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Introduction 

Documentation Contents 
This documentation covers the following topics: 

• What is New in ThinManager 3.1.  
• A System Overview.  

• Installation.  

• Redundancy.  

• Licensing.  

• The ThinManager Interface.  

• The Menu system.  

• Adding thin client hardware.  

• Configuration Wizards.  

• Terminal Server Groups.  

• Failover and Instant Failover.  

• Modules.  

• MultiMonitor.  

• Reports.  

• Shadowing.  

• ThinManager Security.  

• TermSecure.  

• WinTMC.  

• TermMon ActiveX Control.  

• Non ACP Components.  
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ACP ThinManager 3.1 
ThinManager is a server-side configuration, management, and hardware enabling software for Terminal 
Services based thin client systems.  

ThinManager is a software program that allows ACP Enabled, ThinManager Ready Thin Clients to boot, 
receive a configuration, and connect to a terminal server. ThinManager provides terminal configuration, 
session management, and session status monitoring. ACP ThinManager provides quick replacement of 
terminals and an almost seamless switch from terminal server to terminal server in case of terminal server 
failure. 

A thin client is a device that connects to a server, logs onto a separate independent session, and runs its 
applications on the server and not locally on the thin client. ThinManager Ready Thin Clients first connect to 
a ThinManager Server where it receives its configuration. This configuration sends the terminal to a terminal 
server where it logs in. 

Note: The terms Thin Client and Terminal are used interchangeably in this document. 

The keystrokes and mouse movements from the thin client are sent to the terminal server. The terminal 
server session determines the response and sends the screen display back to the terminal. This simplifies 
maintenance and management by eliminating the need to install and configure operating systems and 
applications on the thin client. All configuration, management, installation and applications are on the server, 
not the thin client. 

Note: All trademarks, service marks, and copyrights belong to their respective companies. 

Microsoft, Windows, Windows XP, Windows 2000, Windows 2000 Server, Windows 2003, and 
Windows 2003 Server are trademarks of the Microsoft Corporation, Redmond, Washington. 

Citrix, MetaFrame, ICA, and Citrix Device Services are trademarks of Citrix Systems, Fort Lauderdale, 
Florida.  

ACP, ACP Enabled, AppLink, MultiSession, MultiMonitor, SmartSession, TermSecure, ThinManager, 
ThinManager Ready, and ThinServer, are trademarks of Automation Control Products, Atlanta, Georgia. 

What’s New in ThinManager 3.1 
New - MultiMonitor 

ThinManager 3.1 includes support for ThinManager Ready thin clients that can use up to 5 monitors from a 
single thin client. Each monitor can display an individual Terminal Server Group session or the monitors can 
be configured to show a session spanned across several monitors.  

See Introduction to MultiMonitor for details. 

New - Reports 
ThinManager 3.1 can generate HTML reports of the terminal configurations, terminal properties, event logs, 
uptime, and others. New templates can be added to ThinManager as needed. 

See Reports for details. 

New – Install Menu Item 
The Manage menu has been re-organized and an Install menu item has been added for tasks like adding 
licenses, firmware, and modules. 

See Install for details. 
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New – Mirrored Redundancy 
ThinManager 3.1 introduces a Mirrored Redundancy that allows a second ThinManager Server maintain the 
terminal configuration for terminal boot up if the primary ThinManager Server fails. This is a lower cost than 
full ThinManager Server Redundancy. 

See Mirrored Redundancy for details. 

New – Application Watchdog in ActiveX 
The TermMon.ocx ActiveX tool has a Watchdog added to eliminate problems caused by applications failing in 
a session. The TermMon.ocx ActiveX can be configured so that if the application fails or loses data 
connectivity, the session will be logged off and a new session will be started. 

See TermMon ActiveX Control for details. 

New – Terminal Server Group Settings 
Terminal Server Groups can now be configured to disconnect when it is in the background while another 
Terminal Server Group is in the foreground, conserving resources while using MultiSession. 

See Terminal Server Group List for details. 

New – Touch Screen Calibration for MultiMonitor 
The touch screen modules have MultiMonitor support added to allow use with MultiMonitor ThinManager 
Ready thin clients. 

See Touch Screen Modules for details. 

Improved – Details Pane 
Several Details tabs have been improved to show more information like License Numbers and IP Menu 
Settings. 

See Details Pane for details. 

Improved – Touch Screen Calibration  
The touch screen calibration has been improved with several features, including the ability to launch the 
calibration program by touching the screen for 10 seconds or by using a keyboard hot key. 

See Touch Screen Modules for details. 

Changed – Firmware Update Module  
The Disk-On-Chip/Compact Flash Update module has been changed to the Firmware Update Module to 
define the module more precisely. 

See Firmware Update Module for details. 
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Twenty Things that Sound Alike, but Aren’t 
Terminals 

Terminal: The individual client device, like a ThinManager Ready thin client, that relies on a server for 
operations.  

Terminal Group: A group of Terminals that can be managed together or share a common configuration (was 
just “Group” in ThinManager 2.x). 

Terminal Server: The Windows server that is configured to allow multiple logins. 

Terminal Server Group: A collection of Windows Terminal Servers that ThinManager can use 
interchangeably for logins and applications. 

Terminal Session: The Windows session that the terminal starts when it connects to a Windows Terminal 
Server. This is where the desktop and applications run. 

Servers 
Terminal Server: The Windows server that is configured to allow multiple logins. 

ThinManager Server: A computer with running ThinManager and ThinServer that communicates and 
controls ThinManager Ready thin clients.  

ThinServer: The engine component of ThinManager that does the work. 

ThinManager: The graphic user interface of ThinManager that allows the data from ThinServer to be 
displayed and used. 

Users 
User: An account created in Windows that allows a login to a Windows computer. 

Windows User: A more accurate name for Users. 

Windows User Group: A more accurate name for User Group: 

ThinManager User: A Windows User that has been added to a ThinManager Security Group to regulate their 
access to ThinManager. 

TermSecure User: A user configured in ThinManager that can log into terminals using TermSecure. 

Groups 
Groups: Either (A), a collection of Windows Users with common access levels (also referred to as “User 

Groups”). 

 Or (B), a group of Terminals (now referred to as “Terminal Group”) 

User Group: A collection of Windows Users that share the same level of access in Windows. 

Windows User Group: A more accurate name for User Group. 

Terminal Group: A group of Terminals that can be managed together or share a common configuration (was 
just “Group” in ThinManager 2.x). 

Terminal Server Group: A collection of Windows Terminal Servers that ThinManager can use 
interchangeably for logins and applications. 

TermSecure User Group: A collection of TermSecure Users that share a common configuration. 

ThinManager Security Group: A Windows User Group that ThinManager uses to regulate access to 
ThinManager functions. 
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System Overview 

Quick Start Checklist 
1. Build a terminal server whose operating system is either:  

• Microsoft Windows 2000 Server with Terminal Services enabled.�

• Microsoft Windows 2003 Server with Terminal Services enabled.�

2. Create a Licensing Server and add a TS CAL (Terminal Server Client Access License) for each 
thin client.  

See Microsoft Terminal Services Licensing Activation. 

3. Install ACP ThinManager software onto a computer to create a ThinManager Server. 

Note:  The ThinManager Server can be a terminal server but doesn't have to be. It can be a Windows 2000 or 
XP Workstation. The clients will connect to the ThinManager Server and download the firmware and 
configuration.  

See ThinManager Installation. 

4. Install a ThinManager License for each ThinManager Ready thin client.  

See ThinManager Licensing. 

5. Select a Client-Communication protocol. The default RDP Client-Communication Protocol installs 
with Terminal Services. If using Citrix MetaFrame, available separately, install and license on each 
terminal server.  

Note: Citrix no longer licenses Citrix Device Services. ThinManager will connect to terminal servers with 
existing Device Services licenses, but no new ones can be created. 

See Client Communication Protocol. 

6. Create a Microsoft user profile for each user on the terminal server or the domain.  

See Creating Microsoft User Profiles. 

7. Apply appropriate security to each user profile using the standard Microsoft techniques. 

8. Establish the IP addressing scheme for the thin clients, using either DHCP or Static IP. 

If using DHCP, configure Option 066 to list the IP address of the ThinManager Server and 
configure 067 to list "firmware.acp" as the bootfile name. 
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See IP Address Assignment. 

9. Attach the terminals to ThinManager by either: 
• Turning on the terminal and selecting the "Create New Terminal" option when the unit boots. 

• Pre-creating the terminals in ThinManager and selecting the proper terminal name when the terminal 
is turned on and offline terminals are listed.�

See Adding Thin Client Hardware. 

 

Required Components  
 

ThinManager Ready Thin Clients require a number of components to function properly. These include: 
• Terminal Services from Microsoft 

• Client Communication Protocol, either RDP or Citrix ICA 

• ACP ThinManager software 

• ThinManager Ready Thin Client Hardware 

• Standard TCP/IP network infrastructure 

Windows Terminal Server Operating System 
The first component is the Terminal Server. This is a computer with a version of Microsoft's Windows 2000 
Server or 2003 Server that has the Terminal Services functionality activated. The operating system allows 
multiple users to log into the server and run independent, isolated sessions. The operating system controls 
the server, provides security, controls user access, and runs the applications.   

The terminal server needs Windows 2000 and 2003 Server with Terminal Services enabled and TS CALs 
added. 

See Microsoft TS CALs for details. 

Client Communication Protocol 
The second component is the Client Communication Protocol. This can be either the ICA protocol available 
from Citrix or the RDP protocol that is installed by default with any Windows Terminal Server operating 
systems.  

The Client Communication Protocol is the protocol used for client-to-server communications in the 
Terminal Services Environment. The protocol handles all video, information, and user input such as keyboard 
and mouse input.  

The RDP (Remote Desktop Protocol) is the Client-Communication Protocol that is included with Microsoft 
Terminal Services and can be used by ThinManager Ready Thin Clients to connect to Windows 2000 
Terminal Servers and Windows 2003 Terminal Servers. The RDP connection to a Windows 2000 Terminal 
Server is limited to a 256-color depth (8-bit) while the Windows 2003 Server connection can be made at a 
higher color depth. 

The ICA (Independent Computer Architecture) Protocol is available by installing Citrix MetaFrame on the 
Terminal Servers.  
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ThinManager Administrative Software 
The third component is ACP ThinManager software from Automation Control Products. ThinManager is 
used to configure, manage, and control the ThinManager thin clients. Although ThinManager is treated as a 
single entity, it really has two main components, the ThinManager interface and the ThinServer service.  

• ThinServer is a service that is the engine of the program. It starts automatically, runs in the 
background, and provides essential functions to control the thin clients. ThinServer is installed 
during ThinManager installation if selected.  

• ThinManager is the administrative software that facilitates the configuration and organization of the 
thin clients. This is the visible component of the ThinManager software. ThinManager displays 
information generated by ThinServer. ThinManager can be installed on any computer on the 
network, including the terminal server.  

Note: ThinManager Server is used to describe a computer running ThinManager and ThinServer that 
provides control and configuration to ThinManager Ready Thin Clients, even if the computer is a 
workstation. 

One instance of ThinManager can provide client connection to several terminal servers. The thin clients would 
boot from the ThinManager server but could be assigned to any of several terminal servers.  

ThinManager Ready Thin Client Hardware 

ACP ThinManager is designed to control and configure ACP Enabled Thin clients. These are ThinManager 
Ready thin clients produced by a variety of manufacturing partners and display the ThinManager Ready 
sticker. The ACP website (http://www.thinmanager.com) has links to the ACP Partners. 

              

ThinManager Ready Logos 

ThinManager Enabled thin clients should display a ThinManager Ready Logo. 

Client/Server Architecture 
In terminal services, the client connects to a terminal server, logs in, and starts a session on the terminal 
server. The client uses a client communication protocol to send mouse and keyboard events to the terminal 
server for processing. Once the input is processed, the terminal server generates the video output and sends 
it to the client for display. 
Although the user is typing on the client and sees the results on the client’s monitor, the actual processing 
takes place on the terminal server. 
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Client to Server Communications 

Input from the client is sent to the terminal for processing. 

 

Server to Client Communications 

Output from the Terminal Server is sent to the client for display. 
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Network Overview 

Standard TCP/IP Network Infrastructure 
ThinManager Ready Thin Clients use a standard TCP/IP network. This can include hubs, routers, gateways, 
cables, and wireless components. ThinManager Ready thin clients behave on a network as a PC would, but 
because the thin clients are connected to a terminal server where the actual processing takes place, thin 
clients are more sensitive to poorly deployed networks. 

The simplest thin client network consists of a single computer, configured as a terminal server, with the TS 
CALs, ThinManager, ThinServer, and the applications installed on it. All the ThinManager Ready thin clients 
connect to this single computer. 

A more common scenario includes the use of multiple computers. These might be additional terminal servers 
for failover functionality, additional terminal servers for increased capacity, domain controllers, e-mail servers, 
file servers, database servers, and workstations. One of the strengths of ThinManager and ThinManager 
Ready Thin Clients is their versatility in networking. They do not demand a rigid proprietary network 
configuration but have the flexibility to run in almost any network configuration. 

ACP Networks require: 
• A ThinManager Server, that is, a computer running ThinManager. This does not have to be a 

“server” but can be any Windows computer, including a workstation. 

• A Microsoft Terminal Server with a Client Communication Protocol and all desired applications. 
This computer may also be the ThinManager Server. 

• A Microsoft Terminal Server Licensing Server for the TS CALs (Microsoft Terminal Server Client 
Access Licenses). This does not need to be a separate computer but can run on a terminal server 
or a domain controller. 

• A DHCP Server or Static IP addresses for the thin clients. 

• ThinManager Ready Thin Client hardware. 

• A standard Ethernet network. 

Note: ThinManager does not have to be installed on a terminal server but can be installed on a workstation. 
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Sample ACP Thin Client Network – Single Terminal Server 

When a single server is used for the ThinManager Ready thin client network, all components need to be 
installed on the single computer, including ThinManager, Microsoft Terminal Services Licensing, Terminal 
Services, applications, and a DHCP server, if desired. 

 

Sample ACP Thin Client Network – Multiple Servers 

A more common practice is to use several servers with specific functions. In addition to the normal corporate 
file servers, e-mail servers, and domain controllers, the use of multiple terminal servers allows failover and 
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redundancy. The ThinManager may be run on a separate computer but is typically installed on a terminal 
server, or in conjunction with other server applications like DHCP and Microsoft Licensing. 

 

Sample ACP Thin Client Network – Separate Subnet 

The thin clients can be isolated to their own subnet by using a second network interface card (NIC) in the 
ThinManager Server and terminal servers. The thin clients can reach other servers in the corporate network 
by using the terminal server as a bridge. 

Connection Overview 
When a terminal is powered on: 

• An IP address is requested from a DHCP server by default. The DHCP server needs to have Option 
066 set to the ThinManager Server IP address and Option 067 set to firmware.acp to 
specify a ThinManager Server IP address. Units with the ACP BootLoader 5.01 can use DHCP 
and have the ThinManager Server statically assigned on the unit. See DHCP Server Setup and 
the Boot Process for details. 

• Alternately, the terminal may be assigned a static IP address and the ThinManager Server IP 
address.  

• The terminal connects to the ThinManager Server to download its configuration. 

• The ThinManager configuration will tell the terminal which terminal server to login to. 

• The terminal will connect to that terminal server and display the Windows login dialog box or will 
automatically login with help from the ThinManager configuration. 

• The terminal will create a session on the terminal server, allowing applications to run. 

The ThinManager Ready Thin client can be assigned to a single terminal server, or it can be assigned to 
multiple terminal servers in case of terminal server failure. Terminal Server Groups are groups of terminal 
servers that have added functionality for the thin client. 



 

14  ••••  System Overview ACP ThinManager 3.1 Help Manual 

Failover Overview 
Server failures in any network or system can disrupt productivity and data management. ACP ThinManager 
(version 2.3 and later) has a failover capability built into it that allows terminals to connect to a secondary 
terminal server if the terminal server that they are logged into fails. This will lessen the effect of server failures 
on the terminal server network. The terminals can detect the server crash, drop the connection to it, and 
connect to a secondary server in seconds.  

To initiate ACP ThinManager Failover protection, four steps are needed: 

• Multiple Servers: The first step is to have multiple terminal servers, with a Client Communication 
Protocol and appropriate licenses added. 

• Terminal Server Addressing In ThinManager: When configuring the terminal, list the terminal 
servers, in the order of preferred connection, in ThinManager. Upon boot, each terminal will try to 
connect to the first server in the list (the primary server). If it is not available, it will try the next on 
the list (a secondary server) until a connection is made. 

• Sufficient Memory: The second step is to have sufficient memory capacity on the servers to 
accommodate the addition of terminals during failover. If you do not plan for the extra capacity, 
the servers can be taxed with the addition of the new terminals. 

• User Permissions: Each terminal server needs the appropriate Windows 2000/2003 user 
profiles and permissions. The terminals will not log into a secondary session unless it has a user 
profile on that server. 

ACP ThinManager allows the use of several terminal servers, defined as the primary and as backups. If the 
primary terminal server fails, the ThinManager Ready thin client will detect the server failure and will initiate a 
new session on a backup server. This allows the operator to continue their work and minimize the effect of a 
server failure. 
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Failover Configured in the Terminal Configuration Wizard with Individual Terminal Servers 

Failover when using individual terminal servers is configured in the Terminal Configuration Wizard. See 
Terminal Server Selection Page for details. 
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Failover Configured for Terminal Server Groups in the Terminal Server Group Wizard 

Failover when using Terminal Server Groups is configured in the Terminal Server Group List. See Terminal 
Server Group Members Page for details. 

Instant Failover is an advanced configuration of failover. The terminal will log into two terminal servers and 
start a session on each one. The primary session will be displayed, with the secondary session cascaded 
behind it. If the primary terminal server fails, the terminal will switch focus to the already initiated secondary 
session and display the secondary session, saving the time needed to switch terminal servers and load 
applications. 

See Instant Failover Module or Instant Failover with Terminal Server Groups for further details. 

Terminal Server Group Overview 
Terminal Server Groups are collections of Terminal Servers. Instead of being assigned to a list of individual 
terminal servers, a ThinManager Ready thin client can be assigned to a Terminal Server Group or Groups 
and the terminal will connect to one of the terminal servers of the group. The specific terminal server that the 
terminal connects to is based on the Terminal Server Group configuration and options. 

• A standard Terminal Server Group has the terminal servers listed in a pre-defined order. The 
terminal connects to the first available member of the group. 

• The SmartSession option of Terminal Services Groups provides load balancing by using CPU 
availability, memory, and the number of sessions on the member terminal servers to determine 
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the resource availability on member terminal servers. A ThinManager Ready thin client connects 
to the terminal server in the Terminal Server Group with the most available resources.  

• The Instant Failover option allows a terminal to connect to two terminal servers within a Terminal 
Server Group. The terminal will have an active session on two terminal servers but will only 
display one session. If the first terminal server fails, the session of the second terminal server is 
immediately displayed, eliminating any downtime due to terminal server failure. 

• The AppLink option provides the Initial Program function to members of a Terminal Server Group. 
When specifying the Initial Program function, a program is started instead of the desktop. Closing 
the program will terminate the connection. 

• MultiSession is a terminal configuration that allows a ThinManager Ready thin client to connect to 
multiple terminal servers from multiple Terminal Server Groups. The user can switch between 
groups using an on-screen menu or hot keys. These groups may be standard Terminal Server 
Groups, Terminal Server Groups with SmartSession, AppLink, and/or Terminal Server Groups 
with Instant Failover. 

These Terminal Server Group options can be combined on the same Terminal Server Group, for example a 
Terminal Server Group could use SmartSession to choose the server connection order, Instant Failover to 
maintain a backup, while using AppLink to limit the terminal to a single application. Additionally, a terminal 
server may be a member of several Terminal Server Groups. 

See Terminal Server Groups for details. 

TermSecure Overview 
TermSecure is a new ThinManager feature that allows users to logon to a ThinManager Ready thin client and 
access user-specific or terminal-specific Terminal Server Groups. This does not replace the Windows logon 
but adds an additional layer of security and control.  

Terminals and Terminal Server Groups can be assigned Access Group permissions. A TermSecure User can 
use those terminals and Terminal Server Groups only if the TermSecure User has been assigned to the same 
Access Group. 

TermSecure has two main attributes: 
• SecureAccess: Manages user access to terminal servers and sessions through ThinManager 

authentication and group permissions. 

• SmartContext: Allows the movement of the display of a TermSecure User’s terminal server sessions 
between multiple ThinManager Ready thin clients; initiated by either manual login or the use of an 
authentication device. This allows a user to leave one terminal, logon to a different terminal, and 
reconnect to their session, essentially having the session follow him from terminal to terminal. 

TermSecure logins can be initiated by a manual login or by the use of an ID device like USB drives or 
ProxCards for login. 

See TermSecure User Configuration Wizard for details. 

Note: TermSecure requires the usage of Terminal Server Groups instead of using individual terminal servers.  
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Installation of ThinManager 3.1 

Standard ThinManager Installation in Windows  

ThinManager can be installed on a Windows server or workstation (NT 4.0 SP5 and later). On Microsoft 
Windows 2000 and Windows 2003 Servers, software needs to be added in the Install Mode through the 
Control Panel > Add/Remove Programs. Failure to use the Install Mode can prevent an application from 
working properly. 

Select Start > Settings > Control Panel > Add/Remove Programs to open the Add/Remove Programs 
dialog box.  



 

20  ••••  Installation of ThinManager 3.1 ACP ThinManager 3.1 Help Manual 

 

Add/Remove Programs 

Select the CD or Floppy button on the Add/Remove Programs Properties dialog box to open the 
Installation wizard. The wizard will prompt for the insertion of the ThinManager CD. When the CD is inserted, 
the wizard will ask for the path to the setup program.  



 

ACP ThinManager 3.1 Help Manual Installation of ThinManager 3.1  ••••  21 

 

Install CD File System 

The ThinManager CD has 4 folders.  
• Documentation – This folder contains a copy of this documentation in *.pdf format. 

• Terminal ActiveX – This folder contains the Terminal Monitor ActiveX and companion 
documentation. See TermMon ActiveX Control for details. 

• ThinManager 3.1 – This folder contains the ThinManager setup program. 

• WinTMC – This folder contains the WinTMC setup program. See WinTMC Installation for details. 

Browse to the setup.exe file in the ThinManager 3.1 folder to install ThinManager. 
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Run Installation Program Window 

Once the ThinManager 3.1 setup program is selected, select Next to continue the installation. 
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ThinManager Setup Wizard 

The ThinManager Setup Wizard will lead the user through the installation process. 

Select Next to continue. 
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End-User Licensing Agreement 

Read the End-User Licensing Agreement (EULA). If you agree to the conditions, select Yes to continue. 
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Application Selection 

The installation wizard will display the components of the ThinManager installation. Although ThinManager 
appears to be a seamless program, it has two major components and utilities. 

• ThinManager is the graphic user interface. It is installed to view and control the program.  

• ThinServer is the engine that drives the program. It is a vital component that needs to be 
installed with ThinManager to allow ThinManager Ready thin clients to boot and be configured. 
ThinServer is the component that requires licensing. It is separated from ThinManager in the 
installation to allow additional instances of ThinManager to be installed for remote administration.  

• ThinManager Utilities includes tools like the touch screen calibration program. These utilities 
need to be installed on every terminal server that have clients with touch screens connected to 
them. 

Note: If touch screens are being used with ThinManager Ready thin clients, the ThinManager Utilities 
program needs installed on every terminal server to provide the Calibrate Touch program for 
connected thin clients. 

The Browse button will allow the user to change the path to the folder where ThinManager will be installed. 

Check the desired components and select Next.  
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Installation Wizard Completion 

When the wizard has finished select the Finish button. 
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After Installation Dialog 

After the ThinManager Setup wizard has finished, one needs to complete the installation through the 
Microsoft dialog boxes. 

Select Next to continue. 

 

Finish Installation 

Select Finish to complete the installation. 

ThinManager now needs licenses installed. See ThinManager Licensing for details. 
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WinTMC Installation 
The WinTMC program is a terminal client that is installed on a PC. When the WinTMC client is run it connects 
to a ThinManager Server, receives its configuration, and then connects to a terminal server and launches a 
session. The session is then displayed in the WinTMC client as a window or as a full screen, bringing terminal 
server computing to PCs. 

The WinTMC client needs to be installed on each PC that it is run on. 

Note: Although PCs don’t have as strict a requirement as terminal servers; it is a good idea to install the 
WinTMC client using the Add and Remove Programs feature. 

The ThinManager Install CD contains the installation for the ThinManager program and the WinTMC client. To 
install the WinTMC client on a PC select Start > Settings > Control Panel > Add/Remove Programs to 
open the Add/Remove Programs dialog box.  

 

Add/Remove Programs 

Select the CD or Floppy button on the Add/Remove Programs Properties dialog box to open the 
Installation wizard. The wizard will prompt for the insertion of the ThinManager CD. When the CD is inserted, 
the wizard will ask for the path to the setup program.  
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Install CD File System 

The ThinManager CD has 4 folders.  
• Documentation – This folder contains a copy of this documentation in *.pdf format. 

• Terminal ActiveX – This folder contains the Terminal Monitor ActiveX and companion 
documentation. See TermMon ActiveX Control for details. 

• ThinManager 3.1 – This folder contains the ThinManager setup program. 

• WinTMC – This folder contains the WinTMC setup program. 

Browse to the setup.exe file in the WinTMC folder to install the WinTMC client. 
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Run Installation Program Window 

Once the WinTMC setup program is selected, click the Next button to continue with the install.  

 

WinTMC Setup Wizard 

The WinTMC Setup wizard will launch. Select Next to continue. 
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License Agreement 

Read the End-User License Agreement (EULA). If you agree with the conditions select Yes to continue. 
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Choose Destination Location 

The Browse button will allow the user to change the path to the folder where the WinTMC client will be 
installed. 

Select Next to continue. 
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Feature Selection 

The WinTMC installation program has two options.  
• WinTMC - This is the client application that needs to be installed to use the client. 

• WinTMC Shadow Service - This optional program allows the PC to be shadowed from within 
ThinManager by authorized users.  

Note: The WinTMC Shadow Service will function even when the WinTMC isn’t active. 

Select the Next button to continue with the WinTMC installation. 
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WinTMC Installation Completion 

When the wizard has finished select the Finish button. 

 

After Installation Dialog 

After the WinTMC setup wizard has finished, one needs to complete the installation through the Microsoft 
dialog boxes. 

Select Next to continue. 
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Finish Installation 

Select Finish to complete the installation. 

Trialware ThinManager Installation  
ACP has a demonstration version of ThinManager that provides customers with a 30-day trial. This version is 
downloaded from the ThinManager web site (www.thinmanager.com) as a self-extracting file. 

• A user must register on the ThinManager web site to access the download. 

• The software must be installed on a computer that hasn’t had ThinManager installed before. 

• The software can be installed on a workstation or a terminal server. Be sure to install in the 
Install Mode by using the Add and Remove Programs if the Trialware is installed on a terminal 
server. 

• The software doesn’t need license activation and will provide licenses for 30 days. 

• The Trialware version won’t accept normal ThinManager licenses, but needs to be replaced with 
the standard ThinManager version to become a regularly licensed program. 
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Trialware Download at www.thinmanager.com  

Selecting the Trialware/Demo button will lead to the Trialware/Online Demo window. 
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Trialware/Online Demo Page 

Fill in the required fields to register. The e-mail address is important because the password to the download 
will be sent to that e-mail address. 

Once the form is filled out, a username and password will be e-mailed to allow access to the Trialware 
download. Select the you can access the page here link to access the download. 
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Download Authentication Window 

Selecting the you can access the page here link will open an Authentication Required popup window. 
Enter the username and password that were e-mailed to you when you complete the Trialware registration 
form. A valid user name and password will open the Trialware Demo Access page. 
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Trialware Demo Access Page 

Double-click on the ThinManager Promo link to download the file. Some browsers require that you right-click 
on the link and select Save Link As to save the file. 
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Save File Dialog Box 

The download is a self-installing *.exe. It is recommended that it be installed using the Add/Remove 
Programs function. See Standard ThinManager installation for details on ThinManager installation. 
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Redundant ThinManager Servers 

Redundancy Overview 
ACP uses the term Failover to describe having two or more terminal servers that the thin clients can connect 
and run a session from. 

ACP uses the term Redundancy to describe having two or more ThinManager Servers that the thin clients 
can connect and receive a configuration from. 

Single ThinManager Server - If a system has a single ThinManager Server all the terminals will boot from 
that computer, receive their configuration, then connect to the assigned terminal servers. If the ThinManager 
Server fails the terminals will continue to function as designed. If they reboot, however, they will be unable to 
connect to the failed ThinManager Server and will not receive their configuration or connect to a terminal 
server. 

Redundant ThinManager Server - If the system has two ThinManager Servers that are synchronized with 
the same configuration the thin clients can be configured to point to either ThinManager Server to receive 
their configuration. If the first ThinManager Server has failed a rebooted thin client can connect to the backup 
ThinManager Server and receive the proper configuration and connect to the proper terminal servers. 

Redundancy requires an identical license set on both ThinManager Servers. Each ThinManager Server is 
fully functional and can be used to change or configure the thin clients.  

Note: All Enterprise licenses include Redundancy. 

Mirrored Redundancy is a new feature that allows a pair of ThinManager Server to be synchronized with the 
same configuration so the thin clients can receive their configuration from the backup if it goes down. Mirrored 
redundancy is less expensive than full redundancy but mirrored redundancy installs the second ThinManager 
Server as a headless server. It doesn’t allow changes to be made to the configuration except from the primary 
ThinManager Server. If the primary ThinManager Server fails the thin clients can boot from the secondary 
ThinManager Server but the configuration cannot be changed until the primary ThinManager Server is 
returned to service. 
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Redundancy Differences 
No Redundancy - Single ThinManager Server  

• Least expensive. 

• If the ThinManager Server fails the thin clients cannot retrieve their configuration until the 
ThinManager Server is restored. 

Mirrored Redundancy- Two ThinManager Servers 
• Provides redundancy at a lower cost than full redundancy. 

• Configuration changes can be made only on the primary ThinManager Server. If it fails the 
thin clients are able to retrieve their configuration but configuration changes must wait until 
the primary ThinManager is restored. 

Full Redundancy - Two ThinManager Servers 
• If a ThinManager Server fails, the other ThinManager Server will provide configuration. 

• The ThinManager configuration can be changed on either ThinManager Server at anytime. 

• Most expensive as it requires a duplicate set of licenses on the backup ThinManager Server. 

Creating a Redundant Pair of ThinManager Servers 
To create a redundant pair of ThinManager Servers: 

1. Install ThinManager on two computers. See Standard ThinManager Installation. 

2. Configure the thin clients on the primary ThinManager Server. See Terminal Configuration 
Wizard. 

3. Synchronize the two ThinManager Servers. See Synchronize Configuration. 

4. Install a complete set of licenses on both ThinManager Server for full redundancy or install a 
mirrored license for mirrored redundancy. See ThinManager Licensing. 

5. Configure the thin clients to boot from two ThinManager Servers using the DHCP server or 
static IP addressing. See DHCP Server Setup or Configuring New Hardware. 

Synchronizing ThinManager Servers 
Redundant ThinManager Servers need to be synchronized so that a thin client booting from either will receive 
the same configuration regardless of the ThinManager Server. This can be done manually as described in 
Manual Synchronization or automatically as described in Automatic Synchronization. 

Additionally each thin client needs to be able to boot from both ThinManager Server. This can be configured 
in the DHCP server as described in DHCP Server Setup or when setting up a static IP address as described 
in Configuring New Hardware. 
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Manual Synchronization  
Selecting Manage > Synchronize Configuration from the ThinManager menu to launch the Synchronize 
ThinManager Server Configurations Wizard to manually synchronize ThinManager Servers. 

Note: It is important to synchronize the ThinManager Servers after each configuration change to keep the 
configurations identical. 

ThinManager Server Configuration Synchronization Page 

 

Synchronize ThinManager Server Configuration Wizard 

Highlight the primary ThinManager Server as the Configuration Source ThinManager Server and the 
secondary ThinManager Server as the Configuration Destination. Select Next to proceed. Although many 
ThinManager Servers can be defined in the ThinManager Server List it is normal to have just a primary and a 
backup ThinManager Server. 
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ThinManager Server Configuration Differences Page 

 

Synchronization Differences 

The ThinManager Synchronization Wizard will list the files being updated, including the firmware, TermCap 
database, modules, and the configuration. It synchronizes everything but the licenses. 

Note: The Synchronization tool does not compare and contrast then make changes back and forth. 
Synchronization will take the files and configuration from the source ThinManager Server and overwrite 
the corresponding files on the destination ThinManager Server. 

Select Next to continue.  
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ThinManager Server Synchronization Confirmation 

The ThinManager Server Configuration Wizard will prompt for a confirmation of the synchronization before 
proceeding. Select Finish to finalize the synchronization.   

 

Synchronization Progress Meter 

ThinManager will display the progress of the synchronization as it updates the files. 
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Synchronization Complete Window 

A message will display the final results of the synchronization. 

Automatic Synchronization 
ThinManager has an automatic synchronization tool that makes it easier to keep the configuration on two 
ThinManager Servers the same. Changing a configuration on one will make the change on the other. 

Automatic Synchronization has a few things to consider: 

• It is a good idea to backup the configuration before making changes because a mistake on one 
ThinManager Server will pass the mistake to the other ThinManager Server. The backup will allow a 
chance to restore the configuration to a pre-mistake state. See Backup Configuration. 

• Automatic synchronization is required for Mirrored Redundancy. See Mirrored Redundancy. 

• Automatic synchronization will configure each thin client to send the green/red status lights to both 
ThinManager Servers so the ThinManager Server Monitor List page isn’t shown in the Terminal 
Configuration Wizard, as it isn’t needed. See ThinManager Server Monitor List for details. 

Automatic synchronization is configured on the ThinManager Server List Wizard. Launch it by selecting 
Manage > ThinManager Server List ThinManager menu. See the ThinManager Server List for more detailed 
instructions. 
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ThinManager Server List Wizard - Introduction 

The ThinManager Server List Wizard begins with an introduction screen. Select Next to proceed the 
ThinManager Server List page. 
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ThinManager Server List Page 

 

ThinManager Server List Wizard 

Selecting Add Server will launch a ThinManager Server Definition window that allows the entry of the 
ThinManager Server name and IP address.  

ThinManager Server Definition  

 

ThinManager Server Definition 

Entering the network name of the ThinManager Server and its IP address allows the ThinManager Servers 
to be tied to a convenient name without the need of a DNS server.  

Enter the computer name as found in the Microsoft System Properties in the ThinManager Server field. Add 
the IP address of the ThinManager Server in the ThinManager Server Address field, and select OK. This 
adds the ThinManager Server to the ThinManager Server list. 
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Discover will find and fill in the IP address for a ThinManager Server entered in the ThinManager Server 
field. 

 

ThinManager Server List 

To set up automatic synchronization enter two ThinManager Servers into the ThinManager Server List. 

Select the Automatic ThinManager Server Synchronization checkbox once two ThinManager Servers are 
added. When this is checked, the Add Server button will become inactive and no more ThinManager Servers 
can be added. 

Select Finish to close the ThinManager Server List wizard. 

The two ThinManagers will now be synchronized. The synchronization status can be checked on the 
Synchronization tab of ThinManager. 
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Properties Tab 

The Properties tab will show whether the ThinManager Server is the master or the slave (although it doesn’t 
matter which is which), the synchronization state, and the IP address of the synchronized partner. 
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Mirrored Redundancy 
Mirrored Redundancy is a new feature that provides redundancy at a reduced cost from full redundancy. 

To set up Mirrored redundancy: 

1. Install ThinManager on two computers. See Standard ThinManager Installation. 

2. Configure the thin clients on the primary ThinManager Server. See Terminal Configuration 
Wizard. 

3. Synchronize the two ThinManager Server. See Manual Synchronization. 

4. Install a complete set of licenses on both ThinManager Server for full redundancy or install a 
mirrored license for mirrored redundancy. See ThinManager Licensing. 

5. Configure the thin clients to boot from two ThinManager Server using the DHCP server or 
static IP addressing. See DHCP Server Setup or Configuring New Hardware.. 

Activating a Mirrored License 
This section will cover the highlights of Mirrored licensing. See ThinManager Licensing for full details. 

When a pair of ThinManager Servers are auto-synchronized that Licensing window will display the Installation 
ID of both ThinManager Servers. 

 

Licensing Dialog Box - Synchronized ThinManager Servers 

The Installation ID at the bottom of the window is used to obtain the License File from ACP. Mirrored licenses 
and Enterprise Server licenses require the Installation ID of both ThinManager Servers for activation. 

When a license is a Mirrored license or an Enterprise Server license then the ThinManager License Activation 
site will ask for the Installation ID of the secondary ThinManager Server in addition to the Installation ID of the 
primary ThinManager Server.. 
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Mirrored License Activation 

After the first Installation ID is entered and submitted, the site will recognize the license and ask for the 
second Installation ID. 

Enter the Installation ID of the secondary ThinManager Server into the Mirrored Installation ID field and 
select the Submit button. 

The license will download as described in ThinManager License File Download. 

Add the license as described in ThinManager License File Installation. 
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Added Licenses 

Once a Mirrored license is added the Licensing window will display the license with both ThinManager 
Servers as the location. 

Once a license is added to ThinManager it is displayed on the Licenses tab of the Details pane.  
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License Tab 

When a Mirrored license is activated the mirrored ThinManager Server will allow thin clients to boot from it but 
it does not allow the ThinManager to run and allow configuration changes like a fully redundant ThinManager 
Server allows. 
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Mirrored ThinManager Server 

The Mirrored ThinManager Server will show a message indicating that the ThinManager is not allowed to 
display the ThinServer data. 

Note: A fully redundant ThinManager Server with a complete set of duplicate licenses will allow the display of 
the ThinServer data and will allow changes to the configuration. 
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Licensing ThinManager  

ThinManager Licensing 
When an unlicensed copy of ThinManager is run, a message box will appear with notification that a license 
needs to be installed. 

 

No Valid License Message Box 

ThinManager has two licensing modes, Standard and Enterprise. Several Terminal Server Group functions 
and modules require licenses. 

Standard ThinManager licenses are sold per-connection and are available in 5, 10, and 25-user units. These 
licenses allow any 5, 10 or 25 ThinManager Ready thin clients to boot and connect to terminal servers and 
terminal server groups. The licenses are pooled and are released once the terminal is turned off. 

Enterprise Licenses provide unlimited connections and are available as Server, Site, and Global versions. 
• Enterprise Server includes two license numbers that are installed on two computers to provide 

redundant ThinManager Servers.  

• Enterprise Site has a single license number that can be installed on an unlimited number of 
computers at a single company location to provide redundancy and departmental control. 
ThinManager Servers using this license will display the licensed company’s name and site in the 
title bar of ThinManager. 

• Enterprise Global has a single license number that can be installed on an unlimited number of 
computers at an unlimited number of locations for a single company location to provide 
redundancy, departmental and site control. ThinManager Servers using this license will display 
the licensed company’s name in the title bar of ThinManager. 

Additional Licenses include: 
• A MultiSession Server License allows a terminal server to be added to a Terminal Server Group 

that is available for MultiSession. A number of MultiSession Server Licenses are included with 
Enterprise Licenses or they can be purchased for use with Standard ThinManager licenses.  
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• A SmartSession Server License allows a terminal server to be added to a Terminal Server Group 
that uses SmartSession. A number of SmartSession Server Licenses are included with Enterprise 
Licenses or they can be purchased for use with Standard ThinManager licenses. 

• The Instant Failover License allows a terminal to use the Instant Failover module when using 
individual terminal servers or to connect to a Terminal Server Group that is configured to use the 
Instant Failover option. This is an additional purchase. 

• The Share Keyboard Mouse License allows a terminal to use the Share Keyboard and Mouse 
Master module. This is an additional purchase. This license is not required for Share Keyboard 
and Mouse slave units. 

Mirrored Licenses – ThinManager has a new form of redundancy that ties a license to the Installation IDs of 
two ThinManager Servers. This is covered in Mirrored Redundancy. 

The ThinManager Licensing dialog box shows the available licenses and shows the Installation ID that is 
needed for license activation. It is opened by selecting Install > Licensing from the ThinManager menu bar. 
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Licensing Dialog Box – Single ThinManager Server  

 

Licensing Dialog Box - Synchronized ThinManager Servers 

The Installation ID at the bottom of the window is used to obtain the License File from ACP. 

Note: The Installation ID is required for obtaining a License File. 
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ThinManager License File Download 
To obtain a license file you need two numbers:  

• The Installation ID that is generated by ThinManager during installation. Mirrored licenses and 
Enterprise Server licenses require two Installation IDs.  

• The License Number that is provided with the ACP ThinManager CD. 

The License File needed to activate ThinManager is obtained from the ACP web site at 
www.thinmanager.com or www.acpthinclient.com. 

Note: Since web sites are dynamic, the exact layout of the web screens may change, but the functionality 
should remain the same. If you have problems, please contact your distributor or e-mail 
support@acpthinclient.com for help. 

 

www.thinmanager.com 

Select the License Activation link in the Support section. This will launch the ThinManager License Site. 
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ThinManager License Activation Site 

There are two links at the ACP Licensing Site: 
• Login - This link allows previously registered users to enter the site. 

• New User - This link allows a person to become a registered user of the site so that they can activate 
a license. 

If you are a new user, select the New User link. Previously registered users should login by selecting the 
Login link. 

Note: The login to the license site is separate from any login to www.thinmanager.com.  
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New User Login 

Enter a name to be your ACP User Name. Select Submit to continue. 
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User Information Form 

Fill in the User Information form.  

Note: The e-mail address is very important because all correspondence will take place through e-mail. Your 
password will be sent to that address. 

Select Submit when finished. 
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New Account Completion 

Your user name and password will be promptly sent to your e-mail address. Open your e-mail to receive your 
password. 

Select the Login link to continue. 
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Licensing Site Login 

Enter the user name and password that you received in your e-mail into the appropriate fields. 

Select the Login button to continue. 
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ACP Licensing Site 

Inside of the ACP Licensing Site are four functions for the registered user.  
• Logout - This link will allow exiting from the secure site. 

• Manage Account - This link allows user information to be changed or updated. Passwords are 
changed here. 

• Activate License - This link allows the activation of a license and the retrieval of a license file.  

• History - This link displays past actions for the user account. 

Select the Activate License link to activate a license and retrieve a license file. 

Note: The initial password that is sent is complex and hard to remember. Going to Manage Account will 
allow the password to be changed to one of your choosing. 
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License Request Page 

Logging on to the ACP License site and selecting Activate License will display a License Activation page. 
This web page will have a field for the License Number and a field for the Installation ID. 

Note: The License Number is located on a label inside of the ThinManager CD case. The Installation ID is 
on the ThinManager Licensing dialog box that is launched by selecting Tools > Licensing from the 
ThinManager menu bar. 

Fill in both fields with the correct numbers. These numbers are case sensitive and cannot have extra spaces 
added.  

Select the Submit button to continue.  

If the license is a Mirrored license or an Enterprise Server license then the site will ask for the Installation ID 
of the secondary ThinManager Server. 
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Mirrored License Activation 

Enter the Installation ID of the secondary ThinManager Server into the Mirrored Installation ID field and 
select the Submit button. 
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Download License File 

The site will display a page with license information. Print a copy of this page for your records. 

The License File will begin to download. A dialog box will appear that allows the option of opening the file 
from its current location or saving the file to disk. Saving the file to disk is recommended. 
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Saving File to Disk 

Select OK to continue.  

A dialog box will appear that allows the selection of the download directory. 

 

Save As Window 

Select a directory or drive to copy the file, and select Save. 

The license file is now ready for installation. 
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ThinManager License File Installation 
Open the Licensing dialog box by selecting Tools>Licensing from the ThinManager menu bar. 

 

Licensing Dialog Box - Synchronized ThinManager Servers 

Select the Install License button on the Licensing dialog box. An Open File dialog box will be displayed.  

 

Open License File 

Select the License File that was downloaded from the ACP web site and select Open. This will install the 
License File. 
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Successful License Installation Message 

When the License File has been successfully installed, a message box will appear to confirm it. The License 
Number and properties will appear in the Licensing dialog box. 

Select OK to close the message box. 

 

Added Licenses 

Selecting the Delete License button on the Licensing dialog box will open a message box that will allow the 
deletion of a selected license. 

Selecting the Details button on the Licensing dialog box when a license is selected will display a window with 
the details of the selected license. 
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License Details 

Double-clicking a license in the Licensing dialog box can also open this window. Selecting OK will close the 
License Details window. 

Selecting the Done button on the Licensing dialog box will close the Licensing dialog box. 

Once a license is added to ThinManager it is displayed on the Licenses tab of the Details pane.  
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License Tab 

When a Mirrored license is activated the mirrored ThinManager Server will allow thin clients to boot from it but 
it does not allow the ThinManager to run and allow configuration changes like a fully redundant ThinManager 
Server allows. 



 

ACP ThinManager 3.1 Help Manual Licensing ThinManager  ••••  75 

 

Mirrored ThinManager Server 

The Mirrored ThinManager Server will show a message indicating that the ThinManager is not allowed to 
display the ThinServer data. 

ThinManager Module Licensing 
Certain modules, like the High Speed Serial Driver, Instant Failover, and the Share Keyboard and Mouse 
module require an ACP license to activate. These are activated through the ACP web site using the same 
procedures as the ThinManager license. 

See Module Overview for details. 

WinTMC Licensing 
WinTMC requires a Terminal/WinTMC connection license.  Existing Terminal Connection Licenses can be 
upgraded to support WinTMC connections. For customers using ThinManager Enterprise Class licenses, a 
WinTMC Connection License is required. These are activated through the ACP web site using the same 
procedures as the ThinManager license. 

TermSecure Licensing 
TermSecure requires a TermSecure license for each terminal that will use TermSecure to control access to 
the terminal. For customers using ThinManager Enterprise Class licenses, a TermSecure License is required. 
These are activated through the ACP web site using the same procedures as the ThinManager license. 
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ThinManager Interface 

Opening ThinManager  
ThinManager is used for the configuration of ThinManager Ready Thin Clients in the ACP thin client 
environment. 

ThinManager can be started using any of the traditional Windows methods, based on the administrator's 
preference: 

• Run from the Start Menu, Start > Programs > ACP > ThinManager. 

• Run from the Run line, Start > Run > C:\Program Files\Automation Control 
Products\ThinManager\ThinManager.exe (default path). 

• Run from a command prompt, C:\Program Files\Automation Control 
Products\ThinManager\ThinManager.exe (default path).  

• Run from a shortcut on the desktop. 

• Run from a ThinManager icon in the system tray, if this option is selected in View > Options from the 
menu bar.  

• Run from Windows Explorer.  

Note: ThinManager can be run on a terminal with full privileges if the user is an administrator or a member of 
the ThinManager Administrator’s group. See ThinManager Server Configuration wizard for details on 
ThinManager User Groups. 
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ThinManager Graphic User Interface 
 

 
ACP ThinManager Graphic User Interface 

The ThinManager administrative interface provides "at-a-glance management". The groups and terminals are 
displayed in the tree pane. The configuration data is displayed in the detail panel. Color-coded icons in the 
tree pane show the on-line status of terminals. 

The sections of the ThinManager interface include: 
• A Title Bar  with the standard Windows Minimize/Maximize/Close shortcut icons. 

• A Menu Bar  with commands.  

• A drop-down ThinManager Server Selector to pick which ThinManager Server will have its tree 
displayed. 

• A Tree Pane  with an expandable/collapsible tree showing the Terminals, Groups of terminals, 
Terminal Servers, Terminal Server Groups, and Users on the ThinManager Server. Terminals 
that are on-line have a green monitor icon, while stopped or rebooting terminals have a red 
monitor icon.  
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• A tabbed Details Pane  with information about settings and configurations. The blue group icon 
denotes a property that was obtained from the group. The details pane is tabbed for organization. 
The tabs that are shown depend on the tree item that is highlighted. 

• A Status Bar  that shows advice and tips.  

• The Communication Indicator  shows green when ThinManager is talking to a ThinManager Server. 
ThinManager will wait until this communication is finished before processing additional requests. 

Tree Pane 
The tree pane shows the members of the ACP Thin Client Network in an expandable tree. 

 
ACP ThinManager With Tree 

The current version of the Tree separates the Terminals and nested groups of terminals, Terminal Servers, 
Terminal Server Groups, and Users. Although a single computer can be a ThinManager Server, a Terminal 
Server, and a member of a Terminal Server Group, as shown in the example, these are three distinct 
functions that are displayed in the tree to reflect its function.  

The Terminals branch can be expanded to show the Groups and Terminals under them. Groups can be 
expanded to show the Terminals underneath them. ThinManager now has a multi-level hierarchy that allows 
several levels of nested groups.  
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Icons 

Tree Icons 

Several of the menu tools and other features are dependent on what icon is highlighted in the tree.  

The tree is divided into four branches, Terminals, Terminal Servers, Terminal Server Groups and 
TermSecure Users.  

 

Four Tree Branches 

Each of the branches, shown as a blue icon, can be expanded. 
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Expanded Tree Showing Icon Variety 

The tree in the example has been expanded to provide greater detail about the status of the terminals.  
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Group and Terminal Nesting 

Each Group can be expanded to show the subgroups and terminals that are members of the group. 

Each Terminal can be expanded to show the Terminal Server Groups or Terminal Servers that it is assigned 
to. 

Each Terminal Server Group can be expanded to show the Terminal Servers that are assigned to it. 

Each TermSecure User Group can be expanded to show the TermSecure Users that are members of the 
group. 

Each of the branches of the tree can be expanded. 
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ThinManager Server Icons 

 

ThinManager Server Icons 

ThinManager can connect to several ThinManager Servers, but only one ThinManager Server tree can be 
displayed at a time. This branch shows the local ThinManager Server by default. Other ThinManager Servers 
can be added to the ThinManager Server drop-down box by selecting Edit > Add ThinManager Server from 
the menu bar. 

A Green ThinManager Server icon represents a ThinManager Server that has an active communication link 
with the program. These can be collapsed or expanded to show the Group and Terminal icons that nest under 
the ThinManager Server icons. 

A Red ThinManager Server icon represents a ThinManager Server that is not communicating with the 
program. Right clicking on a red ThinManager icon and selecting Reconnect will reinitiate communications to 
the ThinManager Server. 

Terminal Icons 

Nested under the ThinManager Server icons are groups and terminals. 

 

Group and Terminal Icons 

A Group is represented by an icon of two monitors with a blue screen. Subgroups can be nested under 
Groups. 

A Terminal is represented by an icon of a single monitor. 

A Red terminal screen indicates that the Terminal is off or not communicating with the ThinManager Server. 

A Green terminal screen indicates that the Terminal is on and communicating with the ThinManager Server. 

A Terminal with a Head indicates that a TermSecure User is logged onto the terminal. The TermSecure User 
name will be displayed in parentheses. 



 

84  ••••  ThinManager Interface ACP ThinManager 3.1 Help Manual 

A Locked terminal or group icon means that that terminal or group is being modified and cannot be changed 
by another user. If the Group or Terminal remains locked after its configuration wizard is closed, it can be 
unlocked by using Edit > Unlock from the menu bar.  

A Terminal with a Red Cross indicated that an administrator has disabled the terminal. 

If a Group or Terminal is disabled using the Tools > Disable function, it will be displayed with a red X over 
the terminal icon. An entire ThinManager Server or an entire Group can be disabled, but the ThinManager 
Server icon and the Group icon will not show an X, just the terminal icons. 

 

Disabled Terminal Icons 

A Red terminal screen with a Red X indicates that the Terminal is disabled and is either turned off or 
rebooted and waiting to be enabled. 

A Green terminal screen with a Red X indicates that the disabling has been applied to the terminal that is 
turned on. The terminal has a disabling screen and is waiting for enabling. 

If a Group or Terminal is disabled using the Tools > Disable function, it will be displayed with a red X over 
the terminal icon. An entire ThinManager Server or an entire Group can be disabled, but the ThinManager 
Server icon and the Group icon will not show an X, just the terminal icons. 

Once a terminal is disabled, a disabling screen will appear on the terminal until the terminal has been 
enabled. 
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Disabling Screen 

If a terminal is active when it is disabled, it will display the Disable Screen with a message indicating the 
disabled status in the upper left corner. 

 

Disabled Terminal 

If a terminal is booted when disabled, the boot process will be halted until the terminal is enabled. 

See Disable Terminals for details. 

 

Terminal Server Icons 

Under each Terminal are icons representing the Terminal Servers that they connect to. The lightning bolt 
color indicated the connection status. 
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Terminal Server Connection Icons 

• A Red lightning bolt represents a lack of connection to the terminal server. 

• A Green lightning bolt represents a connection to the terminal server with an active session. 

• A Yellow lightning bolt represents a connection to the terminal server with an active session that is 
the backup in Instant Failover or MultiSession mode.  

 

Terminal Server Nesting 

The Terminal Server branch can be expanded to show the Terminal Servers that have terminals connected to 
them. The monitor screen color and the lightning bolt color indicate the terminal’s status on the Terminal 
Server.  

The Terminal Server Group branch can be expanded to show the Terminal Server Groups that are 
configured. The terminal server groups can be expanded to show the member terminal servers. The member 
terminal servers can be expanded to show the terminals connected to them. The monitor screen color and the 
lightning bolt color indicate the terminal’s status on the Terminal Server. 
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Terminal Server Connection Icons 

The monitor screen color indicates the ThinManager Server connection status. The lightning bolt color 
indicates the Terminal Server connection status. 

• A Red monitor screen indicates that the terminal is off or unable to communicate to the ThinManager 
Server. 

• A Green monitor screen indicates that the terminal is on and able to communicate to the 
ThinManager Server. 

• A Red lightning bolt represents a lack of active connection to the terminal server. 

• A Green lightning bolt represents a connection to the terminal server with an active session. 

• A Yellow lightning bolt represents a connection to the terminal server with a session that is the 
backup session in Instant Failover mode. 

Terminal Server Group Icons 

The Terminal Server Group branch can be expanded. 

A Two-Server icon represents a Terminal Server Group. It can be expanded to show member terminal 
servers. 

A Single-Server icon represents a terminal server that is a member of the Terminal Server Group. It can be 
expanded to show terminals assigned to it. 

Monitor icons represent terminals that are assigned to the terminal servers. The red/green color of the screen 
and lightning bolt are the same as terminals in the Terminals branch, green for connected and red for 
disconnected. 
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Terminal Server Group Icons 

TermSecure User Icons 

The TermSecure Users branch can be expanded. 
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TermSecure User Tree 

The TermSecure User branch expands to show TermSecure User Groups.  

A Two-headed icon represents a TermSecure User Group. This can be expanded to show member 
TermSecure Users. 

A Single-headed icon represents a TermSecure User. This can be expanded to show any Terminal Server 
Groups that are assigned to the TermSecure User. 

A Single-head with Terminal icon represents a TermSecure User that is logged in on a terminal. The 
terminal name is shown in parentheses. This can be expanded to show any Terminal Server Groups that are 
assigned to the TermSecure User. 

A TermSecure User that is not active or logged into a terminal server will show the normal Terminal Server 
Group icon of two servers. 

A TermSecure User that is active and logged into a terminal server will show an icon of the TermSecure User 
head with the terminal Server Group icon of two servers. 

Details Pane 

The Details Pane has been reorganized in ThinManager with tabs to sort information. Highlighting a 
ThinManager Server, Group, Terminal, Terminal Server, or Terminal Server Group in the tree will display 
a different set of tabs and the corresponding set of information. 
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ThinManager Server Tabs - Licenses 

Highlighting the green ThinManager Server will show: 
• Configuration - These are the configuration parameters set in the ThinManager Server 

Configuration Wizard and include the Event Messaging summary.  
• Licenses - This displays the installed licenses, the quantity used and the quantity available. 

ThinManager 3.1 lists all the license files and identifies whether that are valid or invalid.  
• Versions - This displays the version numbers of ThinManager, the firmware, and the TermCap 

database. 
• Synchronization – This will show the synchronization status of the ThinManager Server. See 

Automatic Synchronization for details. 
• Event Log - This displays events for the ThinManager Server. The events and duration are 

configurable in the ThinManager Server Configuration wizard. See Event Selection Page for 
details. 

• Report – This will display the selected report for the ThinManager Server. See Reports for details. 
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Group Tabs - Modules 

Highlighting a Group will show: 
• Configuration - These are the configuration parameters set in the Group Configuration Wizard and 

include Terminal Server assignments, video settings, and monitoring settings. See Terminal Group 
Configuration Wizard for details. 

• Modules - This lists the assigned modules and parameters for the Group. See Modules for details. 
• Schedule – This will display any events scheduled for the Group. See Terminal Schedule for details. 
• Properties - This is blank for a Group. 
• Event Log - This is blank for a Group. 
• Shadow – This is blank for a Group 
• Report – This will display the selected report for the group. See Reports for details. 
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Terminal Tabs - Shadow 

Highlighting a Terminal will show: 
• Configuration - These are the configuration parameters set in the Terminal Configuration Wizard 

and include Terminal Server assignments, video settings, and monitoring settings. See Terminal 
Configuration Wizard for details. 

• Modules - This lists the assigned modules and parameters for the Terminal. See Modules for details. 
• Schedule – This will display any events scheduled for the terminal. See Terminal Schedule for 

details. 
• Properties - This shows the IP address, firmware version, make and model, CPU, memory usage, 

Terminal Up Time, CPU load, and BootROM version of the Terminal.  
• Event Log - This shows the terminal events and terminal configuration events for that terminal, if 

event logging is enabled in the ThinManager Configuration Wizard. See Event Selection Page for 
details. 

• Shadow – This tab shows what the terminal is displaying on its monitor. Administrators can interact 
with the session while ThinManager Power Users can view the session but not control it. See 
ThinManager Security Groups for details. 

• Report – This will display the selected report for the terminal. See Reports for details. 
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Terminal Servers Tabs - Status 

Highlighting the blue Terminal Server will show: 
• Status - This shows the status of the communication connection between the local ThinManager 

Server and the defined Terminal Servers and ThinManager Servers. This shows whether the 
local ThinManager Server is able to retrieve the updated resource information used in 
determining the SmartSession Server Ranking. See Terminal Server Name Page for details. 

• Summary - This will report information on the terminal servers like available memory, uptime, 
CPU utilization, and operating system. 

• Event Log - This shows the terminal events and terminal configuration events for that terminal 
server, if event logging is enabled in the ThinManager Configuration Wizard. See Event Selection 
Page for details. 

The Connection Status of the Terminal Servers may have different messages: 
• OK indicates a good connection. 
• WTSAPI32.dll connection failed occurs when the terminal server is off or unreachable. 
• No login information supplied indicates that the Terminal Server didn’t have a username and 

password added in the Terminal Server List Wizard.  
• User specified does not have permission to connect indicates that the Terminal Server had 

an invalid username and password added in the Terminal Server List Wizard. 
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Terminal Server Tabs – Users 

Highlighting a Terminal Server will show: 
• Configuration - This shows the installed Client Communication Protocols and the SmartSession 

settings for the Terminal Server. See Terminal Server Capabilities Page for details. 
• Properties – This tab displays the server resource data like total memory, free memory, uptime, and 

CPU speed.  
• Schedule – This will display any events scheduled for the Group. See Terminal Server Schedule for 

details. 
• Users - This tab displays information from the Terminal Services Manager. It shows users that are 

logged into the Terminal Server. Right clicking on a user will show options that allow the session to be 
Reset (logged off), Disconnected, or have a message sent to it.  

• Sessions - This tab displays information from the Terminal Services Manager. It shows users that 
are logged into the Terminal Server. Right clicking on a user will show options that allow the session 
to be Reset (logged off), Disconnected, or have a message sent to it.  

• Processes - This tab displays information from the Terminal Services Manager. It shows the 
processes running on the Terminal Server and can have them sorted by Session ID (users) or 
Process Name. Right clicking on a process will give the option to kill the process.  

• Graph – This tab will display the CPU usage and memory usage of the terminal server as a graph. 
This graph can contain one hour of historical data.  

• Event Log - This shows the terminal events and terminal configuration events for that terminal, if 
event logging is enabled in the ThinManager Configuration Wizard. Event Selection Page for details. 
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• Connect – This tab will open a connection from ThinManager to the terminal server. This session 
allows administrators to manage the terminal server from within ThinManager. See Connect Options 
for details. 

• Report – This will display the selected report for the terminal server. See Reports for details. 
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Terminal Server Tabs – Processes 
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Terminal Server Tabs – Graph 

The Graph tab will show the memory usage and CPU usage of the selected Terminal Server. The length of 
time the historical data is stored for each terminal server is configurable in the ThinManager Server 
Configuration Wizard.  
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Terminal Server Tabs – Connect 

The Connect tab allows the ThinManager user to connect to a Terminal Server and start a session for 
administrative purposes if the user can supply a valid Microsoft username and password. 
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Terminal Server Group Tabs – Server Rank 

Highlight the blue Terminal Server Group. The icon will show no details. 

Highlight a Terminal Server Group. It will show: 
• Config – The Configuration tab will show the members of the Terminal Server Group and details 

about SmartSession, Multi-Session, and AppLink. 
• Server Rank - This shows a graph with the SmartSession ranking based on the available resources. 

The server with the lowest number has the lightest load. The server with the highest ranking has the 
highest load. 

Right clicking on the graph can change the colors of the graph. 
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Graph Controls Window 

Right clicking on the graph will launch the Graph Controls window. The color of the lines can be changed by 
selecting a line from the Select Line drop-down and selecting the Set Color button to choose a new color. 

The Zoom  In and Zoom Out buttons control the time intervals displayed on the graph. 

The OK button accepts the changes and closes the Graph Controls window. 

Changing a Terminal’s Group 
To change the Group membership of a terminal, open the Terminal Configuration Wizard or the Terminal 
Properties by either: 

• Highlighting the terminal in the ThinManager tree pane by clicking on the terminal name or icon and 
select Edi t >Modify from the ThinManager menu bar. 

• Right-clicking on the terminal icon in the ThinManager tree pane and select Modify. 

• Double-clicking on a terminal icon in the ThinManager tree pane. 

This will launch the Terminal Configuration Wizard.  
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Terminal Configuration Wizard - Terminal Name Page 

The first page of the wizard, Terminal Name, has a Change Group button. Select the Change Group button 
to launch the Select Group window. 
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Select Group Window 

The Select Group window has a tree of the Terminal Groups. Highlight the desired Terminal Group and 
select the OK button. 

The Cancel button will close the Select Group window without making changes. 

Note: The terminal will need to be restarted for the changes to take effect.  

Modifying a Terminal 
Modifying a terminal allows you to reconfigure the terminal or change group settings such as touch screen 
usage, video resolution, or to assign it to a terminal server.  

To modify a terminal open the Terminal Configuration Wizard or the Terminal Properties by either: 
• Highlighting the terminal in the ThinManager tree pane by clicking on the terminal name or icon and 

select Edit > Modify from the ThinManager menu bar. 

• Right-clicking on the terminal icon in the ThinManager tree pane and select Modify. 

• Double-clicking on a terminal icon in the ThinManager tree pane. 

This will launch the Terminal Configuration Wizard, allowing changes to be made. 

Note: The terminal will need to be restarted for the changes to take effect.  

Deleting a Terminal 
A terminal can be deleted from the ThinManager by: 

• Highlighting the terminal in the ThinManager tree pane and selecting Edit > Delete from the 
ThinManager menu bar  
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• Right-clicking a terminal icon in the tree pane of ThinManager and selecting Delete Terminal.  

Restarting a Terminal 
A restart will reload any changes to a terminal configuration or firmware without a cycling of power. 

A terminal or group can be restarted by:  
• Selecting Tools>Restart Terminal from the ThinManager menu bar. This will restart all the terminals 

on the server if the server is highlighted. If a group is highlighted, all members of the group will be 
highlighted. If a terminal is highlighted, the terminal is restarted. 

• Right-clicking a group icon in the tree pane of ThinManager and selecting Restart Terminals. This 
will reboot all the terminals in the group. 

• Right- clicking a terminal icon in the tree pane of ThinManager and selecting Restart Terminal. This 
will restart only the highlighted terminal. 

Rebooting a Terminal 
A reboot will cycle power to the terminal, reloading firmware and configuration. 

A terminal or group can be rebooted by:  
• Selecting Tools>Reboot Terminals from the ThinManager menu bar. This will reboot all the 

terminals on the server if the server is highlighted. If a group is highlighted, all members of the 
group will be highlighted. If a terminal is highlighted, the terminal is rebooted. 

• Right-clicking a group icon in the tree pane of ThinManager and selecting Reboot Terminals. This 
will reboot all the terminals in the group. 

• Right-clicking a terminal icon in the tree pane of ThinManager and selecting Reboot Terminal. This 
will reboot only the highlighted terminal. 

Renaming a Terminal 
Terminals can be renamed by: 

• Highlighting the Terminal and selecting Edit > Rename. 

• Right-clicking the Terminal and selecting Rename. 

Note: Renaming a terminal can be accomplished the same way that files or directories are renamed in 
Windows Explorer. Single click twice on the terminal name; this will draw a box around the name and 
highlight it. Type the new terminal name. 
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Renaming a Terminal 

The terminal name should be less than 15 characters because of limitations on the terminal server. 

Tip on single clicking  twice: Click once to highlight the name, move the mouse slightly and click again. 
This will prevent Windows from confusing the two single clicks with a double click. 
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Menu Items 

Edit 
Edit contains commands for adding, deleting, and changing configurations. The functions listed are 
dependent on what is highlighted in the tree.  

Add Terminal 
Edit > Add Terminal will launch the Terminal Creation Wizard to start the process of adding a new terminal. 
This command will be displayed when the ThinManager Server, Terminals branch, or a Terminal Group is 
highlighted. 

See Terminal Configuration Wizard for details. 

Add Terminal Group 
Edit > Add Terminal Group will launch the Group Creation Wizard to start the process of adding a new 
group of terminals. This command will be displayed when the ThinManager Server, Terminals branch, or a 
Terminal Group is highlighted. 

See Terminal Group Configuration Wizard for details. 

Add Terminal Server 
Edit > Add Terminal Server will launch the Terminal Server List Wizard to start the process of adding a 
new terminal server. This command will be displayed when the Terminal Servers branch is highlighted. 

See Terminal Server List Wizard for details. 

Add Terminal Server Group 
Edit > Add Terminal Group will launch the Terminal Server Group List Wizard to start the process of 
adding a new Terminal Server Group. This command will be displayed when the Terminal Server Groups 
branch is highlighted. 

See Terminal Server Group List for details. 
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Add TermSecure User 
Edit > Add TermSecure User will launch the TermSecure User Configuration Wizard to start the process 
of adding a new TermSecure User configuration. This command will be displayed when the TermSecure 
Users branch or a TermSecure Users Group is highlighted. 

See TermSecure User Configuration Wizard for details. 

Add TermSecure Users Group 
Edit > Add TermSecure User Group will launch the TermSecure User Group Configuration Wizard to 
start the process of adding a new group of TermSecure users. This command will be displayed when the 
TermSecure Users branch or a TermSecure Users Group is highlighted. 

See TermSecure Users Group Configuration Wizard for details. 

Add ThinManager Server 
Edit > Add ThinManager Server will allow the remote administration of multiple ThinManager Servers by 
adding an additional ThinManager Server to the ThinManager Server drop-down box above the tree. A user 
logged in with administrative rights can connect to multiple ThinManager servers for management.  

Selecting Add ThinManager Server will launch a dialog box. 

 

Add ThinManager Server Dialog Box 

Enter computer name or the IP address of a ThinManager server. This adds the ThinManager Server to the 
ThinManager Server drop-down box above the tree pane of the local ThinManager so that the configuration 
can be displayed in the tree when needed.  

Note: The ThinManager Server may need to be defined in the ThinManager Server List Wizard. 
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ThinManager with a Second Synchronized ThinManager Server Added 

The new ThinManager Server will be added to the ThinManager Server drop-down box. Selecting the new 
ThinManager Server in the drop-down will display the tree for that ThinManager Server. 

ThinManager no longer displays multiple ThinManager Servers in the tree to allow the right-click function to 
be active on each of the tree members. 

Members of the Administrator group or the ThinManager Administrators group have full control of the remote 
ThinManager Server and can make changes as needed. Members of the ThinManager Power Users group 
can monitor the connection. 

See ThinManager Security Groups for more details. 

If ThinManager is installed on a Windows XP Pro workstation, it cannot be added to a ThinManager on a 
Windows 2003 unless a security option is changed. 

In Windows XP Pro select Start > Control Panel > Administrative Tools > Local Security Policy. 
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Windows XP Pro – Local Security Settings 

Highlight the Security Options folder in the Local Security Settings program. Change the Network access: 
Sharing and Security model for local accounts from the default Guest Only to Classic to match the 
setting of the Windows 2003 terminal server.  

Remove ThinManager Server 
Edit > Remove ThinManager Server will delete a highlighted ThinManager Server from the tree. 

Delete 
Edit > Delete will launch a message box that will remove a highlighted ThinManager Server, group or 
terminal. Deleting a remote ThinManager Server will remove it from the local list. 

 

Delete Group Message Box 

Deleting a group will give the option of deleting the group terminals or moving them under the server without a 
group. 
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Modify 
The function of Edit > Modify depends on what tree icon is highlighted when Modify is selected. 

• Modify will launch the ThinManager Server Configuration Wizard for a highlighted ThinManager 
Server. This allows the ThinManager Server to be configured as described in the ThinManager 
Server Configuration Wizard. 

• Modify will launch the Terminal Group Configuration Wizard for a highlighted group. Modifications 
can be made as described in Terminal Group Configuration Wizard. 

• Modify will launch the Terminal Configuration Wizard for a highlighted terminal. Modifications can 
be made as described in Terminal Configuration Wizard. 

• Modify will launch the Terminal Server Group Configuration Wizard for a highlighted Terminal 
Server Group. This allows the Terminal Server Group to be configured as described in Terminal 
Server Group List. 

• Modify will launch the Terminal Server Configuration Wizard for a highlighted Terminal Server. 
This allows the Terminal Server to be configured as described in Terminal Server List Wizard. 

Rename 
Edit > Rename will allow a highlighted group or terminal to have its name changed in the tree of 
ThinManager. 

Note: The terminal name should be less than 15 characters because of limitations of the terminal server. 

Lock 
When a group property or a terminal property is opened for modification, the entry in the configuration is 
automatically locked to prevent two people from making changes at one time.  

Edit > Lock will manually lock the configuration of a group or terminal to prevent it from being changed. A 
lock icon will designate a locked group or terminal. 

 

Lock Icons 

When a terminal server or terminal server group is being modified, they will also be locked to prevent two 
people from making changes at the same time 

Unlock 
Edit > Unlock will manually unlock a terminal or group that was locked while being modified. This is used if 
the server was shut down while the terminal was locked, preventing the terminal from being unlocked 
automatically when the modifications are done. 

Using the Unlock function will display a warning to alert the user. 
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Lock Warning Message 

Unlocking a locked unit can cause a loss of configuration data if another user is modifying it. 

Note: This tool is to be used only when a terminal remains locked due to an unexpected server shut down 
while a terminal is being configured. Using this tool while another is configuring that terminal can lead 
to corruption of the database. 

Find 
Edit > Find launches a Find dialog that searches the tree for the item typed into the Find field. 

 

Find Dialog Box 

CTRL+F is the short cut key to launch Find. 

Find Next 
Edit > Find Next will continue searching the tree for the next instance of the text in the Find field of the Find 
dialog box.  

F3 is the shortcut key for this function.  

Manage 
The Manage menu has been split into two menu items, Manage and Install, in ThinManager 3.1. 

Manage keeps the management and configuration tools while commands for installation are moved to Install. 
The items in the Server List Management sub-menu have been moved to the Manage main menu. 

Terminal Server List 
Manage > Terminal Server List will launch the Terminal Server List Wizard for configuring terminal 
servers. See Terminal Server List Wizard for details. 
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Terminal Server Group List  
Manage > Terminal Server Group List will launch the Terminal Server Group List Wizard for creating 
Terminal Server Groups. See Terminal Server Group List for details. 

ThinManager Server List 
Manage > ThinManager Server List will launch the ThinManager List Wizard. See ThinManager Server 
List for details. 

TermSecure Access Groups 
Selecting Manage > TermSecure Access Groups will launch the Access Groups window. 

 

Access Groups Window 

Select the OK button to accept the changes and close the window. 

Select the Edit button to change the highlighted Access Group. 

Select the Add button to add a new Access Group. 

Select the Delete button to remove the highlighted Access Group. 

If the Add button is selected, an Access Group Creation window will be displayed. 

 

Access Group Creation Window 

Enter a name for the new Access Group and select OK to create the group. 
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TermSecure Access Groups Added 

Defined Access Groups will be displayed in the Access Group window. See Permissions for more details. 

DNS Configuration 
Manage > DNS Configuration will launch the DNS Configuration Wizard. See DNS Configuration for 
details. 

Configure Default Terminal 
Manage > Configure Default Terminal will launch the Terminal Properties for the “Default” terminal. This 
default terminal is used as a template that terminals created during Auto-Create are based on. See Auto-
Creation of Terminals for details on Auto-Creation of terminals. 

Restore Configuration 
Manage > Restore Configuration will allow a backed up ThinManager configuration to be applied to the 
ThinManager Server. Select Restore Configuration to launch the desired ThinManager Configuration file in 
the browse window and select Open. The backup copy will overwrite the existing configuration. 
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Restore ThinManager Configuration  

Backup Configuration 
Manage > Backup Configuration allows the ThinManager Configuration to be saved. Select Backup 
Configuration to launch a browse window and select the Save button to save a backup copy. 

 

Backup ThinManager Configuration 

Synchronize Configuration 
Manage > Synchronize Configuration allows the configuration of multiple ThinManager Servers to be kept 
identical so that a terminal will boot with the same configuration regardless of what ThinManager Server the 
terminal connects to. This is useful for multiple Thin Manager Servers and ThinManager Redundancy. 

Selecting Synchronize Configuration will launch the Synchronize ThinManager Server Configurations 
Wizard. 

Note: ThinManager has an Automatic Synchronization feature that will keep two ThinManager Servers 
synchronized without requiring a manual input. See ThinManager Server List Page for details. 



 

114  ••••  Menu Items ACP ThinManager 3.1 Help Manual 

ThinManager Server Configuration Synchronization Page 

 

Synchronize ThinManager Server Configuration Wizard 

Highlight the Configuration Source ThinManager Server and the Configuration Destination ThinManager 
Server and select Next. Although many ThinManager Servers can be defined it is normal to have just a 
primary and a backup ThinManager Server. 

Note: You may highlight multiple destinations to synchronize multiple ThinManager Servers by holding down 
the CTRL key while you select them with a mouse. 
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ThinManager Server Configuration Differences Page 

 

Synchronization Differences 

The ThinManager Synchronization Wizard will list the files being updated, including the firmware, TermCap 
database, modules, and the configuration. It synchronizes everything but the license. 

Note: The Synchronization tool does not compare and contrast then make changes back and forth. 
Synchronization will take the files and configuration from the source ThinManager Server and overwrite 
the corresponding files on the destination ThinManager Server. 

Select Next to continue.  
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ThinManager Server Synchronization Confirmation 

The ThinManager Server Configuration Wizard will prompt for a confirmation of the synchronization before 
proceeding. Select Finish to finalize the synchronization.  

 

Synchronization Progress Meter 

ThinManager will display the progress of the synchronization as it updates the files. 
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Reconnect  
Manage > Reconnect will reinitialize the connection to the selected ThinManager Server. 

Disconnect  
Manage > Disconnect will stop the connection to the selected ThinManager Server. 

Install 
Install is a new menu item that contains the commands from Manage that involve installation. 

License 
Install > License opens up the Licensing dialog box. See ThinManager Licensing for details. 

Modules   
Install > Modules open the Modules dialog box. This displays the modules that are available to the ACP 
Enabled thin clients. See Module Overview for details. 

 

Installed Modules Windows 

Selecting Install Module… will launch a dialog box that allows modules files to be selected. 

A module can be added to the list of available modules by highlighting the desired module file and selecting 
Open.  
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Open Module File 

See Module Overview for details 

Reports 
Install > Reports will launch a Reports window that allows additional reports to be added to ThinManager. 
See Reports for information on reports. 

 

Reports Window 

The Report Templates radio button shows installed report templates. The SQL Files radio button shows 
installed SQL queries. 
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Selecting the Install button will launch a Browse window that allows additional reports to be added to 
ThinManager. These can be downloaded from www.thinmanager.com.  

 

Reports Browse Window 

Navigate to the new Report Template, highlight it, and select Open to add the report template to 
ThinManager. 

Firmware 
ThinManager allows the firmware for the ThinManager Ready thin client to be upgraded with the latest version 
from the ThinManager web site (www.thinmanager.com).  

Select Install > Firmware to launch a file browser.  

 

Install New Firmware 

Select the new version of the firmware.acp and select Open. This will install the new version of the firmware. 
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The ThinManager Ready thin clients will download the new version of firmware when they reboot next. 

TermCap Database 
ThinManager has a Terminal Capability Database (termcap.db) that provides ThinManager with the 
configuration parameters for each thin client model. At each terminal connection, the TermCap database is 
checked and an integrity check is performed. If the configuration does not match the terminal specifications, 
ThinManager may reconfigure the terminal to acceptable parameters. 

 

Terminal Capabilities Integrity Check 

The Terminal Capability database can be updated with the current release from the ThinManager web site 
(www.thinmanager.com). 

To update the Terminal Capabilities Database, select Install > TermCap Database. 

 

Install New TermCap Database 

An Open dialog box will be launched.  

Select the new version of the termcap.db and select the Open button. This will install the new version. 

 



 

ACP ThinManager 3.1 Help Manual Menu Items  ••••  121 

Tools 
Tools contain commands that affect the terminals. 

Restart Terminals 
Tools > Restart Terminals will perform an intelligent restart of a terminal. It will load any changes to the 
configuration, modules, firmware, and reconnect them to the terminal server without cycling power to the 
terminal, unless it is needed to reload the firmware. 

Note: Restarting a terminal does not close the session on the terminal server nor does it unlock a frozen 
session. It reloads changes independent of the session on the terminal server. It will reconnect to the 
same session without changing the session. 

• Highlight a terminal in the ThinManager tree pane and select this command to restart a terminal.  

• Highlight a group in the ThinManager tree pane and select this command to restart all the terminals 
of the group. 

• Highlight a ThinManager Server in the ThinManager tree pane and select this command to restart all 
the terminals on the ThinManager Server. 

Reboot Terminals 
Tools > Reboot Terminals will cycle the power to the terminal, reloading the firmware and configuration, and 
reconnect it to the terminal server. The function of this command has been largely replaced by the Restart 
Terminal command. 

Note: Rebooting a terminal does not close the session on the terminal server nor does it unlock a frozen 
session. It reboots and reloads the firmware and configuration independent of the session on the 
terminal server. It will reconnect to the same session without changing the session. 

• Highlight a terminal in the ThinManager tree pane and select this command to reboot a terminal.  

• Highlight a group in the ThinManager tree pane and select this command to reboot all the terminals 
of the group. 

• Highlight a ThinManager Server in the ThinManager tree pane and select this command to reboot all 
the terminals on the ThinManager Server. 

Reboot Terminal Server 
Tools > Reboot Terminal Server will send a command to restart the highlighted terminal server.  

• Highlight a terminal server in the ThinManager tree pane and select this command to restart a 
terminal server.  

Caution: Reboot Terminal Server will restart the terminal server and log off all sessions without giving users 
a chance to save their data. Use wisely. 
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Disable Terminals 
The Disable Terminal command will disable any highlighted Group or Terminal by displaying a lockout 
screen. The terminal will wait until it is enabled with the Tools > Enable Terminal function to be functional 
again. This allows terminals to be locked down for security reasons, or to prevent the terminals from 
accessing the terminal servers. 

Highlighting a ThinManager Server, a Terminal Server, or Group in the ThinManager tree and selecting Tools 
> Disable Terminal will disable every terminal assigned to it. 

 

Disabled Terminal Icons 

If a Group or Terminal is disabled using the Tools > Disable function, it will be displayed with a red X over 
the terminal icon. An entire ThinManager Server or an entire Group can be disabled, but only the terminal 
icons will show the X, not the ThinManager Server icon or the Group icons. 

Once a terminal is disabled, a disabling screen will appear on the terminal until the terminal has been 
enabled. 
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Disabled Screen 

A logged on terminal will display a screen indicating that the terminal is disabled.  

 

Disabled Boot Screen 

Terminals that are booted while disabled will halt on a blue screen indicating that the terminal is disabled.  

Enable Terminals 
The Enable Terminal command will remove the disabling from a highlighted Group or terminal and allow it to 
continue functioning or resume the boot process. 

Disable Terminal Server 
The Disable Terminal Server command will disable all connections from the selected terminal server to all 
ThinManager Ready thin clients logged onto that server. The sessions will be disconnected but not reset.  
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Enable Terminal Server 
The Enable Terminal Server command will enable the terminal server to allow connections from 
ThinManager Ready thin clients.  

Calibrate Touch Screen 
ThinManager has a touch screen configuration utility that can calibrate a thin client touch screen. The utility 
can be started three ways:  

• On the thin client, select Start > Program Files > Automation Control Products > Calibrate Touch 
Screen (or Start > Program Files > Acp > CalTouchScreen). This is useful because it allows 
the operator to calibrate the touch screen without administrative support. 

• On the ThinManager Server, highlight the desired terminal in ThinManager and select Tools > 
Calibrate Touch Screen from the menu bar. This will launch the calibration on the selected 
terminal.  

• The TermMon ActiveX can be configured to launch the calibration program. See TermMon ActiveX 
Control for details. 

 

Touch Screen Calibration Screen 

A new touch screen calibration program was released with ThinManager 2.6 and is included in the 2.6 and 
later touch screen modules. When the calibration is run, an X appears in the lower left. Touch the center of 
the X and then touch the center of the other four Xs as they appear. This provides touch screen mapping for 
the terminal.  

Note: The touch screen module must first be added through the Module page in the Terminal Configuration 
wizard. 
To launch the calibration program from the Start menu from within the session requires that the 
ThinManager Utilities be installed on each terminal server. See Standard ThinManager Installation in 
Windows for details. 

 



 

ACP ThinManager 3.1 Help Manual Menu Items  ••••  125 

Send Message 
Send Message will send a message to a highlighted terminal.  

 
Send Message Window  

Enter the message into the Message text box. The Message Title can be changed, if desired. 

Select the OK button to send or the Cancel button to cancel. 

 
Send Message Window 

When a message is sent, an ACP splash screen will be displayed with the message until the message is 
acknowledged. 

Clear Event Log 
Selecting Clear Event Log will clear the event log. The event log is configured by selecting Manage > 
Settings to run the ThinManager Server Configuration Wizard.  
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View 

 Status Bar 
The Status Bar shows advice and comments on the bottom of the ThinManager window. When the Status 
Bar command is checked, the Status Bar text is visible. When the Status Bar command is unchecked, the 
Status Bar text is invisible. 

Show Connected Only 
View > Show Connected Only, if checked, will simplify the tree by removing unconnected terminal servers 
and terminal server groups. 

Reports 
View > Reports will open the Select Reports window.  

 

Select Reports Window 

The Select Reports window allows the selection of the default report that will display when the Report tab is 
selected for a ThinManager Server, terminal, terminal server, or TermSecure user. 

The default reports can be changed by selecting a different report in the drop-down boxes. 

See Reports for details. 

Print 
View > Print will print the report currently selected in the Report tab. 
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Print Reports 

A Print dialog box will appear to allow the selection of the printer and the desired number of copies. 

Options 
Selecting Options will launch the Options dialog box. 
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Options 

The Display “Create New Terminal” dialog for unknown terminals check box, if selected, will launch the 
Terminal Configuration Wizard on the ThinManager Server when a new terminal is added. 

The Display “Create New User” dialog for unknown users check box, if selected, will launch the 
TermSecure User Configuration Wizard on the ThinManager Server when an unknown ID device (USB key 
or ID card) is read by a terminal. 

Note: Checking the Display “Create New User” dialog for unknown users check box is useful for 
assigning ID cards to TermSecure Users. See Card and Badge Configuration for a TermSecure User 
for details. 

The Minimize to the System Tray checkbox will send the ThinManager icon in the system tray when 
ThinManager is minimized.  

Warn if license will expire within __ day(s) will set the warning period before license expiration. This is 
useful for time-limited demonstration and Trialware licenses. 

RemoteView 

Interactive Shadow 

Interactive Shadow, if checked, allows Administrators and members of the ThinManager Security Groups 
that have interactive shadow permissions to interact and control a shadowed terminal session. If this value is 
unchecked the sessions will be viewable, but observers cannot take control of the session. 

Scaled to Window 
Scaled to Windows, if checked, will scale the shadowed terminal session to fit the Details pane of 
ThinManager. If this value is unchecked the session will be viewed regular-sized, requiring the use of scroll 
bars to view portions of the screen. 
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Go FullScreen 

This allows the connection from the Connect tab on ThinManager to the terminal server to be displayed full 
screen instead of in a window in ThinManager. 

This session can be switched to full-screen by selecting RemoteView > Go FullScreen in the menu. This 
changes the appearance from running from within a window to running as a desktop. 

The full screen session will have a tool tab at the top of the screen with controls that allow the window to be 
switched back to the window or to close the connection. 

 

Remote Session Tool Bar 

The standard Minimize, Maximize, and Close icons on the Remote Session Tool Bar allow control over the 
session. 

Connect Options 

Selecting RemoteView > Connect Options will launch the Terminal Server Connect Options window that 
allows the terminal server Remote View connection to be configured. 

 

Terminal Server Connect Options 

The settings include: 
• Video Mode – This allows the connection to be displayed at a specific resolution or as full screen. 

• Width – This allows the connection to be displayed at a specific width if the Video Mode is set to 
Custom. 

• Height – This allows the connection to be displayed at a specific height if the Video Mode is set to 
Custom. 

• Color Depth - This allows the connection to be displayed at a specific color depth. Windows 2003 is 
required for high-color. 

• Allow Auto-Login – This allows the connection to login without prompting when checked. 
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• Allow Access to Local Drives – This allows the user to access the hard drive on the remote 
computer from the remote connection.  

Send Key 

Send Key allows the sending of key commands to the shadowed session that are normally saved for the local 
machine and don’t function in shadowing. These include:  

• CTLL+ALT+DEL 

• CTL+ESC 

• ALT+Tab 

• ALT+Shift+Tab 

• ALT+ESC 

• ALT+Space. 

Select RemoteView > Send Key and the desired key combination to send the key command to the 
shadowed session. 

Note: The Key Block module will block this command if it is used on the terminal. See Key Block Module for 
details. 

 Help 

 Help Topics 
Selecting Help Topics will launch the ThinManager Help file. This file can also be launched by selecting F1 
while using ThinManager. 

 About ThinManager 
Selecting About ThinManager will display a dialog box with ThinManager version information, copyright 
information, and contact information for ThinManager. 

 

Right Click Menus in the Tree Pane 

Right Click on the ThinManager Server Icon 
• Reconnect - This causes the ThinServer service to try to reconnect to the highlighted ThinManager 

Server. 

• Modify - This launches the ThinManager Server Configuration Wizard to configure the highlighted 
ThinManager Server. 

• Remove - This removes the highlighted ThinManager Server from the tree. It does not remove any 
configuration or uninstall the program. 

 See Add ThinManager Server for details. 
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Right Click on the Terminals Branch Icon 
• Add Terminal - This launches the Terminal Configuration Wizard to create a terminal. 

• Add Group - This launches the Terminal Group Configuration Wizard to create a group. 

• Restart Terminals - This sends a signal to all the terminals to reload any changes to its 
configuration, modules, or firmware. It will only do a full reboot if needed. 

Right Click on a Group Icon 
• Add Terminal - This launches the Terminal Configuration Wizard to create a terminal in the group. 

• Add Group - This launches the Terminal Group Configuration Wizard to create a group. 

• Restart Terminals - This sends a signal to all the terminals under the highlighted icon to reload any 
changes to its configuration, modules, or firmware. It will only do a full reboot if needed. 

• Modify - This launches the Terminal Group Configuration Wizard to configure the highlighted 
group. 

• Rename - This allows the Group to be renamed. 

• Delete - This removes the Group from the ThinManager configuration. Member terminals can be 
deleted with the group, or moved out of the group, depending on the choice in the confirmation 
window. 

 

Delete Group confirmation Window 

Selecting Yes will delete the Group and all member terminals. 

Selecting No will delete only the group. The member terminals will be moved out of the group and retain their 
configuration as individuals. 

Selecting Cancel will stop the process and allow the group to remain as it is. 

Right Click on a Terminal Icon 
• Modify - This launches the Terminal Configuration Wizard to configure the highlighted terminal. 

• Rename - This allows the terminal to be renamed. 

• Delete - This removes the terminal from the ThinManager configuration.  

• Go to TermSecure User - This changes the focus of the tree to the TermSecure User that is logged 
into the terminal. 

• Restart Terminal - This sends a signal to the terminal to reload any changes to the configuration, 
modules, or firmware. It will only do a full reboot if needed. 
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Right Click on the Terminal Server Branch Icon 
• Add Terminal Server - This launches the Terminal Server Wizard to create and configure a new 

terminal server. 

• Edit Terminal Server - This launches the Terminal Server List Wizard to allow the configuration of 
an existing terminal server. 

See Terminal Server List Wizard for details 

Right Click on a Terminal Server Icon 
• Modify - This launches the Terminal Server Configuration Wizard to allow changes to the 

configuration of the highlighted terminal server. 

• Rename - This allows the terminal server to be renamed. 

• Delete - This removes the terminal server from the ThinManager configuration.  

 

Terminal Server Deletion Confirmation 

ThinManager will prompt for confirmation before deletion. 

 

Terminal Server Deletion Error 

A terminal server cannot be deleted from a configuration if it still has terminals assigned to it. 
• Restart Terminals - This sends a signal to the terminal to reload any changes to all terminals 

connected to the terminal server. It will only do a full reboot if needed. 

Right Click on the Terminal Server Group Branch Icon 
• Add Terminal Server Group - This launches the Terminal Server Group Wizard to create and 

configure a new terminal server group. 

• Edit Terminal Server Group - This launches the Terminal Server Group List to allow the 
configuration of an existing terminal server group. 

See Terminal Server Group List for details. 

Right Click on a Terminal Server Group Icon 
• Modify - This launches the Terminal Server Group Configuration Wizard to allow changes to the 

configuration of the highlighted terminal server. 

• Rename - This allows the Terminal Server Group to be renamed. 
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• Delete - This removes the Terminal Server Group from the ThinManager configuration.  

 

Terminal Server Deletion Confirmation 

ThinManager will prompt for confirmation before deletion. 

 
Terminal Server Group Deletion Error 

A Terminal Server Group cannot be deleted from a configuration if it still has terminals assigned to it. 

Right Click on the TermSecure Users Branch 
• Add TermSecure User – This launches the TermSecure User Configuration Wizard to allow a 

TermSecure User to be defined. 

• Add TermSecure User Group – This launches the TermSecure User Group Configuration Wizard 
to allow a TermSecure User Group to be defined. 

Right Click on a TermSecure Users Group Icon 
• Add TermSecure User – This launches the TermSecure User Configuration Wizard to allow a 

TermSecure User to be defined. 

• Add TermSecure User Group – This launches the TermSecure User Group Configuration Wizard 
to allow a TermSecure User Group to be defined. 

• Modify - This launches the TermSecure User Group Configuration Wizard to allow changes to the 
configuration of the highlighted TermSecure User Group. 

• Rename - This allows the TermSecure User Group to be renamed. 

• Delete - This will remove the TermSecure User Group from the ThinManager configuration.  

Right Click on a TermSecure Users Icon 
• Modify - This launches the TermSecure User Configuration Wizard to allow changes to the 

configuration of the highlighted TermSecure User. 

• Rename - This allows the TermSecure User to be renamed. 

• Delete - This removes the TermSecure User from the ThinManager configuration.  

• Logoff User – This logs the TermSecure User out the terminal that it is currently logged into. 

• Go to Terminal - This changes the focus of the tree to the terminal that the TermSecure User is 
logged into. 
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Adding Thin Client Hardware 

The Boot Process  
 

There are two methods that an ACP Enabled, ThinManager Ready thin client can use to boot. The standard 
method is to connect to a ThinManager Server and download the firmware and its configuration across the 
network. This allows for an easy update of the firmware and ensures that all the terminals share the same 
firmware. Disk-On-Chip ThinManager Ready thin clients have the firmware embedded in them and boot 
locally then connect to a ThinManager Server to download its configuration. See Firmware Update (Disk On 
Chip / Compact Flash) Update Module for details. 

A ThinManager Ready thin client goes through a number of steps from the initial power on to the complete 
connection to a terminal server. Understanding this process will aid in terminal configuration and 
troubleshooting.  

The steps are: 

POST: Once a ThinManager Ready thin client is turned on it begins the Power On Self-Test to examine the 
hardware and to test the memory.  

IP Address Assignment: The terminal needs an IP address to connect to the network. By default, it receives 
an IP Address from a DHCP server, but this can be changed to use an assigned static IP. See IP Address 
Assignment for details. 

ThinManager Server Connection: After receiving an IP address the terminal will connect to the 
ThinManager Server. This is the Boot Server Host as defined in the DHCP scope Option 066 or the Primary 
ThinManager Server defined in the static IP address configuration.  

Firmware Loading: Next the terminal will download the firmware from the ThinManager Server.  

Terminal Configuration Download: Established terminals will receive their configuration and proceed. New 
terminals will need to be defined on the ThinManager Server, either through the Terminal Configuration 
Wizard or the Create New Terminal method. 

ACP Logo Screen: After the terminal receives its configuration, it will display an ACP splash screen with the 
ACP logo.  

Client Communication Connection: Next the terminal will launch its Client Communication protocol. If using 
ICA it will display a Citrix splash screen while it makes an ICA connection to the terminal server.  

Terminal Server Connection: The thin client will connect to the terminal server(s) that it is assigned to in its 
configuration. 

Windows Login: Next the terminal will display the Windows Login dialog box, prompting for a valid username 
and password. If these have been entered into the username and password fields on the Sessions tab of 
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ThinManager, the terminal will login automatically and display the Windows desktop or a defined initial 
program.  

Note: Windows 2000 prevents auto-login with RDP by default. To allow auto-login see Configuring RDP for 
Auto-Login for details. 

Windows Session: The terminal logs onto a session on terminal server. The terminal will pass mouse clicks 
and keystrokes to the session on the terminal server. The terminal server will process the data and send the 
graphics back to the terminal for display, giving a full Windows experience to the user. 

IP Address Assignment 
ThinManager Ready thin clients are set by default to automatically receive an IP address from a DHCP 
server. Most ThinManager Ready thin clients may use a manually assigned Static IP address instead.  

Note: The ThinAdapter and ThinAdapter Plus require DHCP. 

DHCP 
ThinManager Ready thin clients are set to use DHCP (Dynamic Host Configuration Protocol) by default. The 
DHCP Server needs two options configured for ThinManager Ready thin clients. 
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DHCP Options 

Option 066 - Boot Server Host Name must be set to the IP address of the ThinManager Server. If redundant 
ThinManager Servers are being used, the IP addresses of multiple ThinManager Servers can be entered, 
separated with a space. 

Option 067 - Bootfile Name must be set to firmware.acp. 

Details are at DHCP Server Setup for details. 

ThinManager Ready thin clients use DHCP (Dynamic Host Configuration Protocol) by default. If they have 
been set to use a static IP they can be reset to DHCP from static IP by pressing any key when prompted 
during the boot sequence to open the IP Configuration Menu.  
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IP Configuration Menu - DHCP 

Press the A key to allow a change to DHCP  and enter D key to set the configuration to DHCP. Press the 
Enter key to return to main menu. 

Press the S key to save the configuration and continue with the boot process. 

 

Boot Process - Firmware Download 

The terminal will connect to the ThinManager Server and download the firmware. 

Static IP 
Most models of ThinManager Ready thin clients allow the usage of static IPs. These are set by interrupting 
the boot process to launch the IP Configuration Menu and adding the static IPs.  
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Boot Process - Press Any Key Prompt 

To set the terminal to use a static IP, press any key at the appropriate moment of the boot sequence. 

 

IP Configuration Menu – Static IP 

Press the A to allow the client IP to change from DHCP. 

Type in the static IP address for the client, including the separating periods and press the Enter key. 
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IP Configuration Menu - Options 

Once the Terminal has a static IP assigned, the IP Configuration Menu will be shown to allow the setting of 
other values. 

• (A) Terminal IP Address - This should be a unique address for the terminal. 

• (B) Primary ThinManager Server IP Address - This should be the unique address for your main 
ThinManager Server. 

• (C) Secondary ThinManager Server IP Address - The Secondary ThinManager field allows the 
terminal to use two ThinManager Servers. If the terminal cannot connect to the Primary 
ThinManager Server, it will connect to the Secondary ThinManager Server to receive its 
configuration. If you are not using a Secondary ThinManager Server, set the IP address to 
0.0.0.0. 

• (D) Router IP Address - Fill in the IP address of the router or gateway if one is being used. If not this 
should be set to 0.0.0.0. 

• (E) Subnet Mask - Set this to your subnet mask. 255.255.255.0. is a standard setting. 

• (F) Password Status - Allows a password to be set to prevent unauthorized people from changing 
the configuration.  

• (H) Help - Will launch a Help to explain the IP Configuration Menu. 

• (Q) Abort Changes and Exit - This will cancel any setting changes and let the terminal continue to 
boot with the old settings. 

• (S) Save Changes and Exit - This will apply any changes and allow the terminal to continue to boot 
with the new settings. 

Type the letter of the desired setting and type the IP address, with periods. Press the Enter key on the 
keyboard to accept each change. 

Once configured the terminal will connect to the ThinManager Server and download the firmware and 
configuration. 

Hybrid IP Addressing  
ThinManager Ready thin clients that have BootROM version 5.01 have the ability to use DHCP for the client 
IP address and have the ThinManager Server IP addresses entered as static IPs to save having to configure 
the DHCP server with Option 066. 
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Selecting any key when prompted during bootup opens the IP Configuration Menu. 

  

Boot Loader v5.01 Default Values 

Typing the B key will allow the configuration of a static IP for the ThinManager Server. Type the numbers and 
periods for the address. 

 

DHCP with Static ThinManager Server 

Once a ThinManager Server is assigned, typing C will allow a redundant secondary ThinManager Server to 
be assigned. 

Type S to save the changes and allow the connection to the ThinManager Server. The terminal will now boot 
using DHCP. 

Note: The Escape key will let you exit the entry field and return to the IP Configuration Menu. 
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Configuring New Hardware 
The configuration of terminals is done in ThinManager on the ThinManager Server and not on each individual 
terminal. When a new, undefined ThinManager Ready Thin Client is first connected to a ThinManager Server 
one of three things will happen: 

• If the ThinManager Server has no terminals that are configured and offline, then the terminal will go 
into the Create New Terminal Mode and launch the Terminal Configuration Wizard on the 
ThinManager Server. Once the terminal is configured on the ThinManager Server it will 
automatically download its configuration upon boot up. 

• If the ThinManager Server has terminals that are created and offline, the terminal will go into Replace 
or Create Mode and list the offline terminals that are available for selection. Once a configuration 
is selected, the terminal will take that identity. During any following boot up the terminal will 
automatically download its configuration. 

• A third scenario is to use the Auto-Create Terminal Mode to create an array of terminals.  

Create New Terminal Mode  
Turning on a terminal for the first time will initiate the Create New Terminal mode if: 

• No terminals are defined in ThinManager, or  

• All the defined terminals are currently connected, or 

• All the defined terminals that are turned off have the Allow This Terminal To Be Replaced If Off 
Line check box unselected. 

 

Create New Terminal Mode Screen 

When a terminal enters the Create New Terminal Mode, the terminal will launch the Terminal Configuration 
Wizard on the ThinManager Server. The terminal will display a screen indicating that it will wait until the 
configuration is finished before progressing further.  

Replace or Create New Terminal Mode 
Turning on a terminal for the first time will initiate the Replace or Create New Terminal Mode if one or more 
of the defined terminals are offline and they have the Allow This Terminal To Be Replaced If Off Line 
check box selected. 
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Replace or Create Mode 

The screen will display all the offline terminals that the terminal can replace. Highlight the desired terminal 
name using the keyboard and press the Enter button. The terminal will retrieve the selected configuration and 
assume its identity.  

Auto-Creation of Terminals 
Auto-Create allows new terminals to be created and configured in an array, using the Default Terminal as a 
template. 

Turning on a terminal for the first time will initiate the Replace or Auto-Create Terminal mode if: 
• The Auto-Create mode is enabled by the selection of the Enable AutoCreate check box on the 

Unknown Terminal page of the ThinManager Server Configuration Wizard. 
The ThinManager Server Configuration Wizard is launched by selecting Manage > Settings 
from the ThinManager menu. 

And 
• The Default terminal is configured as a template for the new terminals.  

This is done by selecting Manage > Configure Default Terminal on the ThinManager menu. 

And 
• The user selects Auto-Create from the Replace or Action Menu as the terminal boots and 

connects. The user can do a replacement instead of an Auto-Create. 

 

Enabling AutoCreate 
The terminal will be given the name of the Auto-Create Mask and a number, starting with “0”. The Auto-
Create Mask is configured in the ThinManager Server Configuration Wizard. Open the ThinManager 
Server Configuration Wizard by right clicking on the ThinManager Server in the tree and selecting Modify, or 
select Manage > Settings from the menu. 
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Unknown Terminals 

Check the Enable AutoCreate checkbox and enter an AutoCreate Mask name. This allows new terminals to 
be added to the system and configured without additional input from the server.  

Configuring Default Terminal 
The Default Terminal is created by selecting Manage > Configure Default Terminal. This will launch the 
Terminal Configuration Wizard for a terminal pre-named “Default”.  
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Default Terminal Configuration 

Configure the terminal with the desired settings. The Default terminal can be added to a Group by selecting 
the Change Group button. 

Once the wizard is finished, the Default terminal will be displayed in the ThinManager Server tree. 



 

146  ••••  Adding Thin Client Hardware ACP ThinManager 3.1 Help Manual 

 
ThinManager Tree with Default Terminal 

Once the Enable AutoCreate check box on the Server Properties window is checked and the Default 
Terminal is created and configured, any new terminal connected to the ThinManager Server will have 
AutoCreate Terminal as an option. 
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Replace or Action Menu 

The user needs to scroll to AutoCreate Terminal and press the Enter key to automatically create and 
configure the terminal. 

The new terminal will be given the AutoCreate Mask and a number, starting at 0, for its name. This name will 
also be entered in the Username field of the Log In Information page of the Terminal Configuration 
Wizard. 
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Configuration Wizards 

Introduction to Wizards 
ACP ThinManager Version 2.4 introduced Configuration Wizards to simplify the creation and configuration of 
ACP Enabled Thin Clients. ThinManager 3.1 extends the scope of the wizards to provide more configuration 
power. The Classic Mode of ThinManager 1.0 is now eliminated. 

Wizards take two forms. 
• List Wizards associate Terminal Servers and ThinManager Servers with their IP addresses or assign 

server functions to groups of Terminal Servers. 

• Configuration Wizards set the parameters and options for individual terminals, groups of terminals, 
TermSecure Users, and TermSecure Server Groups. This is where the terminals and 
TermSecure Users have their settings defined. 

The List Wizards can be launched by: 
• Selecting Manage from the ThinManager menu and selecting Terminal Server List, Terminal 

Server Group List, ThinManager Server List, or DNS Configuration. 

• Right clicking on the Terminal Server branch in the tree to launch the option to define a terminal 
server with the Add Terminal Server command, or to edit an existing configuration by selecting 
the Edit Terminal Server command. 

• Right clicking on the Terminal Server Group branch in the tree to launch the option to define a 
Terminal Server Group with the Add Terminal Server Group command, or to edit an existing 
configuration by selecting the Edit Terminal Server Group command. 

The Configuration Wizards can be launched by: 
• Selecting Edit > Add Terminal in the menu to launch the Terminal Configuration Wizard. 

• Selecting Edit > Add Terminal Group in the menu to launch the Group Configuration Wizard. 

• Right clicking on the Terminals branch in the tree to launch the option to define a Terminal with the 
Add Terminal command, or to define a Group with the Add Group command.  

• Right clicking on a Terminal Group in the tree to launch the option to define a Terminal Group with 
the Add Group command, or to define a Terminal with the Add Terminal command. This puts 
the terminal or group in that group. 

• Right clicking on the TermSecure User branch in the tree to launch the option to define a 
TermSecure User with the Add User command, or to define a TermSecure User Group with 
the Add Group command. 
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• Right clicking on a TermSecure User Group in the tree to launch the option to define a TermSecure 
User Group with the Add TermSecure User Group command, or to define a TermSecure User 
with the Add TermSecure User command. This puts the TermSecure User or TermSecure User 
group in that TermSecure User group. 

See Terminal Server List Wizard for details.  

See Terminal Server Group List for details. 

See ThinManager Server List for details. 

See DNS Configuration for details. 

See Terminal Group Configuration Wizard for details. 

See Terminal Configuration Wizard for details. 

See TermSecure User Configuration Wizard for details. 

See TermSecure Users Group Configuration Wizard for details. 
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List Wizards 
ThinManager has List wizards that allow the names of Terminal Servers, Terminal Server Groups, 
ThinManager Servers, and Domain Name Servers to be associated with their IP address for easy use. This is 
similar in function to a host table. 

Each of the List Wizards is launched in the appropriate place during group and terminal configuration in the 
Group Configuration Wizard and Terminal Configuration Wizard, but they can also be run individually to 
configure and identify the members ahead of time. 

Terminal Server List Wizard   
The Terminal Server List Wizard can be launched by selecting Manage > Terminal Server List from the 
menu or by right clicking on the Terminal Server branch and choosing either the Add Terminal Server 
command, or the Edit Terminal Server command. 

 

Terminal Server List Wizard 

The opening window of the Terminal Server List Wizard will show any Terminal Servers that are defined or 
will be blank if none have yet been defined. 

• Edit Server will open the properties for a highlighted terminal server in the list. 

• Add Server will allow a new terminal server to be defined. 

• Remove Server will remove a highlighted terminal server from the list. 

• Find Server will launch the Available Terminal Servers window for automated terminal server 
addition. 

• Cancel will close the wizard without action. 

• OK will close the wizard after accepting changes. 

Selecting Add Server will open the Terminal Server Wizard Introduction page. 



 

152  ••••  Configuration Wizards ACP ThinManager 3.1 Help Manual 

Selecting the Find button will open the Available Terminal Server window that lets ThinManager search for 
terminal servers. 

Available Terminal Servers Search 

 
Available Terminal Server Window 

The Available Terminal Servers window will display any Microsoft terminal servers that are a member of the 
same domain or workgroup as ThinManager. 
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Available Terminal Server Window 

The Domain or WorkGroup to Search field will allow ThinManager to search a different domain or 
workgroup. Enter the domain of workgroup to search and select the Find button to display the member 
servers. 

Once the terminal servers are listed, highlight one and select the OK button to add it to the Terminal Server 
Configuration Wizard. This will launch the Introduction page of the Terminal Server Wizard. 
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Terminal Server Wizard Introduction Page  

 

Terminal Server List Wizard Introduction 

The Terminal Server List Wizard starts with an Introduction page with instructions for the wizard. Select 
Next to continue. 
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Terminal Server Name Page  

 

Terminal Server List Wizard – Terminal Server Name 

The Terminal Server Name page defines the Terminal Server on the network.  

The Terminal Server Name fields are: 
• Terminal Server Name - Enter the computer name as found in the Microsoft System Properties 

(NetBIOS name). The name will already be entered if the Find function on the Available 
Terminal Servers window was used.  

• Terminal Server IP – Entered the IP address of the terminal server. 

• Discover – The Discover button will automatically fill in the IP address for a terminal server listed in 
the Terminal Server Name field. 

• Domain - Enter the domain for the computer, if it is a member of a domain. 

• User Name - Enter a username with administrative rights if you wish to display data from the terminal 
server within ThinManager. 

• Password - Enter the password for the administrative account used in the Username field.  

• Verify Password – Re-enter the password for the administrative account used in the username field. 
Passwords that do not match will be indicated by a warning message on the page. 

• Schedule – The Schedule button will launch the Event Schedule for the terminal server. This allows 
the scheduling of repeated functions like rebooting and disabling. 



 

156  ••••  Configuration Wizards ACP ThinManager 3.1 Help Manual 

Note: ThinManager uses a connection to the terminal server to pull the process, user, and session 
information for the detail pane tabs and to determine the load for SmartSession load balancing. 
Entering a username and password in the User Name and Password fields allows ThinServer to 
connect to the server for this data. 

Terminal Server Schedule 

Selecting the Schedule button on the Terminal Server Name page will launch the Event Schedule window 
and allow a schedule to be created for terminal server events. 

 

Event Schedule 

The Event Schedule will list events for the terminal or group. It has four buttons. 

• The Add button will launch a Schedule window to allow an event to be configured. 

• The Edit button will allow a highlighted event to be changed. 

• The Delete button will remove a highlighted event. 

• The OK button will accept changes and close the Event Schedule window. 

Events can be added by selecting the Add button to launch the Schedule window. 
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Schedule Window 

The Schedule window has several configuration settings. 

Event Type is a drop-down box that allows event selection: 

• Disable Terminal Server - This will disconnect all the ThinManager Ready thin clients connected to 
the terminal server. The sessions will remain idle on the terminal server unless they are set to 
disconnect in the Terminal Services Configuration console. See Disable Terminal Server for details. 

• Enable Terminal Server - This will allow a disabled terminal server to accept ThinManager Ready 
thin client connections again. 

• Reboot Terminal Server - This will cycle power on the terminal server and restart it. 

The Repeat Interval radio buttons allow the event in the Event Type drop-down to be run Once Only, 
Weekly/Daily, Monthly, or Yearly.  

• Selecting Once Only will show a Select Date field for the event.  

• Selecting Weekly/Daily will show a Weekly Schedule list for the event to run. The Every Day button 
will select all the days in the list. 

• Selecting Monthly will show a Select Day of Month field for the event.  

• Selecting Yearly will show a Select Date field for the event.  

The Time field allows the selection of the time that the event should occur.  

Select the OK button to close the Schedule window. Select Add to add another event to the Event Schedule 
or select OK to close the Event Schedule window and return to the terminal server configuration. 

Select Next to continue with the Terminal Server Capabilities page. 
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Terminal Server Capabilities Page  

 

Terminal Server Capabilities 

The Terminal Server Capabilities page determines whether a terminal server is configured for 
SmartSession and Multi-Session and determines what client communication protocols are used.  

• Check the Smart Session Server checkbox to make the terminal server available for terminal 
server groups using SmartSession to provide load balancing. See SmartSession for more details. 

• Check the Make this server available for MultiSession configurations checkbox to make the 
terminal server available for terminal server groups configured for MultiSession. See MultiSession 
for details. 

Note: Configuring a terminal server to use SmartSession uses a SmartSession license. Configuring a 
terminal server to use MultiSession uses a MultiSession license. 

Supported Connections contains a list of the client communication protocols that the terminal server can 
use to talk to the ThinManager Ready thin client. 

• Check the Citrix MetaFrame checkbox if that program, or another Citrix server-side program, is 
installed on the terminal server to provide the ICA protocol. Citrix MetaFrame is an optional 
program sold by Citrix. 

• Check the Citrix Device Services checkbox if Citrix Device Services is installed and licensed on 
the terminal server. Citrix Device Services is a legacy deployment of the ICA client but is no 
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longer supported by Citrix. ThinManager Ready thin clients can still connect to terminal servers 
with Device Services, but no new Device Services terminal servers can be licensed. 

• Microsoft Remote Desktop Protocol (RDP) is installed by default on Windows Terminal 
Servers. Uncheck the Microsoft Remote Desktop Protocol checkbox if you don’t want to 
access to the terminal server with the protocol. 

Selecting Next will open the Data Gathering page. 

Data Gathering Page 

 

Data Gathering 

The Data Gathering page allows configuration of the intervals that ThinManager uses to poll data from the 
terminal server. Preset intervals can be used, or custom intervals can be applied. 

• Smart Session Data Update Interval is the amount of time between the retrieval of 
SmartSession data, CPU usage, memory usage, and session count, from the terminal server. 
This setting affects the update speed of the Server Rankings used in SmartSession load 
balancing. 

• Process Update Interval is the amount of time between the retrieval of the process information 
on the terminal server. This setting affects the speed of the update of the process information on 
the Processes tab for the terminal server. 

• Session Update Interval is the amount of time between the retrieval of session data from the 
terminal server. This setting affects the speed of the update of the user information for the 
sessions on the Users and Sessions tabs for the terminal server. 
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If this terminal server is used as a SmartSession server, the Next button will go to a SmartSession 
Configuration page. If this terminal server is not configured as a SmartSession server, the Next button will be 
grayed out and the Finish button will close the wizard. 

SmartSession Configuration Page 

 

Terminal Server List Wizard - SmartSession Configuration 

ThinManager uses the CPU utilization, Memory utilization, and number of sessions on the terminal server 
to define the SmartSession terminal server’s available resources. ThinManager uses these resource values to 
rank the load of the SmartSession servers. ThinManager supplies this load data to the terminals to allow the 
terminals to connect to the terminal server with the lightest load and greatest available resources.  

The SmartSession Configuration page allows the configuration of the three parameters that ThinManager 
uses to determine availability for SmartSession. ThinManager will scale the range between the Minimum field 
and Maximum field as 100%. 

• The Minimum field is the value that ThinManager will use as the starting point of the load. A 
value below the Minimum is considered to be unused.  

• The Maximum field is the value that ThinManager will consider the parameter as reaching 100% 
utilized and is unavailable. 

The Finish button will close the configuration of that terminal server and return to the beginning of the 
Terminal Server List Wizard for the configuration of other terminal servers. 
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Terminal Server List Wizard Window 

 

Terminal Server List Wizard 

Once all the Terminal Servers are defined and configured in the Terminal Server List Wizard it can be 
closed by selecting the OK button. 
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Terminal Server Group List 

The Terminal Server Group List Wizard can be launched by selecting Manage > Terminal Server Group 
List from the menu or by right clicking on the Terminal Server Group branch and choosing either the Add 
Terminal Server Group command or the Edit Terminal Server Group command. 

 

Terminal Server Group List Wizard 

The opening window of the Terminal Server Group List Wizard will show any Terminal Server Groups that 
are defined or will be blank if none have been defined. 

• Add Group will allow a new Terminal Server Group to be defined.  

• Edit Group will open the properties for a highlighted Terminal Server Group in the list. 

• Delete Group will remove a highlighted Terminal Server Group from the list. 

• Cancel will close the wizard without action. 

• OK will close the wizard after accepting changes. 

Selecting Add Group will open the Group Name page. 
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Terminal Server Group Name Page 

 

Group Name Page 

Enter the desired name of the group in the Group Name field. 

Each group can contain members of one type of Client Communication Protocol. These are configured for the 
terminal servers during the Terminal Server Configuration.  

The Permissions button will launch the Permissions window that allows Permissions to be set for 
TermSecure. This is discussed in Permissions. 

Once the Permissions are set, select the desired Client Communication Protocol and select Next to configure 
the group options. 
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Terminal Server Group Citrix MetaFrame Page 

 

Citrix MetaFrame Options 

If Citrix MetaFrame is the Client Communication Protocol chosen, the Citrix MetaFrame page will be 
displayed to allow the setting of Citrix options including Encryption Level and the use of Published 
Applications. The ICA Browser Address allows aid in connection across routers, subnets, and domains. 

If a published application is used, check the Use a Citrix Published Application checkbox and enter the 
published application in the Enter the name of a Published Application field. This finishes the wizard, 
graying out the Next button and activating the Finish button. 

Note: Published Application should have a continuous name and not contain spaces. 

Select Next to continue. 
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Terminal Server Group - Group Options Page 

 

Group Options 

The Group Options allow the configuration of terminal server group parameters. 

Group Type Options include: 
• SmartSession Group – Selecting this option allows the terminal server group to provide load 

balancing by using CPU availability, memory, and the number of sessions on the member 
terminal servers to determine the availability of resources on member terminal servers. 
ThinManager Ready thin clients connect to the terminal server in the terminal server group with 
the most available resources. See SmartSession for details. 

• Make group available for MultiSession Configurations – This allows the terminal server group to 
be available to ThinManager Ready thin clients that use MultiSession to connect to two or more 
terminal server groups. See MultiSession for details. 

• Application Link Group – This option, AppLink, provides the Initial Program function to 
ThinManager Ready thin clients that connect to members of the terminal server group. The Initial 
Program function launches a program instead of the desktop. Closing the program will end the 
connection and force a reconnection to a session running the application. See AppLink for details. 

Group Options include: 
• Enforce Primary - This allows a ThinManager Ready thin client to connect to its original terminal 

server if that terminal server has failed and recovered.  
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Note: Enforce Primary is not available with SmartSession. 

• Instant Failover - Allows a terminal to connect to two terminal servers in the Terminal Server Group. 
The terminal will have an active session on two terminal servers but will only display one session. 
If the first terminal server fails, the session of the second terminal server is immediately 
displayed, eliminating any downtime due to terminal server failure. 

Note: A terminal requires an Instant Failover license to use this function.  

• Always maintain a session for this group – If checked, if the user closes his session, another 
session will be started automatically. If unchecked, the user can close a session and another 
session won’t start automatically.  

• Start a session at boot-up for this group – If checked, the terminal will start a session for this 
terminal server group at boot up. If unchecked, a user action is required to start the session. 

Note: The Always maintain a session for this group and Start a session at boot-up for this group 
checkboxes, if unselected, will lower the demand on the terminal servers by allowing sessions to be 
closed until needed. 

• Allow Auto-Login - If checked, the terminal will use the login information supplied in the terminal 
configuration to automatically logon to the terminal server. If unchecked, the user will be required 
to manually login to the terminal server.  

• Allow Group to be moved (MultiMonitor) – If checked, this allows a Terminal Server Group to be 
moved from one MultiMonitor screen to another. See MultiMonitor for details. 

• Disconnect session when group is in the background – If checked, this allows a Terminal Server 
Group being used in a MultiSession configuration, to disconnect once it is moved into the 
background. This could be done to require fewer resources.  

Once the Terminal Server Group parameters are configured, select Next to select the terminal servers for the 
group. 
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Terminal Server Group Members Page 

 

Terminal Server Group Members 

Once the Terminal Server Group is configured, the available Terminal Servers are listed on the Terminal 
Server Group Members page. Highlight the desired terminal server from the left-hand Available Terminal 
Servers list and use the arrow to move it into the right-hand Selected Terminal Servers column. Use the Up 
arrow and Down arrow to prioritize the order of connection unless SmartSession is being used. 

Select the Edit Server List button to configure additional Terminal Servers. 

If the Terminal Server Group is using the SmartSession option, the Next button will launch the SmartSession 
Settings page.  

If the Terminal Server Group is not SmartSession Group the Finish button will complete the Terminal Server 
Group configuration. 
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Terminal Server Group SmartSession Settings Page 

 

Smart Session Settings 

The SmartSession Settings page sets the weight of the three parameters that ThinManager uses to 
determine availability for SmartSession. 

ThinManager multiplies the CPU utilization, Memory utilization, and number of sessions on the terminal server 
by the Weight shown to define the SmartSession terminal server’s available resources.  

The higher the Weight, relative to the others, the greater the importance that parameter has in determining 
the load for SmartSession. 

Note: The Weighs are relative. Increasing all three Weights from “1” to “10” doesn’t change the relative 
values. 

Queuing controls the rate that terminals connect to the terminal servers in the Terminal Server Group to allow 
processor intensive applications to load one at a time instead of many sessions forming at once, bringing the 
server to a halt. As terminals that use SmartSession Queuing boot, they request their terminal server from 
ThinManager. ThinManager will send the first terminal to the terminal server with the lightest load and will put 
the other terminals in a queue for the interval defined in the Min _ Sec field. This allows the terminal server 
load to stabilize and allows ThinManager to re-sample the loads and send the terminal to the terminal server 
with the lowest current load. 

• Min _ Sec is the amount of seconds that a terminal will wait in the queue before being sent to a 
terminal server that has another terminal connecting. The terminal may wait longer than this value to 
connect if the CPU of the terminal server exceeds the Maximum CPU Utilization defined on the 
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SmartSession Configuration page of the Terminal Server Configuration wizard. See 
SmartSession Configuration Page for details. 

• Max _ Sec is the maximum amount of seconds that a terminal will wait in the queue before being sent 
to the terminal server to login, regardless of the load. 

• Infinite - If the Infinite checkbox is selected, ThinManager will wait until the CPU utilization of the 
terminal server has regained an acceptable range before sending other terminals to it to login. 

The Finish button will close the configuration of that terminal server and return to the beginning of the 
Terminal Server List Wizard for the configuration of other terminal servers. 

If the Terminal Server Group uses the AppLink option, an AppLink page will be displayed by selecting the 
Next button. 

Terminal Server Group Linked Application Page 

 

AppLink Path 

The AppLink page allows a single application to be defined for the AppLink session. Enter the path to the 
desired application in the Enter the path to the Linked Application field as shown in the example.  

Note: The path used must be valid for each and every terminal server in the AppLink group. 

 

Note: Quotation marks may be needed when there is a space in the path. 
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Selecting the Finish button will close the Terminal Server Group List wizard and display the created terminal 
server groups. 

Available Groups Window 

 

Available Groups 

Additional groups can be configured by selecting the New Group button.  

The Terminal Server Group List wizard can be closed by selecting OK. 
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ThinManager Server List 

Selecting Manage > ThinManager Server List will launch the ThinManager Server List Wizard to allow the 
definition of ThinManager Servers. 

 

ThinManager Server List Wizard - Introduction 

The ThinManager Server List Wizard begins with an introduction screen.  

Select Next to proceed or click Finish to close. 
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ThinManager Server List Page 

 

ThinManager Server List Wizard 

The ThinManager Server List is the collection of ThinManager Servers on the network. These include 
ThinManager Servers that the terminal will communicate with to keep the connection status lights in the 
ThinManager tree updated. It also allows access to remote ThinManager Servers that allow network wide 
monitoring, control, and management.  

• Automatic ThinManager Server Synchronization, if checked, will connect all of the configuration 
databases on the ThinManager Servers in this list and keep them synchronized so that a change 
on one is a change on all. 

• Remove Server will clear a highlighted ThinManager Server from the list.  

• Add Server will launch a window that allows the entry of a ThinManager Server name and IP 
address.  

• Edit Server will launch a window that allows the change of a highlighted ThinManager Server name 
and IP address. 

Selecting Add Server will launch a ThinManager Server Definition window that allows the entry of the 
ThinManager Server name and IP address.  
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Enter The New ThinManager Server Definition Window 

 

ThinManager Server Definition 

Entering the network name of the ThinManager Server and its IP address allows the ThinManager Servers 
to be tied to a convenient name without the need of a DNS server.  

Enter the computer name as found in the Microsoft System Properties in the ThinManager Server field. Add 
the IP address of the ThinManager Server in the ThinManager Server Address field, and select OK. This 
adds the ThinManager Server to the ThinManager Server list. 

• OK will add the ThinManager and the IP address. 

• Cancel will close the window without saving any entry. 

• Discover will find and fill in the IP address for a ThinManager Server entered in the ThinManager 
Server field. 
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ThinManager Server List 

Selecting the Automatic ThinManager Server Synchronization checkbox once two ThinManager Servers 
are added will enable automatic Synchronization. When this is checked, the Add Server button will become 
inactive and no more ThinManager Servers can be added. See Automatic Synchronization for details. 

When all of the desired ThinManager Servers are added to the list, select Finish to close the ThinManager 
Server List wizard. 
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DNS Configuration 
Selecting Manage > DNS Configuration will launch the Domain Name Server Wizard to allow the definition 
of Domain Name Servers.  

 

Domain Name Service Wizard - Introduction 

The Domain Name Service Wizard Introduction screen will allow the use of DNS if a DNS server is being 
used. 

• If the System without a DNS server radio button is selected, no configuration is needed. Select the 
Finish button to close the wizard. 

• If the System using a DNS server radio button is selected, the Next button will launch the Domain 
Name Service Configuration screen. 
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Domain Name Server Configuration Page 

 

Domain Name Server Configuration 

The Domain Name Service Configuration page allows DNS settings to be configured. 
• The Add DNS Server button will launch a dialog box that allows a DNS Server to be added to the 

list. 

• The Remove DNS Server button will remove a highlighted DNS server from the list. 

• The Up and Down arrow keys will change the order of DNS servers used. Highlight a DNS server in 
the list and select the appropriate arrow. 

• Domain  is a field for the DNS domain name. 

• Search Domain  will add the contents of the field as a prefix to any DNS searches.  

• Selecting the Read DNS Setting from this computer button will transfer the DNS settings from the 
current computer into ThinManager.  

Selecting the Add DNS Server button will launch a dialog box that allows the IP address of the DNS server to 
be entered. 
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DNS Server Entry Window 

 

Domain Name Server Configuration - Add DNS Server 

Add the IP address of the DNS server into the DNS Server dialog and select OK. Additional IP addresses can 
be listed by selecting the Add DNS Server button again. 

Select the Finish button when the DNS configuration is done. 
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Terminal Group Configuration Wizard 

Using Terminal Groups allows a configuration to be defined for a group of terminals. Terminals added to a 
group will inherit the group properties to speed the configuration process. Using Groups can also aid in 
management because many tasks can be done on the group level instead of repeating them for multiple 
terminals. 

ThinManager 3.1 expands the Group functionality: 

• Groups can be nested within groups, providing deeper levels of organization. 

• All Group Settings now use a forced inheritance because of the new nested Groups in ThinManager 
3.1. Once a setting has been selected as a group property, every terminal group and terminal 
beneath it will use that setting. 

• Group Settings will be designated on the Configuration and Modules tabs with the Group icon of two 
blue monitors.  

Group Settings Checkbox 

The Terminal Group Configuration Wizard establishes the terminal settings for a group of terminals, while the 
Terminal Configuration Wizard establishes the terminal settings for the individual terminal. The Terminal 
Configuration Wizard and the Group Configuration Wizard use the same forms so they are very similar, with a 
few different settings.  

The Group wizard will have Group Setting checkboxes for each setting. Selecting this checkbox will force 
that setting to be inherited by nested sub-groups and member terminals. This is a significant difference from 
previous versions of ThinManager that allowed any Group Setting to be un-selected and individually 
configured for a terminal. 

The Group Settings of any sub-group or terminal will be grayed out to prevent changes if the group setting is 
selected on the parent. Changes need to be made at the Group level. 
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Group Setting Example 

This example shows variations in the use of four Group Settings on the Terminal Group Options page of a 
nested group. 

Terminal Replacement (1) and Terminal Schedule (2) were configured in the parent group and cannot be 
changed in this child group. Terminal Replacement (1) was set as checked, while Terminal Schedule (2) 
was set as unchecked. 

The Terminal Effects (3) Group Setting is selected for this Group. It will be grayed out in child groups and 
member terminals. 

The Shadowing (4) Group Setting is unselected, making it available to be set for child groups and member 
terminals.  

Group Name Page 

The Group Configuration Wizard can be launched by selecting Edit > Add Terminal Group or by or right 
clicking on the Terminals branch in the tree and selecting Add Group. 
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Group Configuration Wizard - Group Name 

When a Group is first added, giving it a name is the first priority. Use numbers, letters, hyphens (-) and 
underscores (_), but don’t use spaces or other characters. 

 

Duplicate Name Warning 

If an existing name is selected, a Duplicate Name Warning popup will be displayed when the Next button is 
selected. 

Terminal Groups can be added to Terminal Groups, creating a multi-level hierarchy. 

Select the Change Group button to launch the Select Group window. 
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Select Terminal Group Window 

The Select Group window will show a tree displaying the group hierarchy. Highlight the Terminal Group that 
you want to join and select the OK button to join or select the Cancel button to quit without joining.  
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Terminal Group Configuration Wizard - Group Name Page 

The parent Terminal Group you joined will be displayed in the Group field.  

The Permission button allows the Terminal Group to be assigned Access Groups for security. This is a 
function of TermSecure. See Permissions for details. 

Select the Next button to continue or select the Cancel button to close the configuration wizard without 
saving. 
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Terminal Group Options 

 
Terminal Group Configuration Wizard - Terminal Group Options 

Selecting the Allow replacement at terminal if offline checkbox will allow all members of the group to show 
up in the replacement list during a new terminal connection. See Replace or Create New Terminal Mode for 
details. 

Set Schedule allows members of the group to be disabled, rebooted, or enabled on a schedule. 

Select the Set Schedule checkbox and click the Schedule button to launch the Schedule window to 
configure the schedule for members of the group. See Terminal Schedule for details. 

Enable Terminal Effects, when selected, will allow the desktops in MultiSession to slide smoothly into the 
desktop instead of appearing instantaneously. 

Show terminal status messages, when selected, will allow status messages like TermSecure User logins 
and current Terminal Server Group to be displayed. If unselected, these status messages won’t be displayed 
but critical messages like connection failures will still be displayed. 

The Allow terminal to be shadowed drop-down box allows the configuration of Shadowing Options. 

• No – Will prevent members of the Group from being shadowed. 

• Ask - Will display a message window that will prompt for a positive response before the shadowing is 
allowed. 
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• Warn - Will display a message window alerting the terminal that it is to be shadowed, but doesn’t 
require a positive response before the shadowing is allowed. 

• Yes – Will allow shadowing to occur without warning or recipient input. 

Allow Interactive Shadow will allow members with Interactive Shadow privileges to shadow members of the 
Group. Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. 
Unselecting this will prevent shadowing from within ThinManager. See Details Pane. 

The Group Setting checkboxes will lock the settings for the group and all member terminals. 
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Group Terminal Server Specification Page 

 

Terminal Server Specification - Select Individual Terminal Servers 
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Terminal Server Specification - Use Terminal Server Groups 

The Method of Terminal Server Selection radio button provides options for terminal server connections. 
• Use Terminal Server Groups will allow terminals to connect to terminal servers in Terminal Server 

Groups for increased functionality like load balancing.  See Terminal Server Groups for details. 

• Select Individual Terminal Servers will allow terminals to connect to a list of terminal servers as it 
has been traditionally done in earlier versions of ThinManager.  When this is chosen, the other 
options are hidden. 

If the Use Terminal Server Groups is selected, two other settings become available: 
• The Enable MultiSession checkbox allows the terminals in the group to use the MultiSession 

functionality as described in MultiSession. This is only available to Groups that use Terminal 
Server Groups. See MultiSession for details.  

• Enable TermSecure, when checked, will enable TermSecure functionality. This is covered in the 
TermSecure section. See TermSecure for details. 

Note: Enable MultiMonitor is not available for Group Settings. 

The Group Setting checkboxes will lock the settings for the group and all member terminals. 
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Groups Using Individual Terminal Servers 
Groups that have the Select Individual Terminal Servers radio button selected will connect to terminal 
servers as assigned on the Terminal Server Specification page. 

The Group Connection Type page is displayed next to allow the selection of the desired Client 
Communication Protocol. 

Group Connection Type Page 

 

Terminal Group Configuration Wizard - Connection Type 

Thin clients use a client communication protocol to connect to the Terminal Servers. Select the correct 
protocol and select the Next button. 

• Select the Citrix MetaFrame radio button if that program or a similar program is to be used to 
provide the ICA protocol. Citrix MetaFrame is an optional program sold by Citrix. 

• Select the Citrix Device Services radio button if Citrix Device Services is to be used to provide 
the ICA protocol. Citrix Device Services is a legacy deployment of ICA for Windows 2000 
Terminal Servers but is no longer supported by Citrix. ThinManager Ready thin clients can still 
connect to terminal servers with Device Services, but no new Device Services terminal servers 
can be licensed. 
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• Microsoft Remote Desktop Protocol (RDP) is installed by default on all Windows Terminal 
Servers. The Microsoft Remote Desktop Protocol (RDP) radio button is selected by default 
unless you choose another protocol. 

The Group Setting checkbox will lock the settings for the group and all member terminals. 

Selecting Citrix ICA with MetaFrame offers additional configuration options before displaying the Terminal 
Server Selection. Selecting Citrix ICA with Device Services and Remote Desktop Protocol (RDP) will 
jump to the Terminal Server Selection. 

A Group using Citrix MetaFrame, as its Client Communication Protocol, will be shown additional configuration 
screens beginning with the Citrix MetaFrame Configuration page. 

Group Citrix MetaFrame Configuration Page 

 

Terminal Group Configuration Wizard - Citrix MetaFrame Configuration 

Citrix MetaFrame allows increased encryption in the ICA protocol. Select a level from the Encryption drop-
down box. 

Citrix MetaFrame has a feature called Published Applications. If you are using Published Applications, 
select the Yes radio button, then select the Next button to continue to the Citrix Published Application 
dialog. 

The Group Setting checkboxes will lock the settings for the group and all member terminals. 
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If you are not using Published Applications, select the No radio button, then select the Next button to continue 
to the Terminal Server Selection dialog. 

Group Citrix Published Applications Page 

 

Terminal Group Configuration Wizard - Citrix Published Applications 

Enter the name of the desired Published Applications in the Published Applications field. Do not use spaces 
in the name when creating a Published Application for Terminal Services. 

Citrix MetaFrame uses ICA Browsers as part of the system. Because the ICA client may have problems 
detecting an ICA browser across a router or switch, an ICA Browser field is provided for entering the name of 
an ICA browser. 

The Group Setting checkboxes will lock the settings for the group and all member terminals. 

Select the Finish button to create the Group, or select the Next button to rejoin the main configuration path to 
configure more options. 

Groups using the Select Individual Terminal Servers will be shown the Group Terminal Server Selection 
page where the desired terminal servers can be selected. 
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Group Terminal Server Selection Page 

 

Terminal Group Configuration Wizard - Group Terminal Server Selection 

If Published Applications or Terminal Server Groups are not being used, the terminal will need to be assigned 
to a Terminal Server. The Terminal Server is a server that allows a terminal to logon and run applications in 
an independent session. 

If the Available Terminal Server column is empty, the Terminal Server List Wizard needs to be run to add 
terminal servers to ThinManager. Select the Edit Server List button to launch the Terminal Server List 
Wizard as shown in the Terminal Server List Wizard. 
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Terminal Group Configuration Wizard - Terminal Server Selection 

Once the Terminal Server List wizard has run, each Terminal Server that is identified in the Terminal Server 
List Wizard will initially appear in the Available Terminal Servers box on the left of the Group Terminal 
Server Selection.  

To choose a terminal server for the Group, highlight it in the list on the left and click the Right arrow button or 
double click on it. This will put the Terminal Server into the Selected Terminal Server list on the right. The 
Group will use all the Selected Terminal Servers as Terminal Servers, in the order listed. 

The Terminal Server on the top of the Selected Terminal Server List will be the Primary Terminal Server, the 
first Terminal Server that the terminal will attempt to login to. If the Primary Terminal Server fails, or is 
unavailable, the terminal will connect to the other terminal servers in the order that they are listed.  

To change the order of the Terminal Servers in the Terminal Server Selection list, highlight a Terminal Server 
and use the Up arrow button and the Down arrow button to move it up or down in the list. 

The Enforce Primary Terminal Server Connection will cause a terminal to return to the primary terminal 
server whenever that server is available.  

The Group Setting checkbox will lock the settings for the group and all member terminals. 

Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 
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Groups Using Terminal Server Groups 
Members of a Group may connect to Terminal Server Groups by selecting the Use Terminal Server Groups 
on the Terminal Server Specification page instead of using the Select Individual Terminal Servers setting. 

 

Terminal Group Configuration Wizard - Terminal Server Specification 

If Use Terminal Server Groups is selected, an Enable MultiSession and an Enable TermSecure 
checkbox will be displayed.  

Check the Enable MultiSession checkbox to connect to two or more terminal server groups at once. See 
MultiSession for details. 

Enable TermSecure, when checked, will enable TermSecure functionality. This is covered in the 
TermSecure section. See TermSecure for details. 

Note: Enable MultiMonitor is not available for Group Settings. 

The Group Setting checkboxes will lock the settings for the group and all member terminals. 

Select Next to continue configuration. 

The Group Terminal Server Selection page is displayed next to allow the selection of the desired Terminal 
Server Groups. 
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Group Terminal Server Group Selection Page 

 

Terminal Group Configuration Wizard - Group Terminal Server Selection 

The Group will need to connect to Terminal Server Groups that contain terminal servers that will host the 
sessions.  

If the Available Terminal Server Groups column is empty, the Terminal Server Groups List wizard needs 
to be run to configure Terminal Server Groups. Select the Edit Server Groups button to launch the Terminal 
Server Group Wizard as shown in Terminal Server Group List. 
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Terminal Group Configuration Wizard - Terminal Server Selection 

Once the Terminal Server Group wizard has run, each Terminal Server Group that is identified in the 
Terminal Server Group Wizard will initially appear in the Available Terminal Server Groups box on the left 
of the Group Terminal Server Selection page.  

Note: The Available Terminal Server Groups will only list Terminal Server Groups that are appropriate. Only 
RDP Terminal Server Groups will be shown if the Group is using RDP. If the Enable MultiSession 
checkbox was selected on the Terminal Server Specification page, only Terminal Server Groups with 
MultiSession capabilities are shown in the Available Terminal Server Groups list. . 

To select a Terminal Server Group for a Group, highlight it in the list on the left and click the right arrow button 
or double click on it. This will put the Terminal Server Group into the Selected Terminal Server Group list on 
the right. The Group will use the Selected Terminal Server Groups for the terminal servers that it can login 
to.  

Selecting the Enable MultiSession checkbox on the Terminal Server Specification page will allow more 
than one Terminal Server Group to be selected for use. If it is not selected, an error message will be 
displayed when a second Terminal Server Group is added. 



 

196  ••••  Configuration Wizards ACP ThinManager 3.1 Help Manual 

 
MultiSession Not Enabled Error 

The Group Setting checkbox will lock the settings for the group and all member terminals. 

Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 

Group Client Interface Options Page 

 

Terminal Group Configuration Wizard - Client Interface Options 

Terminals in a Group using MultiSession will need to have a method to switch between sessions. This is 
configured on the Group Client Interface Options page. 

Group Selector Options allow on-screen switching of sessions. 

• Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down 
menu that can be activated by mouse.  
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• Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 

The Selector Options button will launch the Group Selector Options window that allows configuration of 
the on-screen Group Selector bar. 

 

Group Selector Options Window 

The Auto-hide Group Selector checkbox will hide the Group Selector until the mouse is moved to that 
space. 

The Group Selector Menu Size drop-down box allows the setting of the size of the Group Selector font.  

Select the OK button to accept changes or the Cancel button to close. 

Terminal Hotkeys on the Client Interface Options page allows the selection of keyboard combinations that 
allow switching between sessions. 

• Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between 
the two active sessions of a Terminal Server Group that is using Instant Failover. 

• Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between different 
sessions of a terminal using MultiSession. 

Selecting the Change Hotkeys button when the Enable Instant Failover Hotkeys is checked will allow the 
hotkeys for switching between Instant Failover sessions to be changed from the default. 

 

Terminal Server Group Instant Failover Hotkey Configuration  

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed using the Alt key 
radio button and the dropdown. 

See Instant Failover for details. 
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Selecting the Change Hotkeys button when the Enable Group Hotkeys is checked will allow the hotkeys to 
be changed from the default. 

 
MultiSession Switch Hotkey Configuration 

The default hotkey for MultiSession Group switching is set to Control+Page Up and Control+Page Down.  

The hot keys can be changed by using the Alt radio button and dropdown boxes. 

See MultiSession for details. 

Select the OK button to continue or the Cancel button to close without accepting changes. 

Continuation of the Group Configuration 
The configuration paths (Independent Terminal Servers vs. Terminal Server Groups, MetaFrame vs. Device 
Services and RDP) unite at the Group Login Configuration page. 
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Group Login Information Page 

 

Login Information - Select Individual Terminal Servers 

It is recommended that each terminal login to a Terminal Server with a unique profile. For this reason, the 
Group Username, Password, and Domain are inactive in the Terminal Group Configuration. These need to 
be set individually during the Terminal Configuration. 

The Initial Program is a setting available to Groups using Individual Terminal Servers. The Initial Program 
loads the designated program instead of the Windows desktop when the terminal connects to the Terminal 
Server. If a program is launched as the initial program, it is the only program that will run. This provides a 
level of security and control because that program is the only program that will run in that session. If the Initial 
Program is closed on the terminal, the session on the Terminal Server will close and the ThinManager Ready 
Thin Client will reconnect to the Terminal Server and re-launch the Initial Program. This effectively makes the 
Initial Program the only program. See Login Information Page for details. 

To use the Initial Program, enter the path to the program in the Initial Program field. The Browse button will 
open a file browser to allow program selection. 

Note: When using the Initial Program with failover, the path must be identical on all terminal servers. If the 
path is different, use a batch file to launch the application. 

The Group Setting checkbox will lock the settings for the group and all member terminals. 
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Login Information - Use Terminal Server Groups  

Terminal Groups using Terminal Server Groups do not display the Initial Program field. AppLink instead 
provides the Initial Program function. See AppLink for details. 

Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 
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Group Video Resolution Page 

 

Group Configuration Wizard - Video Configuration 

The Group Video Resolution page has a drop-down box that allows the video resolution to be set for all 
members of the Group.  

The standard terminal connection uses a 256-color depth. The 64K-color depth is available by using RDP 
connected to a Windows 2003 Terminal Server, or by using the ICA client with Citrix MetaFrame 1.8 FR1 or 
greater. 

The Group Setting checkbox will lock the settings for the group and all member terminals. 

Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 
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Group WinTMC Settings 

 

Group WinTMC Settings Page 

WinTMC clients can be configured on the Group WinTMC Settings page. These only apply to connections 
made by the WinTMC fat client. See WinTMC Fat Client for details about the WinTMC client. 

 The settings include: 

Redirect Local Resources: 
• Redirect Serial Ports – Enable this setting to make the local PC serial ports available in the WinTMC 

session. Serial Port redirection does not work when you connect to a terminal server running 
Windows 2000 or earlier. 

• Redirect Drives – Enable this setting to make the local drives of the PC available in the session. 
Drive redirection does not work when you connect to a terminal server running Windows 2000 or 
earlier. 

• Redirect Printers – Enable this setting to make a local printer available in the session.  

• Redirect Sound –Enable this setting to allow audio played in your session to play locally. Sound 
redirection does not work when you connect to a terminal server running Windows 2000 or 
earlier. 
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•  Redirect Smart Cards – Enable this setting to make your PC smart card available in a session. 
Smart card redirection does not work when you connect to a terminal server running Windows 
2000 or earlier. 

Client Control Settings: 
• Allow Client to be closed – Enable this setting if you want your user to be able to close the client. 

• Allow client to be sized – Enable this setting if you want your user to be able to resize the client. 

Experience Settings: 
• Show Desktop Background – Enable this setting if you want your user to be able to select a 

Windows Desktop Background instead of a default solid color background.  

• Show window contents while dragging – Enable this setting if you want the window contents of a 
window to be shown while the window is being dragged within the session.  

• Show menu/window animations – Enable this setting if you want menu/window animations to be 
enabled in the session.  

• Show Themes – Enable this setting if you want your user to be able to select a Windows Theme for 
the session.  

Note: These functions may be denied by user policies or terminal server configuration. Check the Microsoft 
Local Policy, Group Policy, and Terminal Services Configuration. See Non-ThinManager Components 
for details. 

The Group Setting checkbox will lock the settings for the group and all member terminals. 

 Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 
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Group Module Selection Page 

 

Group Configuration Wizard - Module Selection 

A Module is a component of the firmware that is not needed for the basic functionality but may be desired for 
advanced functionality. These features include Touch Screen drivers, serial mouse drivers, High Speed Serial 
drivers, Shared Keyboard and Mouse, USB Memory Card Reader, and Instant Failover. See Module 
Overview for details. 

To add a Module to a Terminal Group, select the Add… button to launch the Attach Module to Terminal 
window. 
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Attach Module to Terminal 

The Attach Module to Terminal window will show the modules that are available. The Module Type drop-
down box sorts the modules by categories to make the modules easier to find. 

Highlight the desired module and select the OK button to add the module to the configuration. 
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Terminal Configuration Wizard - Module Selection 

Terminals that are members of a Group may show icons to represent the properties of added modules. 

•  The Group icon represents modules assigned to a parent Group. 

•  The Group icon with yellow plus sign represents properties that are changed on the 
terminal from the Group settings. This is limited to touch screen calibration.  

• No icon indicates that the module was added to that particular Group or Terminal and not a 
parent Group. 
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Module Configuration 

Highlighting a module and selecting the Configure button will open the Module Properties window and allow 
changes to the module configuration. 
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Module Properties 

On the Modules Properties window, select the parameter to change, select the new value in the drop-down 
list, and click the Set button. This will change the setting.  

The Set to Default button will restore the module to the default settings. 

Select the Done button to close the Module Properties window and to return to the Terminal Group 
Configuration Wizard. 

Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 
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Group ThinManager Server Monitor List Page 

 

Group Configuration Wizard - Monitoring Configuration 

The ThinManager Server Monitor List defines what Thin Manager Servers the terminal will communicate 
with to keep monitoring light status current. All ThinManager Servers defined in the ThinManager Server List 
Wizard will appear in the Available ThinManager Server column. 

If the Available ����������	
Server column is empty, the ����������	
Server List Wizard needs to 
be run to define the ����������	
Servers. Select the Edit Server List button to launch the ThinManager 
Server List Wizard as shown in ThinManager Server List Wizard. 
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Group Configuration Wizard - Monitoring Configuration 

Once the ThinManager Server List wizard has run, each ThinManager Server that is identified in the 
ThinManager Server List Wizard will initially appear in the Available ThinManager Server box on the left of 
the Group Monitoring Configuration page.  

To select a ThinManager Server for the Group, highlight it in the Available ThinManager Server list on the 
left and click the right arrow button. This will put the ThinManager Server into the Selected ThinManager 
Server list on the right. The terminals of the Group will send connection status (red/green icon lights) to all 
ThinManager Servers in the Selected ThinManager Server list. 

The Group Setting checkbox will lock the settings for the group and all member terminals. 

 Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 
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Group Monitoring Configuration 

 

Terminal Group Configuration Wizard - Monitoring Configuration 

ThinManager Ready Thin Clients continuously monitor the Terminal Server to make sure that it stays online. If 
the Terminal Server goes offline, the terminal will disconnect and connect to the next Terminal Server in the 
Group Terminal Server Selection. The Monitoring Connection sets the frequency that the monitor occurs. 

Use the Monitor Interval radio buttons to use a default frequency or select Custom and choose a setting of 
your own. 

• Monitor Interval is the interval that the monitor checks occur. 

• Monitor Timeout is the time the terminal will wait for a response from the terminal server. 

• Monitor Retry is the number of times the monitor check will be tried. 

• Primary Up Delay Multiplier is the number that generates the Primary Up Delay time. 

• Primary Up Delay is a delay added (usually set to 30 or 60 seconds) to allow a Terminal Server to 
become fully booted before the terminal will try to login. This time period is equal to the 
Monitoring Interval times the Primary Up Delay Multiplier. 

The Fast setting of the Monitor Connection will detect Terminal Server failure quickly. However, the faster the 
setting is, the more sensitive it is and it may drop the Terminal Server when the network is busy and not 
offline. Setting the Monitoring Connection to a slower setting gives the Terminal Server more time to respond 
when it is busy. 
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The Group Setting checkbox will lock the settings for the group and all member terminals. 

 Select the Finish button to complete the Group configuration. 
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Terminal Configuration Wizard 

The Terminal Group Configuration Wizard establishes the terminal settings for a group of terminals, while the 
Terminal Configuration Wizard establishes the terminal settings for the individual terminal. The Terminal 
Configuration Wizard and the Group Configuration Wizard are very similar, with few different settings.  

The Group Wizard will have Group Setting checkboxes for each setting. Selecting this checkbox will force that 
setting to be inherited by nested sub-groups and member terminals. This is a significant difference from 
previous versions of ThinManager that allowed any Group Setting to be un-selected and individually 
configured for a terminal. 

The Group Settings of any sub-group or terminal will be grayed out to prevent changes if the group setting is 
selected on the parent. Changes need to be made at the Group level. 

The Terminal Creation Wizard can be launched by either:  
• Selecting the ThinManager Server in the ThinManager tree and selecting Edit > Add Terminal from 

the menu bar, or  

• Selecting the Terminals branch in the ThinManager tree, right-clicking on the Terminals icon, and 
selecting the Add Terminal option, or  

• Selecting a Group in the ThinManager tree, right-clicking on the Group icon, and selecting the Add 
Terminal option. This puts the terminal in that group. 
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Terminal Name Page 

 

Terminal Configuration Wizard - Terminal Name 

When a Terminal is first created, giving it a name is the first priority. Use numbers, letters, hyphens (-), and 
underscores (_), but don’t use spaces or other characters. 

Note: The terminal name should be less than 15 characters because of limitations of the terminal server. 

The terminal can be added to a Terminal Group by selecting the Group name in the Group drop-down box. 
Terminals added to a Group will be assigned the Group properties 

The Change Group button will launch a Select Group window. 
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Select Group Window 

The Select Group window will show a tree displaying the group hierarchy. Highlight the Terminal Group that 
you want to join and select the OK button to join or select the Cancel button to quit without joining.  
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Terminal Name Page - Group Membership 

The Terminal Group you joined will now be displayed in the Group field.  

The Copy Settings from another Terminal checkbox will copy an established configuration to the new 
terminal. Selecting the Copy Settings from another Terminal checkbox and clicking the Copy From button 
will launch the Select Terminal window that allows the terminal to copy settings from another terminal. 
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Select Terminal Window 

The Select Terminal window will show a tree of the configured Terminal Groups and terminals. Highlight the 
terminal that you wish to copy and select the OK button to load the settings and return to the Terminal 
Configuration Wizard. 

The Cancel button will close the Select Terminal window without making changes. 

The Permissions button will launch the Permissions window that allows Permissions to be set for 
TermSecure. See Permissions for details. 

Select the Next button to continue or select the Cancel button to close the configuration wizard without 
saving. 
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Terminal Hardware Page 

 

Terminal Configuration Wizard - Hardware Configuration 

Select the make and model of the ThinManager Ready Thin Client from the drop-down boxes.  These 
parameters are from the Terminal Capability database (TermCap data base). If the unit has an integrated flat 
panel, it will display the touch screen controller type.  

If the make and model of your ThinManager Ready thin client does not appear in the list, download a new 
TermCap Database from www.thinmanager.com. See Install New TermCap Database for details. 

If you do not know what model it will be, leave the default setting. When a terminal is connected and receives 
this configuration, ThinManager will update the hardware settings to match the actual hardware. 
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Terminal Configuration Wizard - Hardware Configuration – Added Hardware 

When the hardware is added and tied to a configuration, the Make/OEM and Model fields will list the actual 
hardware type and cannot be changed unless the unit is turned off and the Terminal ID is cleared with the 
Clear button. 

The Clear button will remove the Terminal ID identifier from the configuration of an inactive terminal. This will 
free hardware that has already been tied to a configuration and allow the terminal to be tied to a different 
configuration, without deleting its original configuration. It will also allow the make and model of the hardware 
to be changed. 
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Terminal Configuration Wizard - WinTMC Setup 

A WinTMC connection needs to be configured as Generic/Personal Computer. See WinTMC Overview for 
details. 

Select Next to continue. 
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Terminal Options  

 

Terminal Options Page 

Selecting the Allow replacement at terminal if offline checkbox will allow all members of the group to show 
up in the replacement list during a new terminal connection. See Replace or Create New Terminal Mode for 
details. 

Set Schedule allows members of the group to be disabled, rebooted, or enabled on a schedule. 

Select the Set Schedule checkbox and click the Schedule button to launch the Schedule window to 
configure the schedule for members of the group. 

See Terminal Schedule for details. 

Enable Terminal Effects, when selected, will allow the desktops in MultiSession to slide smoothly into the 
desktop instead of appearing instantaneously. 

Show terminal status messages, when selected, will allow the terminal to display status messages in the 
upper left corner of the screen. When unselected, incidental messages like Terminal Server Group switching 
and TermSecure logins will be suppressed and only critical messages like connection errors will be displayed. 

The Allow terminal to be shadowed drop-down box allows the configuration of Shadowing Options. 

• No – Will prevent members of the Group from being shadowed. 

• Ask - Will display a message window that will prompt for a positive response before the shadowing is 
allowed. 
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• Warn - Will display a message window alerting the terminal that it is to be shadowed, but doesn’t 
require a positive response before the shadowing is allowed. 

• Yes – Will allow shadowing to occur without warning or recipient input. 

Allow Interactive Shadow will allow members with Interactive Shadow privileges to shadow the terminal. 
Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. Unselecting 
this will prevent shadowing from within ThinManager. See Shadowing and ThinManager Security Groups for 
details. 

Terminal Schedule 

Selecting the Schedule button on the Terminal Options page will launch the Event Schedule window and 
allow a schedule to be created for terminal events. 

 

Event Schedule 

The Event Schedule will list events for the terminal or group. It has four buttons: 

• The Add button will launch a Schedule window to allow an event to be configured. 

• The Edit button will allow a highlighted event to be changed. 

• The Delete button will remove a highlighted event. 

• The OK button will accept changes and close the Event Schedule window. 

Events can be added by selecting the Add button to launch the Schedule window. 
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Schedule Window 

The Schedule window has several configuration settings. 

Event Type is a drop-down box that allows event selection: 

• Disable Terminal - This will prevent a terminal from being used, although its terminal server sessions 
will still be running on the terminal servers.  

• Enable Terminal - This will allow a disabled terminal to become active again. 

• Reboot Terminal - This will cycle power on the terminal and reload its configuration. 

• Reset Terminal Sessions - This will logoff the sessions that the terminal has open on terminal 
servers. 

The Repeat Interval radio buttons allow the event in the Event Type drop-down to be run Once Only, 
Weekly/Daily, Monthly, or Yearly.  

• Selecting Once Only will show a Select Date field for the event.  

• Selecting Weekly/Daily will show a Weekly Schedule list for the event to run. The Every Day button 
will select all the days in the list. 

• Selecting Monthly will show a Select Day of Month field for the event.  

• Selecting Yearly will show a Select Date field for the event.  

The Time field allows the selection of the time that the event should occur.  

Select the OK button to close the Schedule window. Select Add to add another event to the Event Schedule 
or select OK to close the Event Schedule window and return to the terminal configuration. 
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Terminal Server Specification Page 

 

Terminal Server Specification 

The Method of Terminal Server Selection radio button provides options for terminal server connections: 
• Use Terminal Server Groups will allow terminals to connect to terminal servers in Terminal Server 

Groups for increased functionality like load balancing. 

• Select Individual Terminal Servers will allow terminals to connect to a list of terminal servers as it 
has been done in earlier versions of ThinManager. 

If the Use Terminal Server Groups is selected, three other settings may become available: 
• The Enable MultiSession checkbox allows the terminals in the group to use the MultiSession 

functionality as described in MultiSession. This is only available to terminals that use Terminal 
Server Groups.  

• Enable TermSecure, when checked, will enable TermSecure functionality. This checkbox will only be 
displayed if the ThinManager Server has a TermSecure license installed. See TermSecure for 
details on this function. 

• The Enable MultiMonitor checkbox will be displayed if the hardware selected on the Terminal 
Hardware page is a MultiMonitor-capable ThinManager Ready thin client. Selecting this will allow 
the terminal to be configured for MultiMonitor. See MultiMonitor for details. 
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Terminals Using Individual Terminal Servers 
Terminals may connect to a series of individual terminal servers by selecting the Select Individual Terminal 
Servers on the Terminal Server Specification page. 

 

Terminal Configuration Wizard - Terminal Server Specification 

The Terminal Connection Type page is displayed next to allow the selection of the desired Client 
Communication Protocol. 
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Terminal Configuration Wizard - Connection Type 

Thin clients use a client communication protocol to connect to the Terminal Servers. Select the correct 
protocol and select the Next button. 

• Select the Citrix MetaFrame radio button if that program is to be used to provide the ICA 
protocol. Citrix MetaFrame is an optional program sold by Citrix. 

• Select the Citrix Device Services radio button if Citrix Device Services is to be used to provide 
the ICA protocol. Citrix Device Services is a legacy deployment of the ICA client but is no longer 
supported by Citrix. ThinManager Ready thin clients can still connect to terminal servers with 
Device Services, but no new Device Services terminal servers can be licensed. 

• Microsoft Remote Desktop Protocol (RDP) is installed by default on all Windows Terminal 
Servers. The Microsoft Remote Desktop Protocol (RDP) radio button is selected by default 
unless you choose another protocol. 

Selecting Citrix ICA with MetaFrame offers additional configuration options before displaying the Terminal 
Server Selection. Selecting Citrix ICA with Device Services and Remote Desktop Protocol (RDP) will 
jump to the Terminal Server Selection. 

A Terminal using Citrix MetaFrame as its Client Communication Protocol will be shown additional 
configuration screens beginning with the Citrix MetaFrame Configuration page. 
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Citrix MetaFrame Configuration Page 

 

Terminal Configuration Wizard - Citrix MetaFrame Configuration 

Citrix MetaFrame allows increased encryption in the ICA protocol. Select a level from the Encryption drop-
down box. 

Citrix MetaFrame has a feature called Published Applications. If you are using Published Applications, select 
the Yes radio button, then select the Next button to continue to the Citrix Published Application dialog. 

If you are not using Published Applications, select the No radio button, then select the Next button to continue 
to the Terminal Server Selection dialog. 
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Citrix Published Applications Page 

 

Terminal Configuration Wizard - Citrix Published Applications 

Enter the name of the desired Published Applications in the Published Applications Name field. Do not use 
spaces in the name when creating a Published Application for Terminal Services. 

Citrix MetaFrame uses ICA Browsers as part of the system. Because the ICA client may have problems 
detecting an ICA browser across a router or switch, an ICA Browser field is provided for entering the name of 
an ICA browser. 

Select the Finish button to create the Terminal, or select the Next button to rejoin the main configuration path 
to configure more options. 

Terminals using the Select Individual Terminal Servers will be shown the Terminal Server Selection page 
where the desired terminal servers can be selected. 
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Terminal Server Selection Page 

 

Terminal Configuration Wizard -Terminal Server Selection 

If Published Applications or Terminal Server Groups are not being used, the terminal will need to be assigned 
to a Terminal Server. The Terminal Server is a server that allows a terminal to logon and run applications in 
an independent session. 

If the Available Terminal Server column is empty, the Terminal Server List wizard needs to be run to add 
terminal servers to the ThinManager system. Select the Edit Server List button to launch the Terminal Server 
List Wizard as shown in Terminal Server List Wizard. 
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Terminal Configuration Wizard - Terminal Server Selection 

Once the Terminal Server List wizard has run, each Terminal Server that is identified in the Terminal Server 
List Wizard will initially appear in the Available Terminal Server box on the left side of the Terminal Server 
Selection page.  

To select a Terminal Server for the terminal, highlight it in the list on the left and click the Right arrow button. 
This will put the Terminal Server into the Selected Terminal Server list on the right. The terminal will use all 
the Selected Terminal Servers as Terminal Servers in the order listed. 

The Terminal Server on the top of the Selected Terminal Server List will be the Primary Terminal Server, the 
first Terminal Server that the terminal will attempt to login to. If the Primary Terminal Server fails, or is 
unavailable, the terminal will connect to the other terminal servers in the order that they are listed.  

To change the order of the Terminal Servers in the Terminal Server Selection list, highlight a Terminal Server 
and use the Up arrow button and the Down arrow button to move it up or down in the list. 

The Enforce Primary Terminal Server Connection will cause a terminal to return to the primary terminal 
server whenever that server is available.  

Select the Next button to continue configuration or select the Finish button to complete the terminal 
configuration. 
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Terminals Using Terminal Server Groups 
Terminals may connect to Terminal Server Groups by selecting the Use Terminal Server Groups on the 
Terminal Server Specification page instead of using the Select Individual Terminal Servers setting. 

 

Terminal Configuration Wizard - Terminal Server Specification 

If the Use Terminal Server Groups is selected, three other settings may become available: 
• The Enable MultiSession checkbox allows the terminals in the group to use the MultiSession 

functionality as described in MultiSession. This is only available to terminals that use Terminal 
Server Groups.  

• Enable TermSecure, when checked, will enable TermSecure functionality. This checkbox will only be 
displayed if the ThinManager Server has a TermSecure license installed. See TermSecure for 
details on this function. 

• The Enable MultiMonitor checkbox will be displayed if the hardware selected on the Terminal 
Hardware page is a MultiMonitor-capable ThinManager Ready thin client. Selecting this will allow 
the terminal to be configured for MultiMonitor. See MultiMonitor for details. 

Select Next to continue configuration. 
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Terminal Server Group Selection 
The Terminal Server Selection page is displayed next to allow the selection of the desired Terminal Server 
Groups. 

 

Terminal Configuration Wizard - Group Terminal Server Selection 

The terminal will need to connect to Terminal Server Groups that contain terminal servers that will host the 
sessions.  

If the Available Terminal Server Groups column is empty, the Terminal Server Groups List wizard needs 
to be run to configure Terminal Server Groups. Select the Edit Server Groups button to launch the Terminal 
Server Group Wizard as shown in Terminal Server Group List. 

 

MultiSession Not Enabled Warning 

If two Terminal Server Groups are selected without the Enable MultiSession checkbox on the Terminal 
Server Specification page selected, a message will be displayed warning that the Enable MultiSession 
checkbox needs to be checked to allow the MultiSession. 
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Terminal Server Groups Selection Page 

 

Terminal Configuration Wizard - Terminal Server Selection 

Once the Terminal Server Group wizard has run, each Terminal Server Group that is identified in the 
Terminal Server Group Wizard will initially appear in the Available Terminal Server Groups box on the left 
of the Terminal Server Selection page.  

Note: The Available Terminal Server Groups will only list Terminal Server Groups that are appropriate. Only 
RDP Terminal Server Groups will be shown if the terminal is using RDP. If the Enable MultiSession 
checkbox was selected on the Terminal Server Specification page, only Terminal Server Groups with 
MultiSession capabilities are shown in the Available Terminal Server Groups list.  

To select a Terminal Server Group for a terminal, highlight it in the list on the left and click the right arrow 
button. This will put the Terminal Server Group into the Selected Terminal Server Group list on the right. The 
Group will use the Selected Terminal Server Groups for the terminal servers that it can login to. 

The Enforce Primary Terminal Server Connection will cause a terminal to return to the primary terminal 
server whenever that server is available. This is not available with Smart-Session.  

Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 
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Terminal Interface Options 

 

Terminal Configuration Wizard - Terminal Interface Options 

A terminal using MultiSession will need to have a method to switch between sessions. This is configured on 
the Terminal Interface Options page. 

Group Selector Options allow on-screen switching of sessions. 

• Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down 
menu that can be activated by mouse.  

• Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 

The Selector Options button will launch the Group Selector Options window that allows configuration of 
the on-screen Group Selector bar. 
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Group Selector Options Window 

The Auto-hide Group Selector checkbox will hide the Group Selector until the mouse is moved to that 
space. 

The Group Selector Menu Size drop-down box allows the setting of the size of the Group Selector font.  

Select the OK button to accept changes or the Cancel button to close. 

Terminal Hotkeys on the Terminal Interface Options page allows the selection of keyboard combinations 
that allow switching between sessions. 

• Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between 
the two active sessions of a Terminal Server Group that is using Instant Failover. 

• Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between different 
sessions of a terminal using MultiSession. 

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow the 
hotkeys to be changed from the default. 

 

Select Instant Failover Hotkeys  

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by selecting the 
Alt Key radio button or using the drop-down to select another function key. 

Selecting the Change Hotkeys button when Enable Group Hotkeys is selected will allow the hotkeys to be 
changed from the default. 
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Select MultiSession Switching Hotkeys 

The default hotkey for MultiSession switching is set to Control+Page Up and Control+Page Down. This can 
be changed by selecting the Alt Key radio button or using the drop-down to select another hot key. 

Select the OK button to continue or the Cancel button to close without accepting changes. 
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Terminal Interface Options – TermSecure Enabled 

Additional Terminal Interface options are enabled when TermSecure is enabled on the terminal enabling 
access to the main menu for logging into TermSecure. These are covered at TermSecure User Configuration 
Wizard. 
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Continuation of the Terminal Configuration 
The configuration paths (Independent Terminal Servers vs. Terminal Server Groups, MetaFrame vs. Device 
Services and RDP) unite at the Login Configuration. 

Login Information Page 

 

Terminal Configuration Wizard - Login Information 

It is recommended that each terminal should login to a Terminal Server with a unique profile.  

If the Username, Password, and Domain fields are filled with a valid Microsoft user account, ThinManager 
will pass this information to the Microsoft Terminal Server when the ThinManager Ready Thin Client 
connects, letting the terminal login automatically. 

Note: RDP will not allow auto-login by default on a Windows 2000 Server. See Configuring RDP for Auto-
Login for details. 

If the Username, Password, and Domain fields are left blank, or are filled with invalid data, the Microsoft 
Windows login window will be presented on the terminal and the user will need to login manually. 

Note: Users may need to be added to Microsoft’s Remote Desktop Users Group when connecting to a 
Windows 2003 terminal server. 
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Windows 2003 Computer Management – Local Users and Groups  

The Initial Program loads the designated program instead of the Windows desktop when the terminal 
connects to the Terminal Server. If a program is launched as the initial program, it is the only program that will 
run. This provides a level of security and control because that program is the only program that will run in that 
session. If the Initial Program is closed on the terminal, the session on the Terminal Server will close and the 
ThinManager Ready Thin Client will reconnect to the Terminal Server and re-launch the Initial Program. This 
effectively makes the Initial Program the only program. See Initial Program for details. 

To use the Initial Program, enter the path to the program in the Initial Program field as shown in the 
example. 

Note: When using the Initial Program with failover, the path must be identical on all terminal servers. If the 
path is different, use a batch file to launch the application. 
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Login for Domain Users 

 

Domain Member 

If a domain name is entered in the Domain field, the Verify button becomes active to allow the user to be 
check for validity. 

Select the Verify button to check the user. 
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Validate Users Window 

A Validate Users window will be displayed with the status of the user. If the user account is a valid domain 
account, the results will show valid. If the results show invalid, try another account. 
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Login for Terminal Server Group Users 

 
Login Information - Use Terminal Server Groups  

Terminals using Terminal Server Groups do not display the Initial Program field. Use AppLink to provide the 
Initial Program function instead. See AppLink for details. 

Select the Next button to continue configuration or select the Finish button to complete the Terminal 
configuration. 
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Video Resolution Page 

 

Terminal Configuration Wizard - Video Configuration 

The Video Resolution Configuration has drop-down boxes that allow the video resolution to be set for the 
terminal. The resolution levels and color depths are limited to what the selected is capable of using, as 
defined in the TermCap database. See TermCap Database for details. 

The standard terminal connection to a Windows 2000 terminal server is limited to the 256-color depth.  The 
RDP connection to a Windows 2003 terminal server can use the 64K-color depth. 



 

244  ••••  Configuration Wizards ACP ThinManager 3.1 Help Manual 

 

MultiMonitor Video Settings 

The MultiMonitor Video Settings window will be displayed if the ThinManager Ready thin client hardware 
selected has MultiMonitor capability, and the Enable MultiMonitor checkbox is selected on the Terminal 
Server Specification page. The number of monitors and the resolution of each can be selected. See 
MultiMonitor for details. 

Select the Next button to continue configuration or select the Finish button to complete the Terminal 
configuration. 
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WinTMC Settings Page 

 

WinTMC Settings 

If the terminal was defined as a GENERIC: PersonalComputer on the Terminal Hardware page, the 
terminal is configured as a WinTMC client  and will display the WinTMC Settings page. These only apply to 
connections made by the WinTMC fat client.  

Note: This page will only be shown if GENERIC: PersonalComputer is chosen for the Make/OEM and 
Model on the Terminal Hardware page. 
See WinTMC for details. 

See WinTMC Fat Client for details on the WinTMC client.   

The settings include: 

Redirect Local Resources: 
• Redirect Serial Ports – Enable this setting to make local serial ports available in a session. Serial 

Port redirection does not work when you connect to a terminal server running Windows 2000 or 
earlier. 

• Redirect Drives – Enable this setting to make local drives available in a session. Drive redirection 
does not work when you connect to a terminal server running Windows 2000 or earlier. 

• Redirect Printers – Enable this setting to make your local printer available in a session.  
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• Redirect Sound –Enable this setting to allow audio played in your session to play locally. Sound 
redirection does not work when you connect to a terminal server running Windows 2000 or 
earlier. 

•  Redirect Smart Cards – Enable this setting to make your smart card available in a session. Smart 
card redirection does not work when you connect to a terminal server running Windows 2000 or 
earlier. 

Client Control Settings: 
• Allow client to be closed – Enable this setting if you want your user to be able to close the client. 

• Allow client to be sized – Enable this setting if you want your user to be able to resize the client. 

Experience Settings:  
• Show Desktop Background – Enable this setting if you want your user to be able to select a 

Windows Desktop Background. If not set, the background will be a solid color.  

• Show window contents while dragging – Enable this setting if you want the window contents of a 
window to be shown while the window is being dragged.  

• Show menu/window animations – Enable this setting if you want menu/window animations to be 
enabled on the client.  

• Show Themes – Enable this setting if you want your user to be able to select a Windows Theme.  

Note: These functions may be denied by user policies or terminal server configuration. Check the Microsoft 
Local Policy, Group Policy, and Terminal Services Configuration. See Non-ThinManager Components 
for details. 

Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 
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Terminal Module Selection Page 

 

Terminal Configuration Wizard - Module Selection 

A Module is a component of the firmware that is not needed for the basic functionality but may be desired for 
advanced functionality. These features include Touch Screen drivers, serial mouse drivers, High Speed Serial 
drivers, Shared Keyboard and Mouse, USB Memory Card Reader, and Instant Failover. See Module 
Overview for details. 

To add a Module to a Terminal, select the Add… button to launch the Attach Module to Terminal window. 
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Attach Module to Terminal 

The Attach Module to Terminal window will show the modules that are available to the terminal. The 
Module Type drop-down box sorts the modules by categories to make the modules easier to find. 

Highlight the desired module and select the OK button to add the module to the configuration. 
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Terminal Configuration Wizard - Module Selection 

Terminals that are members of a Group may show icons to represent the properties of added modules. 

•  The Group icon represents modules assigned to a parent Group. 

•  The Group icon with yellow plus sign represents properties that are changed on the terminal 
from the Group settings. This is now limited to touch screen calibration.  

• No icon indicates that the module was added to that particular Group or Terminal and not a parent 
Group. 
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Module Configuration 

Highlighting a module and selecting the Configure button will open the Module Properties window and allow 
changes to the module configuration. 
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Module Properties 

On the Modules Properties window, select the parameter to change, select the new value in the drop-down 
list, and click the Set button. This will change the setting.  

The Set to Default button will restore the module to the default settings. 

Select the Done button to close the Module Properties window and to return to the Terminal Configuration 
Wizard. 

Select the Next button to continue configuration or select the Finish button to complete the Terminal 
configuration. 
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ThinManager Server Monitor List Page 

 

Terminal Configuration Wizard - ThinManager Server Monitor List 

The ThinManager Server Monitor List defines what Thin Manager Servers the terminal will communicate 
with to keep monitoring light status current. All ThinManager Servers defined in the ThinManager Server List 
Wizard will appear in the Available ThinManager Server column. 

If the Available ����������	
Server column is empty, the ����������	
Server List Wizard needs to 
be run to define the ����������	
Servers. Select the Edit Server List button to launch the ThinManager 
Server List Wizard as shown in ThinManager Server List Wizard. 
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Terminal Configuration Wizard - ThinManager Server Monitor List 

Once the ThinManager Server List wizard has run, each ThinManager Server that is identified in the 
ThinManager Server List Wizard will initially appear in the Available ThinManager Server box on the left of 
the Group Monitoring Configuration page.  

To select a ThinManager Server for the terminal, highlight it in the Available ThinManager Server list on the 
left and click the right arrow button. This will put the ThinManager Server into the Selected ThinManager 
Server list on the right. The terminal will send connection status (red/green icon lights) to all ThinManager 
Servers in the Selected ThinManager Server list. 

Select the Next button to continue configuration or select the Finish button to complete the Group 
configuration. 
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Monitoring Configuration Page 

 

Terminal Configuration Wizard - Monitoring Configuration 

ThinManager Ready Thin Clients continuously monitor the Terminal Server to make sure that it stays online. If 
the Terminal Server goes offline, the terminal will disconnect and connect to the next Terminal Server in the 
Group Terminal Server Selection. The Monitoring Connection sets the frequency that the monitor occurs. 

Use the Monitor Interval radio buttons to use a default frequency or select Custom and choose a setting of 
your own. 

• Monitor Interval is the interval that the monitor checks occur. 

• Monitor Timeout is the time the terminal will wait for a response from the terminal server. 

• Monitor Retry is the number of times the monitor check will be tried. 

• Primary Up Delay Multiplier is the number that generates the Primary Up Delay time. 

• Primary Up Delay is a delay added (usually set to 30 or 60 seconds) to allow a Terminal Server to 
get fully booted before the terminal will try to login. This time period is equal to the Monitoring Interval 
times the Primary Up Delay Multiplier. 

A Fast setting of the Monitor Connection will detect Terminal Server failure quickly. However, the faster the 
setting is, the more sensitive it is and it may drop the Terminal Server when the network is busy but not 
offline. Setting the Monitoring Connection to a slower setting gives the terminal server more time to respond 
when it is busy. 
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Select the Finish button to complete the terminal configuration. 
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ThinManager Server Configuration Wizard 
Selecting Manage > Settings will launch the ThinManager Server Configuration wizard that allows the 
configuration of global ThinManager settings. The ThinManager Server Configuration wizard is also 
accessible by double-clicking on the ThinManager icon in the tree, or by right clicking the icon and selecting 
Modify. 

 

ThinManager Server Configuration Wizard 

Select Next to Configure the ThinManager Server settings. 
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Unknown Terminals Page 

 

Unknown Terminals 

• Allow unknown terminals to connect - This checkbox, if selected, lets new terminals be added to 
the ThinManager Server. Replacements and new terminals are prevented if this box is un-selected. 

• Require password on unknown terminals - This checkbox, if selected, allows use of a password so 
that only authorized personnel can add terminals to the ThinManager Server. If checked, the 
password fields become active and allow the addition of a password. 

• Enable AutoCreate - This checkbox, if selected, allows the auto-creation of an array of terminals as 
described in Auto-Creation of Terminals.  

• AutoCreate Mask - This field is the base name used in the array of terminals when using Auto-
Creation of Terminals. 

Select the Next button to continue. 
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Terminal Replacement Page 

 

Terminal Replacement 

The Enable Replacement checkbox gives global permission for terminals to be replaced. Un-selecting this 
will prevent all terminals from showing up in the replacement list when a new terminal is added, making 
Create New Terminal the only option. This feature is also available for the Group and terminal level on the 
first page of the corresponding wizard. However, if this checkbox is unselected in the ThinManager Server 
Configuration Wizard, checking it in a Terminal Configuration Wizard will have no effect. 

Select the Next button to continue. 
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Historical Logging Page 

 
Historical Logging 

The Historical Logging page allows the Historical Log and Event Log parameters to be set. 

Historical Data 

• Maintain Historical Log for X days - This field determines the length of time that the terminal server 
CPU and memory data from the Terminal Server Graph tab is stored. See Details Pane for an 
example of the graph. 

• Clear History - This button will erase the Historical log. 

Event Log 

• Maintain Event Log for X days - This field determines how long the event log is kept. 

• Choose events to log - These checkboxes determine what events are stored in the log. 

• Terminal Server Events - This checkbox, when selected, records events of the terminal 
servers.  

• Terminal Events - This checkbox, when selected, records events of the terminal. 

• Terminal Configuration Changes - This checkbox, when selected, records changes to the 
terminal configuration. 

• User Configuration Changes - This checkbox, when selected, records changes to the 
TermSecure User configuration. 
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Selecting the Event Log tab will show the events for the highlighted tree icon. 

 

Event Log Tab 

Details of an event can be obtained by double-clicking on an event. 
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Event Detail 

The Event Details window shows details of the selected event. Select either the OK or Cancel button to 
close. 

Select Next to continue the ThinManager Server Configuration Wizard. 
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System Schedule 

 

System Schedule 

The next page of the ThinManager Server Configuration Wizard is the System Schedule page. This 
allows tasks to be scheduled for the ThinManager Server. 

Select the Edit Schedule button to launch the Event Schedule window. 
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Event Schedule Window 

The Event Schedule window allows events to be scheduled by selecting the Add button when system is 
displayed in the Select Event Category drop-down box.  
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Schedule for Weekly Event 

The Schedule dialog allows events to be scheduled for the ThinManager. The two main events are Run 
Report and Backup Configuration Database. 

Select the desired event in the Event Type drop-down. 

If Run Report is chosen, select the desired report in the Report Template File drop-down. 

If Backup Configuration Database is chosen the backup file will be automatically chosen if the Auto 
Generate Filename checkbox is selected. To use a different filename, uncheck the Auto Generate Filename 
checkbox and enter the desired name in the Report Output Filename. A Browse button will appear to allow 
selection of the file. 

The Repeat Interval radio buttons control the frequency of the event. The time selection varies with the 
Repeat Interval chosen. 
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Schedule for Monthly Event 

Select the appropriate time for the event and select OK to accept the configuration and Cancel to cancel the 
changes. 

While the Event Schedule window is open, other scheduled events can be viewed by selecting the event 
type in the Select Events Category drop-down. The event categories are system (ThinManager Server), 
terminal (Terminals), terminalserver (Terminal Servers) and user (TermSecure Users). 
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Events Schedule 

New events cannot be added for the non-system categories, but existing events can be changed by 
highlighting an event and selecting the Edit button. Events can be deleted by selecting the Delete button. 

The OK button accepts the changes and closes the window. 

Selecting the Next button on the System Schedule page will open the ThinManager Access Permissions 
page of the ThinManager Server Configuration Wizard. 

ThinManager Security Groups 

Access to ThinManager can be assigned to Windows User Groups on the ThinManager Security Groups 
page. 
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ThinManager Security Groups 

ThinManager allows different levels of access and functionality based on standard Windows groups.  

Standard Windows groups can be created in the Computer Management console and given different 
privileges in ThinManager. 

ThinManager 3.1 comes with privileges pre-defined for seven groups: 

• Administrators - The Microsoft defined Administrator group is given all privileges by default in 
ThinManager. This may be denied by unselecting the various Windows User Group Permissions. 

• ThinManager Administrators have full permission to do anything within ThinManager including the 
power to logoff sessions, kill processes, send messages, restart terminals, calibrate touch screens, 
change terminal configurations, update firmware, update the TermCap, and restore configurations. 
Administrators and members of ThinManager Administrators can shadow terminals and interactively 
control the terminal session. These privileges may not be removed. 

• ThinManager Interactive Shadow Users - Members of this group may shadow a terminal 
interactively. 

• ThinManager Power Users can logoff sessions, kill processes, send messages, restart terminals, 
and calibrate touch screens. They cannot change terminal configurations, update firmware, update 
the TermCap, and restore configurations. ThinManager Power Users can shadow terminals from 
within ThinManager but cannot interact with the session. 

• ThinManager Shadow Users - Members of this group may shadow a terminal but not interactively. 
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• ThinManager Users can view only. They cannot logoff sessions, kill processes, send messages, 
restart terminals, or calibrate touch screens. ThinManager Users cannot shadow a terminal. 

Additional Windows User Groups can be configured by selecting the Add Group button to launch the New 
Windows Group window. 

 

Figure 1 - New Window User Group Window 

Adding a Windows Group name in the Enter Windows User Group Name field of the New Window Group 
window and selecting the OK button will add the Windows User Group to the drop-down list. 

Note: This doesn’t create the user group on any servers. This just adds the name of an existing group to the 
list that ThinManager is maintaining. 
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ThinManager Security Groups Page 

Select the group from the Windows Users Group drop-down. Choose the permissions you want to grant to 
the group by selecting and unselecting the Windows Users Group Permissions checkboxes. Members of 
the Windows User Group will have the selected permissions the next time they login. 

Although ThinManager has Windows User Groups pre-configured with privileges, these groups have not been 
created on the terminal servers. 

To create a Windows User Group, open the Computer Management Console by selecting Start > Settings 
> Control Panel > Administrative Tools > Computer Management. 
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Created ThinManager Security Groups 

Highlight Groups in the tree and select Action > New Group to launch the New Group window. 
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Microsoft New Group Windows 

Enter the group name in the Group name field. 

Add Users to the Windows User Group by selecting the Add button. 

Select the Create button to finish the Windows User Group creation. Members of the Windows User Group 
will have the selected permissions the next time they login. 

Select Next to continue the ThinManager Server Configuration Wizard. 



 

ACP ThinManager 3.1 Help Manual Configuration Wizards  ••••  273 

Event Selection Page 

 

Event Selection 

ThinManager has event notification. E-mails or Windows messages can be sent by ThinManager to identify 
changes in the setup, configuration or status. 

Check the desired events, the method of notification, and select Next to proceed. 
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E-Mail or Windows Message Recipients Page 

 

Email or Windows Messaging Recipients  

The desired recipients of the event information can be specified on the Email or Windows Messaging 
Recipients page. 

E-Mail: 

• SMTP Server - Enter the SMTP (Simple Mail Transfer Protocol) server used by the ThinManager 
Server in the field. 

• E-Mail Addresses - ThinManager will send an e-mail message to the addresses in this text box when 
an event selected on the Event Select page occurs. 

• Add - Select this button to add e-mail addresses through the Enter the E-mail address window. 
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Enter the E-mail Address Window 

Enter the desired e-mail address in the entry form and select OK. Select the Cancel button to close 
the window without making changes. 

• Delete - Select this button to delete a highlighted e-mail address from the E-mail Addresses list. 

Messages: 

• Terminals - ThinManager will send a message to the terminals in this text box when an event 
selected on the Event Select page occurs. 

• Add - Select this button to add a terminal through the Select Terminal(s) window. 

 

Terminal Selection Window 

The Select Terminal(s) windows will list the terminals configured on the ThinManager Server. 
Highlight the desired terminal and select the OK button.  

• Delete - Select this button to delete a highlighted terminal from the Terminals list. 
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Email or Windows Messaging Recipients  

When the addresses are configured as desired, select the Next button to configure the ThinManager Server 
for Multicast or select Finish to accept configuration. 
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Multicast Configuration Page 

 

Multicast Configuration Page 

Multicast provides the ability for an unlimited number of terminals to boot simultaneously from the same data 
stream. This feature reduces the amount of network traffic and reduces the amount of load on the 
ThinManager Server when multiple terminals are booting concurrently. This function is especially useful for 
low bandwidth connections and highly utilized networks. 

Smart Multicast allows the terminal firmware to be sent directly to the terminal while a single terminal is 
booting. If additional terminals request the terminal firmware during this time, the firmware will be multicast so 
that all terminals can receive the firmware from a single data stream. If Smart Multicast is disabled, the 
firmware will always be sent as a multicast transmission. 

Multicast is only available on terminals with ACP Boot Loader Version 5.0 and later. No local terminal 
configuration is needed to use Multicast. 

There are two Multicast checkboxes and two buttons. 

• Enable Multicast - This checkbox, if selected, enables Multicast. 

• Enable Smart Multicast - This checkbox, if selected, enables Smart Multicast. 

• Advanced - This button, if selected, displays the advanced settings. 

• Load Defaults - This button, if selected, sets the advanced settings back to the defaults. 
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Advanced Multicast Options 

The Advanced settings are provided for advanced users.  

Note: If you do not understand these settings, we recommend that you use the default settings. 

Multicast Settings 
• Address – This is the IP address that will be used for Multicast transmissions. 

• Port – This is the destination port that will be used for Multicast transmissions. 

• Time-to-Live (TTL) – This is the maximum number of router hops for Multicast packets. Setting this 
value to 255 allows for unlimited hops. 

IGMP Settings (Internet Group Management Protocol) 
• Version – This sets the IGMP version for use with multicast capable routers. 

• Time-to-Live (TTL) – This sets the time-to-live value for IGMP packets. 
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Terminal Server Groups 

Terminal Server Group Overview 
Terminal Server Groups are collections of Terminal Servers. A ThinManager Ready thin client can connect to 
one or more terminal servers that are members of a Terminal Server Group. Instead of specifying individual 
terminal server that a terminal will connect to a terminal server defined in a terminal server group. The specific 
terminal server that the terminal connects to is based on the Terminal Server Group configuration and 
options. 

Note: Configuring a Terminal Server Group is covered in detail in the Terminal Server Group List. 
This section covers the special functions of Terminal Server Groups. 

The types of Terminal Server Groups include: 
• A standard Terminal Server Group has the terminal servers listed in a pre-defined order. The 

terminal connects to the first available member of the group. 

• The SmartSession option of Terminal Services Groups provides load balancing by using CPU 
availability, memory, and the number of sessions on the member terminal servers to determine 
the resource availability on member terminal servers. A ThinManager Ready thin client connects 
to the terminal server in the Terminal Server Group with the most available resources. 

• The Instant Failover option allows a terminal to connect to two terminal servers within a Terminal 
Server Group. The terminal will have an active session on two terminal servers but will only 
display one session. If the first terminal server fails, the session of the second terminal server is 
immediately displayed, eliminating any downtime due to terminal server failure. 

• The AppLink option provides the Initial Program function to members of a Terminal Server Group. 
When specifying the Initial Program function, a program is started instead of the desktop. Closing 
the program will terminate the connection. 

• MultiSession is a terminal configuration that allows a ThinManager Ready thin client to connect to 
multiple terminal servers from multiple Terminal Server Groups. The user can switch between 
groups using an on-screen menu or hot keys. These groups may be standard Terminal Server 
Groups, Terminal Server Groups with SmartSession, AppLink, and/or Terminal Server Groups 
with Instant Failover. 

These Terminal Server Group options can be combined on the same Terminal Server Group. For example,e 
a Terminal Server Group could use SmartSession to choose the server connection order, Instant Failover to 
maintain a backup, while using AppLink to limit the terminal to a single application. Additionally, a terminal 
server may be a member of several Terminal Server Groups. 
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Terminal Configuration Wizard - Terminal Server Specification Page 

A terminal will use Terminal Server Groups when the Use Terminal Server Groups radio button on the 
Terminal Server Specification page of the Terminal Configuration Wizard is selected. 
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SmartSession  
SmartSession is a load balancing strategy that allows terminals to connect to the member of a terminal 
server group that has the most available resources. ThinManager monitors the CPU load, memory 
availability, and number of sessions on the terminal servers and ranks them by availability. When a 
ThinManager Ready thin client connects to a member of a terminal server group with SmartSession, the 
terminal connects to the terminal server with the lightest load. 

 

SmartSession 

Each member terminal server needs SmartSession configured in the Terminal Server List Wizard. See the 
Terminal Server List Wizard for details. 
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Terminal Server Wizard – Terminal Server Capabilities 

Selecting the Available for Smart Session Groups checkbox on the Terminal Server Capabilities page of 
the Terminal Server List Wizard allows the Terminal Server to become a member of a terminal server group 
using SmartSession.  

Note: MultiSession can also be enabled on this page. 
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Terminal Server List Wizard - SmartSession Configuration 

The SmartSession Configuration page allows the configuration of the three parameters that ThinManager 
uses to determine resource availability. ThinManager determines the availability of a terminal server by 
measuring: 

• CPU Utilization 

• Memory Utilization 

• Number of Sessions 

 ThinManager uses these values to rank the SmartSession server loads, with a lower number representing a 
smaller load and greater resources. 

 Each parameter has two settings that set the range that ThinManager uses:  
• The Minimum field is the value that ThinManager will consider the parameter to be unused.  

• The Maximum field is the value that ThinManager will consider a parameter exceeded and 
unavailable. 

Once ThinManager has polled the terminal servers and established the availability of their resources, 
ThinManager passes the Server Ranking to the ThinManager Ready thin clients for its connection 
instructions. 



 

284  ••••  Terminal Server Groups ACP ThinManager 3.1 Help Manual 

 

ThinManager Interface – Server Rank Tab 

The Server Rankings are displayed on the Server Rank tab when a Terminal Server Group is highlighted in 
the ThinManager tree. In the example above a ThinManager Ready thin client would connect to Brown 
because it has the lowest load. 
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Instant Failover with Terminal Server Groups 
Terminal Server Groups can provide Instant Failover without using the Instant Failover Module. By 
selecting the Instant Failover checkbox on the Group Option page of the Terminal Server Group Wizard, 
a terminal will connect to a session on two terminal servers. Both sessions are active but only one is 
displayed. If the first terminal server fails, the second session is immediately displayed, eliminating any 
downtime due to terminal server failure. 

Instant Failover works within a Terminal Server Group, not between Terminal Server Groups.  

In a standard terminal server group, the terminal will use the first listed terminal server as the primary 
session and will use the second listed terminal server as the secondary session. 

In a terminal server group with SmartSession, the primary session will be on the server with the lightest 
load and the backup session will be on the terminal server with the second lightest load. 

The Instant Failover function requires an Instant Failover license for each terminal that uses it.  

 

Terminal Server Group Wizard – Group Options 

Instant Failover is a Group Option for Terminal Server Groups. 
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Terminal Configuration Wizard – Terminal Interface Options 

It is possible to switch between the sessions using Instant Failover on the terminal. Check the Enable Instant 
Failover Hotkeys checkbox on the Terminal Interface Options page of the Terminal Configuration 
Wizard for the desired terminal to activate the hotkeys to switch between sessions. 

See Terminal Interface Options for details. 
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MultiSession  
MultiSession allows a user to login to multiple terminal groups and switch between the various sessions. The 
user will have one session for each group that they have selected. This lets a user have access to several 
terminal servers through terminal server groups. These terminal server groups can be standard groups or 
have combinations of SmartSession, AppLink, and Instant Failover. 

Note: Users can cut and paste between sessions even when they are on different terminal servers when 
using RDP. 

 

Sample MultiSession Groups 

MultiSession is useful in large installations with many servers. Instead of installing every application on every 
server, individual terminal servers or groups of terminal servers can be dedicated to a single application, a 
small collection, or a suite. This simplifies maintenance, upgrading, and security, while limiting the number of 
conflicts between programs. 

Terminals can use MultiSession to access the Terminal Server Groups that they need. The groups can be 
standard terminal server groups, or combinations of the various options like SmartSession, Instant Failover, 
and AppLink. 

Enabling MultiSession is a three-step process. 
• First, the Terminal Servers need to be configured for MultiSession in the Terminal Server List 

Wizard. 
See Terminal Server List Wizard for details. 

• Second, the Terminal Server Groups need to be configured for MultiSession in the Terminal Server 
Group List Wizard. 
See Terminal Server Group List Wizard for details. 

• Third, the Group or Terminal needs to be configured to use MultiSession on the Terminal Server 
Specification page of the Terminal Configuration Wizard. 
See Terminal Configuration Wizard for details. 
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If two Terminal Server Groups are selected without the Enable MultiSession checkbox selected in the 
Terminal Configuration Wizard, a message will be displayed warning that the Enable MultiSession checkbox 
needs to be checked to allow the MultiSession. 

 

MultiSession Not Enabled Warning 

Users can switch between sessions using an onscreen Group Selector menu or hotkeys.  

 

MultiSession Group Selector 

The Group Selector shows the Terminal Server Group that the terminal is currently displaying. When 
activated by the mouse it shows a dropdown list of available Terminal Server Groups. 

Hotkeys can be used to switch between the terminal server groups if the Enable Group Hotkeys checkbox is 
selected on the Terminal Server Group Options page of the Terminal Configuration wizard.  



 

ACP ThinManager 3.1 Help Manual Terminal Server Groups  ••••  289 

 

Terminal Configuration – Terminal Interface Options 

The choice of the hot keys used can be set by selecting the Change Hotkeys button to launch the Select 
Hotkeys window. 
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Terminal Configuration Wizard - Select Hotkeys Page 

The default hotkeys are CTRL+Page Down and CTRL+Page Up. These can be changed by selecting the Alt 
Key radio button or selecting a different key in the dropdown box. 



 

ACP ThinManager 3.1 Help Manual Terminal Server Groups  ••••  291 

AppLink 
AppLink provides the Initial Program functionality to a Terminal Server Group. If AppLink is enabled, the path 
to an Initial Program is entered into the Terminal Server Group Wizard. This program will be the only 
program to run in that session. See the Login Information Page for details. 

AppLink is configured during the Terminal Server Group Wizard. See Terminal Server Group List for details. 

 

Terminal Server Group Wizard – Group Options 

Selecting the Application Link Group checkbox will make the Terminal Server Group an AppLink Group. 

Selecting Next will allow the designation of the Initial Program after the member servers are selected. 
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Terminal Server Group Wizard – Linked Application 

The AppLink page of the Terminal Server Group Wizard has an Enter the path to the Linked Application 
field. Fill in the field for the Initial Program with the valid path to the desired program. This may require the 
use of quotation marks if there are spaces in the path name.  

The Browse button will launch a Browse window that will allow the Enter the path to the Linked Application 
field to be filled in by ThinManager instead of typing the path manually. 

The AppLink Terminal Server Group may be a single terminal server or may contain many terminal servers. 
These may be Standard Groups, SmartSession Groups, or MultiSession Groups. 

Note: If the AppLink Group contains several terminal servers, the path must be valid for all members of the 
Terminal Server Group. If different members of the AppLink group have different paths to the desired 
program, write a batch file to open the program. 
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AppLink and MultiSession  
MultiSession receives a major increase in functionality in combination with AppLink. Since AppLink adds the 
Initial Program functionality to Terminal Server Groups, a terminal server group with AppLink will display an 
application instead of a desktop. The user can switch between applications as they switch between AppLink 
sessions in the different Terminal Server Groups. This allows terminal servers to be set up and maintained by 
application instead of having every application installed on every terminal server. 

 

AppLink Servers 

AppLink MultiSession is configured in the Terminal Server Group Wizard. 



 

294  ••••  Terminal Server Groups ACP ThinManager 3.1 Help Manual 

 

Terminal Server Group Wizard – Group Options 

Select the Make group available for MultiSession configurations checkbox and the Application Link 
Group checkbox to make the Terminal Server Group an AppLink MultiSession Group. 
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Terminal Server Group Wizard – Linked Application 

The AppLink page of the Terminal Server Group Wizard has an Enter the path to the Linked Application 
field. Fill in the field for the Initial Program with the valid path to the desired program. This may require the 
use of quotation marks if there are spaces in the path name. 

The AppLink MultiSession Terminal Server Group may be a single terminal server or may contain many 
terminal servers. These can be Standard Groups or SmartSession Groups. 

Note: If the AppLink Group contains several terminal servers, the path must be valid for all members of the 
Terminal Server Group. If different members of the AppLink group have different paths to the desired 
program, write a batch file to open the program. 

The terminal will display a Group Selector menu at the top edge of the session when it boots if the Show 
Group Selector on Terminal checkbox was selected in the Terminal Configuration Wizard. 
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Terminal Configuration – Terminal Interface Options 

The Show Group Selector on Terminal checkbox will display the mouse activated Group Selector at the top 
edge of the terminal screen. Hotkeys can be used if the Enable Group Hotkeys checkbox is selected on the 
Terminal Interface Options page of the Terminal Configuration Wizard. Both methods can be used, but at 
least one method must be available. 
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AppLink MultiSession Terminal Screen 

The Group Selector lists the Terminal Server Group that the terminal is currently displaying. When activated 
by the mouse it shows a dropdown list of available AppLink Terminal Server Groups. 
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Group Selector 

The user can switch between the AppLink Terminal Server Groups by using an on-screen Group Selector or 
by using hotkeys.  
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Failover and Instant Failover 

Failover Introduction 
ACP uses specific terms to cover different topics that are concerned with keeping data viable during computer 
failure.  

Replacement: If a terminal fails or is destroyed, the session stays active on the terminal server while the thin 
client is replaced. This is covered in Adding Thin Client Hardware. 

Failover: Failover is the ability to switch between multiple terminal servers if a terminal server fails. This is 
built in to every ThinManager Ready thin client. This is covered in Failover. 

Instant Failover: Instant Failover is the ability of ThinManager Ready thin clients to connect and login to two 
terminal servers simultaneously. This allows applications to be pre-loaded so that a failure to one terminal 
server causes minimal impact because the terminal will quickly switch to an existing session. This is covered 
in Instant Failover. 

Redundancy: Redundancy refers to multiple ThinManager Servers. ThinManager Ready thin clients are not 
dependent on ThinManager after booting and will continue to run if the ThinManager Server fails. However, 
rebooted terminal will wait until the ThinManager Server is restored until it boots and receives its 
configuration. For this reason some people use a backup, or Redundant ThinManager Server. This is covered 
in Redundancy Overview. 

Failover  
Every ThinManager Ready thin client has the ability to switch between multiple terminal servers if a terminal 
server fails. Each thin client has a program that monitors its terminal server. If the terminal server fails to 
respond to the terminal, it will drop the broken connection and connect to a backup terminal server, allowing it 
to continue to function.  

Failover requires:  
• Two or more terminal servers  

• Identical Microsoft user accounts on each, or domain permissions on both  

• Identical applications on each, with the same path, to make life easier  
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Simple Failover - Before Failure 

This shows a pair of terminal servers, one used as the primary with the terminals connected and running 
sessions, and a second terminal server as the backup, or secondary terminal server.  

 

Simple Failover, After Failure  

This shows the results of a failure of the primary terminal server. The thin clients would detect the failure and 
switch to the secondary terminal server where they would login and continue running.  
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Note: This does not synchronize the hard drives. This gives you the ability to continue to run the thin client by 
connecting to a backup. Data pulled from an outside source like a PLC or file server would be the same 
on either terminal server.  

 

Failover Setup using Individual Terminal Servers  
Failover is configured in the Terminal Configuration Wizard. It is configured differently when using individual 
terminal servers and Terminal Server Groups.  

 

Terminal Configuration Wizard - Select Individual Servers  

If individual terminal servers are to be used, select the Select Individual Terminal Servers radio button on 
the Terminal Server Selection page.  
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Terminal Configuration Wizard - Terminal Server Selection 

Configure failover on the Terminal Server Selection page by adding two or more terminal servers in the 
Selected Terminal Servers field. Upon bootup, the terminal will connect to the first terminal server in the list, 
considered the primary terminal server. If the primary fails, the terminal will connect to the next terminal server 
in the list. The terminal will use all the terminal servers in the list, if needed.  

The Enforce Primary Terminal Server Connection checkbox will keep the terminal monitoring the first 
terminal server in the list, even if it has failed. If the terminal detects that the primary terminal server is back 
on line, it will drop its connection to the backup and reconnect to the primary terminal server.  

Failover Setup using Terminal Server Groups  
Terminal Server Groups allows a terminal to connect to a group of servers. The Terminal Server Group will 
have Failover within that group if the Terminal Server Group has two or more terminal servers added to it. 
This is configured in the Terminal Server Group Wizard.  

Launch the Terminal Server Group Wizard by selecting Manage > Terminal Server Group List from the 
ThinManager menu. This is detailed in Terminal Server Group List.  
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Terminal Server Group List 

If the Available Groups box is empty, select the Add Group button to launch the Terminal Server Group 
Wizard.  

If the Available Groups box has groups, select the Add Group button to add a new group, or highlight an 
existing group and select the Edit Group button.  
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Terminal Server Group Wizard - Terminal Server Group Members  

Member terminal servers are added to the group on the Terminal Server Group Members page. Adding two or 
more terminal servers to the Selected Terminal Servers field will enable failover. The terminal will connect to 
the terminal servers in the order given, unless the Terminal Server Group is using SmartSession.  
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Terminal Server Group Wizard - Terminal Server Group Members  

As the Terminal Server Group Wizard proceeds, the Group Options page allows the Terminal Server Group to 
use SmartSession load balancing.  

SmartSession uses the CPU usage, Memory usage, and the number of sessions on a terminal to determine 
its load. Terminals connecting to a Terminal Server Group with SmartSession will ask ThinManager for the 
load numbers, then will connect to the server with the lightest load, instead of the order listed.  
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Instant Failover  
Basic failover is built into every ThinManager Ready thin client. Detecting that the primary server is down and 
connecting to a backup server is usually achieved in 5 to 15 seconds, depending on the monitoring 
configuration. Once the session is connected, it may take an additional 15-60 seconds to launch and initialize 
the programs. Instant Failover was developed for people who need the session to switch to another terminal 
server and start running immediately, without any delays for starting the applications.  

When using Instant Failover, the ThinManager Ready thin client starts sessions on two servers at once. The 
sessions are cascaded on the thin client, with the primary session on top. If the primary terminal server fails, 
the preexisting secondary session is switched to the forefront.  

 

Instant Failover, Part 1 

When a ThinManager Ready thin client using Instant Failover boots, it connects to two terminal servers, logs 
in, and starts two sessions.  
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Instant Failover, Part 2  

The thin client cascades both sessions and displays the primary session in front. You cannot see the 
secondary session as it is hidden in back. There is a optional hot key toggle available to allow toggling 
between sessions. See Instant Failover Module for details..  
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Instant Failover, Part 3  

If the primary server fails, the thin client monitoring program will detect its failure. The thin client will then 
switch the focus of the window, showing the secondary session. This session is already initialized so the user 
is able to proceed at once.  

Note: Use a Username, Password, and Initial Program to allow the ThinManager Ready thin client to login 
automatically and start a program so that the background session is immediately ready and not 
needing a login and program launch.  

If the Enforce Primary feature is used, the thin client will switch back to the primary once it is back online.  

Note: ThinManager Ready thin clients that use instant failover may require 64 MB of memory.  
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Instant Failover Configuration 
Instant Failover is initiated by the Instant Failover Module if a ThinManager Ready thin client is using 
individual terminal servers, or is configured as part of Terminal Server Groups if Terminal Server Groups are 
used.  

Instant Failover Setup using Individual Terminal Servers  
Instant Failover is initiated by the Instant Failover Module if a ThinManager Ready thin client is using 
individual terminal servers . 

Run the Terminal Configuration Wizard for the terminal or Group that needs instant failover and proceed to 
the Module Selection page.  

 

Module Selection Page - Attach Module to Terminal Window  

On the Module Selection page of the Terminal Configuration Wizard, select the Add button to launch the 
Attach Module to Terminal window. Highlight the Instant Failover Module and select OK. This will apply 
Instant failover to the Group or thin client when it reboots.  

The terminal or terminal group will need two or more terminal servers to connect to. This is done on the 
Terminal Server Selection page of the Terminal Configuration Wizard.  
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Terminal Configuration Wizard - Terminal Selection Page  

Select two or more terminal servers from the Available Terminal Servers list and move them to the Selected 
Terminal Servers list by highlighting and double clicking, or by using the Arrow buttons.  

The thin client will connect to the top two terminal servers in the Select Terminal Server list, with the top 
terminal server as the primary and the second terminal server as the backup.  

If more than two terminal servers are selected, the thin client will connect to the other terminal servers if one 
of the other terminal servers fails.  
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Instant Failover Setup using Terminal Server Groups  
Terminal Server Groups allows a thin client to connect to a group of servers. Instant Failover can be applied 
to this Terminal Server Group in the Terminal Server Group List.  

Launch the Terminal Server Group List Wizard by selecting Manage > Terminal Server Group List from the 
ThinManager menu.  

 

Terminal Server Group List 

The Terminal Server Group List will show created Terminal Server Groups. Select the Add Group button to 
create a new Terminal Server Group or highlight a group and select the Edit Group button to configure an 
existing group.  
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Terminal Server Group Wizard - Group Options Page 

Select the Instant Failover (requires license) check box on the Group Options page to enable instant 
failover for the Terminal Server Group.  

The Group Options allows the configuration of other Terminal Server Group parameters in addition to the 
Instant Failover. See the Terminal Server Group – Group Options Page for details. 

Each Terminal Server Group needs two or more terminal servers to get Instant Failover to function. This is 
done on the Terminal Server Group Members page of the Terminal Server Group Wizard.  
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Terminal Server Group Wizard - Terminal Server Group Members Page  

Select two or more terminal servers from the Available Terminal Servers list and move them to the Selected 
Terminal Servers list by highlighting and double clicking, or by using the Arrow button.  

The thin client will connect to the top two terminal servers in the Select Terminal Server list, with the top 
terminal server as the primary and the second terminal server as the backup, unless SmartSession was 
chosen on the Group Options page.  

If more than two terminal servers are selected, the thin client will connect to the other terminal servers if one 
of the other terminal servers fails.  
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Switching Between Instant Failover Sessions 
Instant Failover can be configured to allow a user to toggle between the two instant failover sessions. This is 
done differently when using individual terminal servers and Terminal Server Groups.  

Switching Between Sessions using Individual Terminal 
Servers 

Instant Failover can be configured in the Instant Failover Module to allow a user to toggle between the two 
instant failover sessions when the thin client connects to individual terminal servers. Run the Terminal 
Configuration Wizard for the thin client or Group that needs instant failover and proceed to the Module 
Selection page. See Instant Failover Module for details. 

 

Terminal Configuration Wizard - Module Selection Page  

Highlight the Instant Failover Module and select the Configure... button to launch the Module Properties 
window.  
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Modules Properties Window 

To enable hot key switching between sessions, highlight the Hot Key Switching parameter, select the 
Enabled value from the Value drop down and select the Set button.  

The hot key combination can be changed by selecting the Hot Key Combination is CTRL+ parameter, 
changing the key in the Value drop down and selecting the Set button.  

Select the Done key when finished, close the wizard, and reboot the thin client.  

The thin client will toggle between the instant failover sessions when the configured hot key combination is 
selected.  
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Switching Between Sessions with Terminal Server Groups 
Instant Failover can be configured to allow a user to toggle between the two instant failover sessions when 
the thin client is using Terminal Server Groups. To configure this, run the Terminal Configuration Wizard for 
the thin client or Group that is using a Terminal Server Group with Instant Failover and proceed to the 
Terminal Server Group Options page.  See Terminal Interface Options for details. 

 

Terminal Configuration Wizard - Terminal Server Group Options Page  

When a thin client is using Terminal Server Groups, selecting the Enable Instant Failover Hotkeys check 
box will allow the user to switch between instant failover sessions using the default CTL + F9 hot key.  

The default hot key can be changed by selecting the upper Change Hotkeys button and launching the Select 
Hotkeys windows.  



 

ACP ThinManager 3.1 Help Manual Failover and Instant Failover  ••••  317 

 

Select Hotkeys Windows 

The hot keys needed to switch between instant failover sessions on using Terminal Server Groups can be 
changed on the Select Hotkeys window. Select the Control Key or Alt Key radio button and a function key 
from the drop down box and select the OK button to accept the changes.  

Instant Failover Tree Icons 
Under each Terminal are icons representing the Terminal Servers that they connect to. The lightning bolt 
color indicated the connection status. 

 

Terminal Server Connection Icons 

A Red lightning bolt represents a lack of connection to the terminal server. 

A Green lightning bolt represents a connection to the terminal server with an active session. 

A Yellow lightning bolt represents a connection to the terminal server with an active session that is the 
backup in Instant Failover mode.  
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Instant Failover 

If a terminal that is configured for Instant Failover is expanded in the ThinManager tree, the Primary Terminal 
Server should have a green lightning bolt, while the Secondary Terminal Server should have a yellow 
lightning bolt, as shown in the example. 
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Modules 

Module Overview 
Modules are software components that can be loaded to increase the functionality of the terminal. Modules 
include touch screen drivers, sound drivers, and special device drivers. Some modules are included with 
ThinManager and are registered automatically during ThinManager installation. Other modules are obtained 
separately from Automation Control Products and need to be installed. 

Note: “Installing a module” refers to the registration of the module with the ThinManager Server, while 
“Adding a module” refers to attaching the module to a particular group or terminal. 

This section includes: 
• A list of available Modules.  

• Instructions on installing and adding Modules. 

• Details on specific modules.  

Module List 
ThinManager divides the modules into a number of categories or types to make navigation of the module list 
easier. Although details on the specific modules will follow, the types and modules include: 

ICA - See ICA Modules 
• Citrix ICA UseAlternateAddress Module 

• Citrix ICA wfclient.ini Extension Module 

• ICA Client  

Local Storage - See Local Storage Modules 
• USB Flash Drive Module 

• USB Memory Card Reader Module 

Miscellaneous - See Miscellaneous Modules 
• Add Serial Port 

• Firmware Update Module (formerly the Disk On Chip / Compact Flash Update Module) 

• Instant Failover Module 
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• Key Block Module 

• Local Printer Module 

• MultiMonitor Module 

• TermMon ActiveX Configuration 

• Time Zone Redirection Module 

Mouse - See Mouse Modules 
• Mouse Configuration 

• PS/2 Mouse Configuration 

• Serial Mouse Driver 

• Share Keyboard and Mouse Master Module 

• Share Keyboard and Mouse Slave Module 

RDP - See RDP Modules 
• RDP Experience Module 

• RDP Module for ThinManager v2.4 and Older 

• RDP Port Module 

• RDP Serial Port Redirection Module 

Screen Saver - See Screen Saver Modules 
• MultiSession Screen Saver Module 

• Screen Saver Module 

Sound - See Sound Modules 
•  Advantech ARK-3380 Sound Driver 

• Advantech PCM-5820 Sound Driver 

• Advantech PCM-9372 Sound Driver 

• Advantech UNO-2053E Sound Driver 

• Allen-Bradley VersaView 200R Sound Driver 

• Arista 5824-ACP Sound Driver 

• Arista 6824-ACP Sound Driver 

• Arista AP-3200 Sound Driver  

• Arista BoxPC-201H Sound Driver  

• DC_30_100 Sound Driver 

• DC_40_100 Sound Driver 

• Gigabyte TA3LB Sound Driver 

• NTA-6020 Sound Driver 

• TC3000 Sound Driver 

• TC3500 Sound Driver 

• TeleVideo TC7X30 Sound Driver 
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• Xycom XA1300 Sound Driver 

TermSecure - See TermSecure Modules 
• RF Ideas pcProx Module 

• TermMon ActiveX Configuration Module 

• USB Flash Drive Module 

• Wavetrend Tag Reader 

Touch Screen - See Touch Screen Modules 
• Arista ARP-16XXXAP-ACP Touch Screen Driver 

• CarrollTouch Touch Screen Driver 

• Contec Touch Screen Driver 

• DMC Touch Screen Driver 

• Dynapro Touch Screen Driver 

• Elographics Touch Screen Driver 

• Gunze AHL Touch Screen Driver 

• MicroTouch Touch Screen Driver 

• PenMount Touch Screen Driver 

• Ronics Touch Screen Driver  

• Touch Control Touch Screen Driver 

• Touch International IR Touch Screen Driver 

• Xycom 33XX Touch Screen Driver 

Video Driver - See Video Driver.  
• AMD Geode Video Driver 

• Core Video Driver 

• Geode Video Driver 

• Intel i8XX Video Driver 

• Intel i8XX//i9XX Video Driver 

• Legacy Video Driver 

• MultiMonitor Video Driver 

• S3 Savage Video Driver 

• VIA CLE266 Video Driver 
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Installing a Module  
Installing a Module adds a new module to ThinManager so that it is available to Terminal Groups and 
Terminals. To install a module, open the Modules window by selecting Install > Modules from the 
ThinManager menu bar to launch the Modules window.  

 

Modules Window 

The Module window shows all of the modules installed on the ThinManager Server.  



 

ACP ThinManager 3.1 Help Manual Modules  ••••  323 

 

Sorted Modules 

The installed modules can be sorted by using the Module Type dropdown list. 

To install additional modules select the Install Module button. This will launch a file browser window.  
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Module File Browser Window 

Browse to the new module, usually downloaded from the ThinManager web site (www.thinmanager.com ). 
Highlight the new module, and select the Open button. This will add the new module to the list of modules. 

Selecting the Remove Module from All Terminals  button will remove the highlighted module from all 
terminals. It does not uninstall the module from the ThinManager Server; it just removes its use by all groups 
and terminals. 

Select the Done button to close the Modules window. 
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Adding a Module to a Group or Terminal 
Modules are added to terminals or groups of terminals on the Module Selection page of the Terminal 
Configuration Wizard or the Terminal Group Configuration Wizard. 

 

Terminal Configuration Wizard - Module Selection 

To add a Module to a Terminal, select the Add… button to launch the Attach Module to Terminal window. 
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Attach Module to Terminal 

The Attach Module to Terminal window will show the modules that are available to the terminal. The 
Module Type drop-down box sorts the modules by categories to make the modules easier to find. 

Highlight the desired module and select the OK button to add the module to the configuration. 
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Terminal Configuration Wizard - Module Selection 

Terminals that are members of a Group may show icons to represent the properties of added modules. 

•  The Group icon represents modules assigned to a parent Group. 

•  The Group icon with yellow plus sign represents properties that are changed on the terminal 
from the Group settings. This is limited to touch screen calibration.  

• No icon indicates that the module was added to that particular Group or Terminal and not a parent 
Group. 
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Changing Module Parameters 
Many modules have parameters that can be changed. With the new inheritance rules from ThinManager 3.0 
module parameters can’t be changed for modules that are inherited from a parent group. Changes must be 
made at the level that the module was added. 

 
Module Configuration 

Highlighting a module on the Module Selection page and selecting the Configure button will open the 
Module Properties window and allow changes to the module configuration. 
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Module Properties 

On the Modules Properties window, select the parameter to change, select the new value in the drop-down 
list, and click the Set button. This will change the setting.  

The Set to Default button will restore the module to the default settings. 

Note: The Set button must be selected to apply the change. 

Select the Done button to close the Module Properties window and to return to the Group or Terminal 
Configuration Wizard. 

 



 

330  ••••  Modules ACP ThinManager 3.1 Help Manual 

 

Module Icons in ThinManager 

The status of the modules is displayed on the Modules tab of the Details pane of ThinManager. 

Module Loading Order 

Highlighting a module and selecting the Move Up or Move Down button can change the order that the 
modules load. 



 

ACP ThinManager 3.1 Help Manual Modules  ••••  331 

 

Module Loading Order 

The loading order of modules rarely needs to be adjusted. 
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Individual Module Details 
ThinManager divides the modules into a number of categories or types to make navigation of the module list 
easier. The types and modules include ICA, Local Storage, Miscellaneous, Mouse, RDP, Screen Saver, 
Sound, TermSecure, and Touch Screen.  

ICA Modules 
The ICA Modules are advanced modules for advanced users of the ICA client communication protocol. 

Citrix ICA UseAlternateAddress Module 
 

The Citrix ICA UseAlternateAddress Module is used by advance Citrix users to specify connections to 
Citrix Servers.  

Configuration includes UseAlternate Address, Browser Protocol, and HttpBrowser Addresses.  

Citrix ICA wfclient.ini Extension Module 
The Citrix ICA wfclient.ini Extension Module is used by advance Citrix users. This module allows up to 8 
strings of text to be added to the wfclient.exe for passing Citrix parameters. 

ICA Client  
The ICA Client Module is a module that does not need to be added by administrators. If a terminal is 
configured to use the ICA client communication protocol on the Terminal Server Specification page of the 
Terminal Configuration Wizard, the terminal will automatically download this module to enable ICA 
functionality without human intervention. 

Local Storage Modules 
The Local Storage modules allow the use of USB ports on ThinManager Ready thin clients. The USB ports 
are not active by default for security. 

USB Flash Drive Module 
The USB Flash Drive Module allows USB flash drives to connect to a terminal. The parameters include: 

• Drive Access Rights in Session - ReadWrite allows the user to read and write to the flash drive. 
ReadOnly allows the user to read data but not write data, and None sets the flash drive to access only 
the unique serial number to make it usable as a TermSecure ID device.  

• Use with TermSecure - This, when set to Yes, will allow the flash drive to be used as a TermSecure 
ID device.  

• Allow Manual Login - This value, when set to Yes, will allow a TermSecure user to log into a 
terminal without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure ID 
device to log in.  

• Prompt for Password - This value, when set to Yes, will require a TermSecure User to enter their 
password for access, even if the password is configured in ThinManager.  
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See Card and Badge Configuration for a TermSecure User for details. 

USB Memory Card Reader Module 
The USB Memory Card Reader Module allows USB card readers to connect to a terminal. The parameters 
include: 

• Number of Slots in Reader - This value sets the number of slots that the card reader uses. 

• Read Only Access - This value, when set to Yes, will limit the user to reading the card. This value, 
when set to No, will allow the user to read and write to the card. 

Miscellaneous Modules 
These are modules that don’t fit in other categories. 

Add Serial Port 
The Add Serial Port Module is only used to configure the serial ports of daughter boards that add additional 
serial ports to terminals. Add a module for each additional serial port. Each module will let the user configure 
one additional port.  

• Port Number - This value is to be set to the port number of the new port. 

• Port Address - This value is to be set to the port address of the new port. 

• IRQ - This value is to be set to the IRQ of the new port. 

• UART- This value is set to the chipset type for the new port. 

Firmware Update (Disk On Chip / Compact Flash) Update 
Module 

The Firmware Update is the new name for the Disk On Chip/Compact Flash Update module in 
ThinManager 3.1. 

ACP enables some models of terminals to store the firmware with Disk On Chip or Compact Flash storage so 
that the unit doesn’t have to download the entire firmware at boot but can boot locally and download just the 
configuration to save bandwidth. This is most commonly used with units that will connect over low bandwidth 
networks, like wireless networks or WANs. These units can use the Firmware Update module to download 
and flash new firmware when the firmware is updated in ThinManager. 

The ability to update stored firmware terminals eliminates the need to send the terminal back to the 
manufacturer to update the firmware. 

Note: The firmware download can vary, depending on the bandwidth of the connection and the size of the 
firmware update.  
It is recommended that updates be done over a wired LAN instead of over a wireless connection, when 
possible. 

The Firmware Update module has two configurable parameters.  
• Confirm at Terminal - This setting, if set to Yes, will prompt the operator to choose between 
immediately updating firmware or waiting until the next boot up. If Confirm at Terminal is set to No, the 
firmware download will take place immediately. 
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• Force Update - Normally a stored firmware terminal with the Firmware Update module will check 
firmware version numbers at boot and only download a new firmware if the versions are different. This 
setting, if set to Yes, will force the terminal to always download the firmware for re-flashing. 

Note: The module will download firmware when it detects a different firmware. Since this will only happen at 
the first reboot after updating the ThinManager firmware, it is safe to leave this module added to terminals 
permanently when Force Update is set to No. It does not need to be added and removed each time the 
firmware is updated. However, since it will update when the firmware is different, it will try to update the 
firmware if you boot it from a ThinManager server with older firmware. 

Firmware Update Program 

Once the new firmware has downloaded, an update program will run on the terminal to rewrite the new 
firmware to the storage. The program will display a warning stating that the terminal must not be reset or 
powered off during the process, usually around 30 seconds. Ignoring the warning can corrupt the stored 
firmware, so it is important to leave the terminal alone for that period of time.  

Note: Heed the warning. The terminal must not be reset or powered off during the brief period that the update 
program is writing the firmware to the firmware storage device.  
It is recommended that updates be done over a wired LAN instead of over a wireless connection, when 
possible. 

Stored Firmware Terminal Configuration 

A stored firmware terminal loads the firmware locally before connecting to the ThinManager server. The 
stored firmware terminals have a setup program that allows configuration of the connection. Enter the 
program by selecting any key when Select any key to configure is displayed during the boot process. A setup 
screen will be displayed.  

 

Disk-On-Chip/Compact Flash Configuration Screen 

The IP Addressing method is set to DHCP by default. To change a value, navigate with arrow keys to the 
desired property. Pressing the Enter key will allow the input and acceptance of new values. The changes may 
be saved or discarded before the boot process is resumed. 
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Instant Failover Module 
The Instant Failover Module allows a terminal to connect to a session on two terminal servers. Both 
sessions are active but only one is displayed. If the first terminal server fails, the second session is 
immediately displayed, eliminating any downtime due to terminal server failure. See Instant Failover for 
details. 

The Instant Failover module is used if the terminal is connecting to individual terminal servers. If Terminal 
Server Groups are being used, Instant Failover is a Terminal Server Group option. Instant Failover works 
within a Terminal Server Group, not between Terminal Server Groups. 

Note: The Instant Failover Module is only used with terminals using Individual Terminal Servers. (See 
Terminal Server Specification Page). 
Terminals using Terminal Server Groups use a checkbox to enable Instant Failover. (See Instant Failover with 
Terminal Server Groups). 
Do not use this module while using Terminal Server Groups. 

The Instant Failover function requires an Instant Failover license for each terminal that uses it. 

The ThinManager Ready thin client cascades both sessions, with the primary in front. You cannot see the 
secondary session as it is hidden in back. There is an option that allows one to switch between sessions with 
a hot key. 

Instant Failover Configuration When Using Individual Terminal Servers 

If using the Instant Failover module, this is configured in the module properties.  

 

Instant Failover Module Properties 

• Hot Key Session Switching  - If this parameter is set to Enabled, the hot key combination will allow 
the toggling between sessions.  
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• Hotkey Combination is CTRL+ - The value of the hot key is defaulted to CTRL+F9 but can be 
assigned to any function key. 

Instant Failover Configuration When Using Terminal Server Groups 

 

Terminal Server Group Options - Instant Failover Hotkey Configuration 

If using a Terminal Server Group with Instant Failover, the hotkey is enabled on the Terminal Interface 
Options page of the Terminal Configuration Wizard by selecting the Enable Instant Failover Hotkeys 
checkbox. 

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow the 
hotkeys to be changed from the default. 
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Select Instant Failover Hotkeys  

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by selecting the 
Alt Key radio button or using the drop-down to select another function key. 

Key Block Module 
The Key Block module traps certain keystrokes and prevents them from being sent to the terminal server for 
processing. 
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Key Block Module 

The key combinations to be blocked can be configured by in the Module Properties. To launch this, highlight 
the module on the Module Selection page and select the Configure button. A Module Properties dialog box 
will be displayed. Select the parameter to change in the Module Properties window, select the Value in the 
dropdown box and click the Set button. 

The key combinations that have a value of YES will be blocked from reaching the terminal server. 

Local Print Module 
The Local Print Module simplifies printing through the parallel port on ThinManager Ready thin clients.  

There are three steps: 

1. Install the print driver on the terminal servers that the client will connect to. 

2. Add the Local Print Module to the ThinManager Ready thin client as described in Adding a 
Module to a Group or Terminal. 

3. Configure the Print Driver Name parameter in the module to contain the print driver’s name. 
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Local Print Module Properties 

• Printer Driver Name - The Local Print module works when the name of the print driver is entered in 
the Value field for the Printer Driver Name. The Print Driver name is provided by the properties page for 
the printer. 

The Printer Property page for a printer can be launched by selecting Start > Settings > Printers and 
selecting the appropriate printer. This will launch the Printer Queue window. 

 

Printer Queue window 

Select Printer > Properties to launch the Printer Properties page. 
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Advanced Printer Properties 

The Printer Property page shows the Print Driver name on the Advanced tab. This is the name that needs 
to be entered into the Local Print Module. 
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Client Print Window 

When printing from the client, the printer will be displayed as Printer/username/session number as shown 
in the example. 

MultiMonitor Module 
 

 

MultiMonitor  

The MultiMonitor Module was introduced to allow MultiMonitor capable thin clients to be configured for use 
with MultiMonitor before MultiMonitor was integrated into ThinManager 3.1. This module provides primitive 
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functionality compared to the integrated settings of ThinManager 3.1 and is no longer used. See MultiMonitor 
for details. 

 

MultiMonitor Module Parameters 

The MultiMonitor Module has four parameters: 
• Number of Monitors – This allows the terminal to be configured for the number of monitors attached. 

• Main Monitor – This selects which monitor will receive the login window and messages. 

• Session Spanning – This setting, if set to Yes, allows the monitors to be merged into a single 
desktop. The maximum size is 4096x2048 pixels. 

• Monitor Orientation – This sets the monitor configuration to HORIZ (horizontal) for side-by-side, 
VERT (vertical) for stacked, or SQUARE for a grid.  

TermMon ActiveX Configuration 
This configures the TermMon ActiveX control that collects terminal information and can perform terminal 
functions. It is listed as both a Miscellaneous Module and a TermSecure Module but is described in the 
TermSecure section. 
See TermMon ActiveX Control for details. 

Time Zone Redirection Module 
The Time Zone Redirection Module allows a terminal to display local time when it is connected to a terminal 
server in another time zone. 
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Time Zone Module Properties 

• Time Zone  - This parameter can be highlighted to activate the Value drop-down that contains time 
zones. Select the Set button to accept the changes. 

The Time Zone Redirection module needs to have time zone redirection allowed in the Group Policy Console. 
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Group Policy Console 

The Allow Time Zone Redirection policy is found under Local Computer Policy\Computer 
Configuration\Administrative Templates\Windows Components\Terminal Services\Client/Server data 
redirection folder of the Group Policy. 

Please see Microsoft documentation for information on Group Policy. 

Mouse Modules 

Mouse Configuration Module 
The Mouse Configuration Module allows USB or PS/2 mice to be configured and allows the use of two mice. 
Configuration of mouse settings include:  

• Primary Mouse Type -This setting allows both a PS/2 mouse and USB mouse to be used on a 
terminal. This setting will define which mouse is considered the primary mouse.  

• Mouse Protocol - This value allows the selection of different protocols used by the mouse. 

• Scroll Mouse - The value, when set to Yes, allows a scroll mouse to function on a terminal. 
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• Acceleration Multiplier - This value allows the mouse movement to be slowed down or sped up. 

• Acceleration Threshold (pixels) - This value is the number of pixels a mouse must move before the 
acceleration multiplier takes effect. 

These parameters can be changed by highlighting the parameter and choosing a new value in the Value 
dropdown box. Use the Set button to accept the new parameter value. 

 

Mouse Configuration Module 

ThinManager supports USB mice with the latest firmware. The Mouse Configuration Module allows 
configuration of USB mice.  

A ThinManager Ready thin client can have both a USB and a PS/2 mouse installed. This module allows the 
selection of the primary mouse when using two mice. 

PS/2 Mouse Module 
The PS/2 Mouse Module is the forerunner of the Mouse Configuration Module. It allows the changing of PS/2 
settings like mouse type, acceleration and threshold. All of these features are now available in the Mouse 
Configuration Module. 

• Mouse Type -This value allows the selection of PS/2 or USB mouse type. 

• Scroll Mouse - The value, when set to Yes, allows a scroll mouse to function on a terminal. 

• Acceleration Multiplier - This value allows the mouse movement to be slowed down or sped up. 

• Acceleration Threshold (pixels) - This value is the number of pixels a mouse must move before the 
acceleration multiplier takes effect. 
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Serial Mouse Driver 
The Serial Mouse Driver allows a serial mouse to be used with ThinManager Ready thin clients. 

 

Serial Mouse Module 

Mouse Type - This value defines what type of mouse is used. 

Serial Port – Set this value to the serial port number used for the mouse. 

Share Keyboard and Mouse Modules 
The Share Keyboard and Mouse module allows several ThinManager Ready thin clients to be controlled 
with a single keyboard and mouse without the need of a KVM switch (Keyboard/Video/Mouse). 

The Share Keyboard and Mouse has a Master module that is added to the controlling terminal, and a Slave 
module that is added to the dependent terminals. 

 

Shared Keyboard and Mouse Layout 

The Share Keyboard and Mouse can be used by placing several monitors connected to ThinManager Ready 
thin clients side-by-side or top-to-bottom. The Share Keyboard and Mouse Master module is loaded on the 
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center thin client. This module is configured by adding the IP addresses of the secondary slave thin clients. 
The other terminals receive the Share Keyboard and Mouse Slave module. 

 

Share Keyboard and Mouse Master Module 

Once the Share Keyboard and Mouse Master Module is added to a terminal, it can be configured by 
highlighting it in the Installed Module window and selecting the Configure button. 
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Share Keyboard and Mouse Master Module Properties 

• Left Terminal IP Address - Enter the correct IP address for the Slave terminal on the left of the 
master terminal, if used, and select the Set button. 

• Right Terminal IP Address - Enter the correct IP address for the Slave terminal on the right of the 
master terminal, if used, and select the Set button. 

• Top Terminal IP Address - Enter the correct IP address for the Slave terminal on the top of the 
master terminal, if used, and select the Set button. 

• Bottom Terminal IP Address - Enter the correct IP address for the Slave terminal on the bottom of 
the master terminal, if used, and select the Set button. 

• Allow Interactive Shadow of Master  - Normally a terminal with the master module loaded is 
blocked from interactive shadow. If you want to allow interactive shadowing on the master, highlight the 
Allow Interactive Shadow of Master parameter, select Yes from the Value drop-down, and select the 
Set button. 

The Share Keyboard and Mouse Slave module is loaded on the secondary thin clients using the same 
methods as other modules are loaded.  
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Share Keyboard and Mouse Slave Module Properties 

• Master IP Address  - This setting allows the slave module to be configured to connect to a specified 
master by entering the IP address of the master terminal and selecting the Set button. 

Select the Done button when finished. 

Once the ACP Enabled thin clients are booted, the mouse on the master thin client can be moved seamlessly 
into the other desktops. The keyboard will be active in whatever screen the mouse pointer is on. 

This allows an operator to have control of several displays with only one keyboard and mouse. The mouse 
movement is seamless, allowing access to displays without switching. 

Note: A Master Share Keyboard and Mouse session cannot be interactively shadowed in ThinManager 
unless it is configured to allow it. 

The keyboards and mice for the slave thin clients can be left attached but stowed away until a multi-user 
configuration is needed. 

The Share Keyboard and Mouse Master module is licensed for each master thin client. The Share 
Keyboard and Mouse Slave module is free. Each master module can have 1 to 4 slave units. Future 
releases will expand the number of slaves that the master can control. 
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RDP Modules 

RDP Experience Module 
The RDP Experience Module allows a session connected to a Windows 2003 terminal server with RDP to add 
features to the session.  

 

RDP Experience Module Parameters 

The RDP Experience Module parameters are:  
• Allow Desktop Background - This setting, if set to Yes, will allow a terminal to show a desktop 
background. 

• Show Window Contents While Dragging - This setting, if set to Yes, will allow a terminal to show 
window contents while dragging. 

• Allow Menu and Window Animation - This setting, if set to Yes, will allow a terminal to show 
window and menu animations. 

• Allow Themes - This setting, if set to Yes, will allow a terminal to show a desktop Theme. 

These features are only available with Windows 2003 Server. In order to use these features, they must be 
enabled by using the Windows Group Policy Editor. See Microsoft documentation for details. 
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Group Policy Console 

Windows 2003 adds a variety of features that can be accessed or denied by Windows Group Policies as 
shown in the example. Please consult Microsoft documentation for assistance with these features.  

RDP Module for ThinManager v2.4 and Older 
The RDP Module for ThinManager v2.4 and Older module is used to allow older versions of ThinManager 
to use RDP. 

ThinManager didn’t support RDP until the v2.4.1 release. Users with older versions of ThinManager can use 
the RDP client communication protocol with older versions of ThinManager by adding the RDP Module for 
ThinManager v2.4 and Older to the terminal and installing a ThinManager firmware that is v02.05.00 or later. 

RDP Port Module 
The RDP Port Module allows that port that RDP communicates to the terminal server to be changed from the 
default 3389 to another port. 
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RDP Port Module Parameters 

The RDP Port Module allows the port that RDP uses to be changed from the default 3389. 
• RDP Server Port Number (decimal) - Enter the new port number for RDP in this value. 

RDP Serial Port Redirection Module  
The serial ports on a ThinManager Ready thin client can be remapped by adding the RDP Serial Port 
Redirection module to the thin client without additional configuration. Once the thin client is booted, the 
COM1 in the session will refer to the COM1 on the terminal, while the COM2 in the session will refer to the 
COM2 on the terminal. This function requires Windows 2003 to work. 

Additionally the COM Port Mapping needs to be allowed. This is done on the Terminal Services 
Configuration Console. To open the Terminal Services Configuration Console in Windows 2003 select Start 
> Administrative Tools > Terminal Services Configuration. 
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Terminal Services Configuration Console 

Launch the RDP-tcp Properties page by highlighting the Connections folder in the tree pane and double-
clicking the RDP-tcp in the right pane. This will launch the RDP-tcp Properties page. 
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COM Port Mapping Allowed 

The Com port mapping checkbox must be unselected to allow the RDP Serial Port module to function on 
the Windows 2003 terminal server. 

Screen Saver Modules 

MultiSession Screen Saver Module 
The MultiSession Screen Saver Module is a screen saver for use on terminals configured with 
MultiSession. See MultiSession for details. 
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MultiSession Screen Saver Module Parameters 

The MultiSession Screen Saver Module has two modes. It can be set to cycle through the MultiSession 
windows when the terminal is inactive, or it can be set to return to the main MultiSession screen when the 
terminal is inactive. 

The parameters are: 
• Mode - The Cyclic mode will switch between all active sessions on the terminal. The 
GotoFirstGroup mode will switch the terminal to the main session when it is inactive. 

• Start Delay Time in secs - This is the number of seconds of inactivity that the terminal will allow 
before starting the screen saver. 

• Switch Interval in secs (Cyclic only) - This is the number of seconds that the terminal will display 
each session when using the Cyclic mode. 

Screen Saver Module 
Screen Saver Module is a module that loads a screen saver on the client. The screen saver will run when 
the terminal is idle to protect the monitor. Since the screen saver runs on the client, it saves CPU resources 
on the terminal server.  
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Screen Saver on Thin Client 

 

MultiSession Screen Saver Module Parameters 

The Screen Saver Module configuration includes: 
• Screen Saver - the graphic that is displayed when the screen saver is active. 
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• Wait Time in Minutes - the length of time that the terminal needs to be idle before the screen saver 
starts. 

• Use Disable Time Period - the screen saver can be set to be disabled, or unavailable during a time 
block. This could be used to prevent the screen saver from running during normal business hours. 

• Disable Start Time (0-23) - This sets the start of the disabled time block. 0 is Midnight and 
23 is 11:00 p.m. 

• Disable End Time (0-23) - This sets the end of the disabled time block. 0 is Midnight and 23 
is 11:00 p.m. 

• Force Off when Start Hour is Reached - If set to Yes, this will turn the screen saver off 
when the Disable End Time is reached. 

 

Sound Modules  
The use of sound from a ThinManager Ready thin client requires four things: 

• ThinManager Ready hardware with a Line Out plug 

• An amplified speaker  

• The appropriate sound module 

• Either a Windows 2003 Server terminal server or MetaFrame.  

Plug the speaker(s) into the Line Out plug on the terminal, add the module, and connect to the terminal 
server.  

Note: Some thin clients, like the Advantech PCM-5820, may require that a sound harness be plugged into the 
motherboard. 

Current sound modules include:  
• Advantech ARK-3380 Sound Driver 

• Advantech PCM-5820 Sound Driver 

• Advantech PCM-9372 Sound Driver 

• Advantech UNO-2053E Sound Driver 

• Allen-Bradley VersaView 200R Sound Driver 

• Arista 5824-ACP Sound Driver 

• Arista 6824-ACP Sound Driver 

• Arista AP-3200 Sound Driver  

• Arista BoxPC-201H Sound Driver  

• DC_30_100 Sound Driver 

• DC_40_100 Sound Driver 

• Gigabyte TA3LB Sound Driver 

• NTA-6020 Sound Driver 

• TC3000 Sound Driver 
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• TC3500 Sound Driver 

• TeleVideo TC7X30 Sound Driver 

• Xycom XA1300 Sound Driver 

 

Sound Module Parameters 

These Sound modules have several settings: 
• Audio Bandwidth (ICA Only) - This parameter can be set to Low, Medium, or High bandwidth when 
using Citrix MetaFrame. 

• Sound in Session - This setting, when set to Enabled, will allow sound generated within the session 
to be played through the terminal. When this is set to Disabled the session sounds will be turned off but 
system sounds will still be generated during TermSecure login for audio feedback during the login 
process.  

• Terminal Sound Effects - This setting, when set to Enabled, will allow terminal sound effects like 
TermSecure login sounds on the terminal. 
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TermSecure Modules  

RF Ideas pcProx Module 

 

RF Ideas pcProx Module Parameters 

The RF Ideas pcProx Module allows a terminal to use RF Ideas pcProx cards as TermSecure ID cards. The 
parameters are: 

• Port - This selects the port that the RF Ideas pcProx card reader is installed. 

• Number of Data Bits – Different cards use different numbers of data bits in their format. This sets the 
number of data bits to match that used by the card as an identifier. The choices are 26, 37, or Raw. 

• Use Facility Code - This value, when set to Yes, will require the addition of the card’s Facility Code 
to the Card / Badge ID number. 

• Allow Manual Login - This, when set to Yes, will allow a TermSecure user to log into a terminal 
without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure ID device to log 
in.  

• Prompt for Password - This, when set to Yes, will require a TermSecure to enter their password for 
access, even if the password is configured in ThinManager.  

See Card and Badge Configuration for a TermSecure User for details. 

TermMon ActiveX Configuration 
This configures the TermMon ActiveX control that collects terminal information and can perform terminal 
functions. 
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TermMon ActiveX Module Parameters 

Normally the TermMon ActiveX, when registered on a terminal server, allows a terminal server session to 
communicate with its terminal and act upon it without the need of the TermMon ActiveX module. The 
TermMon ActiveX module can be added to the terminal configuration to either deny the default terminal 
server to terminal access or to allow access to other sessions and PCs. 

• Allow ActiveX Connections - This value, when set to Yes, will allow the ActiveX control to function. 
Setting this value to No will prevent any ActiveX communication to the terminal, including the default 
terminal server to terminal access. 

• Only Allow Connections from Session - This value, when set to Yes, will allow other terminal 
server sessions and PCs to communicate to the terminal with the ActiveX functions. If set to No, the only 
communication allowed is between the terminal and a session on the terminal server belonging to the 
terminal, providing that the Allow ActiveX Connections is set to Yes.  

See TermMon ActiveX Control for details. 

USB Flash Drive Module 
The USB Flash Drive Module can be used to allow USB flash drives to be used as TermSecure ID devices. It 
is also listed under Local Storage modules. 

See USB Flash Drive Module in the Local Storage Modules for details. 

Wavetrend Tag Reader 
The Wavetrend Tag Reader Module allows a terminal to use Wavetrend RFID cards as TermSecure ID 
cards. This allows a user to login through TermSecure when they approach the terminal and logs them out 
when they leave the area. The distance required to login and log out are configurable in the module. 
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Wavetrend Tag Reader Module Parameters 

The parameters are: 

Port - The WaveTrend Tag Reader Module connects to a ThinManager Ready thin client through the serial 
port. The Port setting specifies which COM Port the reader is attached to. 

Use Vendor Code - This, if set to YES, includes the vendor code as part of the identifier number.  

Allow Manual Login - If set to YES, this allows a TermSecure User to use the hotkey to initiate logins, or the 
device. If set to NO, it will force a TermSecure User to use a device to login. 

Prompt for Password - NO allows the device to login without a password. YES forces every TermSecure 
User to enter a password after using the device. 

Entry Signal Strength - The signal strength required to register the card as in range. 

Exit Signal Strength - The signal strength required to register the card as out of range. 

Entry Sensitivity - The number of reads above the Entry Signal Strength reads that are required to register 
as “Entered”. 

Exit Sensitivity - The number of reads below the Exit Signal Strength that are required to register as “Exited”. 

See WaveTrend Tag Reader Module for details. 

Touch Screen Modules   
• Arista ARP-16XXXAP-ACP Touch Screen Driver 

• CarrollTouch Touch Screen Driver 

• Contec Touch Screen Driver 

• DMC Touch Screen Driver 
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• Dynapro Touch Screen Driver 

• Elographics Touch Screen Driver 

• Gunze AHL Touch Screen Driver 

• MicroTouch Touch Screen Driver 

• PenMount Touch Screen Driver 

• Ronics Touch Screen Driver  

• Touch Control Touch Screen Driver 

• Touch International IR Touch Screen Driver 

• Xycom 33XX Touch Screen Driver 

 
Touch Screen Parameters 

Some, but not all, touch screen modules have parameters that can be modified. These may include: 
• Connection Type - Whether the touch screen uses Serial or USB to connect. 

• Port (Serial Only) - The serial port that the touch screen is connected to. 

• Monitor Number – Used to specify which monitor in a MultiMonitor scheme will use the touch 
screen. 

• Controller Type - Model of touch screen controller. 

• COM Port - The serial port that the touch screen is connected to. 

• Baud Rate - The speed used for communication between the terminal and the touch screen. 

• Double Touch Area - The size of the area that a second touch will register as a double touch. 

• Double Touch Time - The amount of time between touches that qualifies as a double touch. 
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• Touch De-Bounce Timeout - a time interval used to prevent a single touch from being registered as 
multiple touches. 

• Calibration (entered automatically) - Set automatically by machine. These are the calibration 
values. 

• Orientation (entered automatically) - Set automatically by machine. Used at the direction of Tech 
Support in error correction. 

• Swap XY Coordinates – If X and Y are reversed, this setting will correct the orientation. 

• Calibration Hotkey – This allows a function key to be set as a hotkey so that the calibration can be 
launched from a keyboard.  

• Calibration Hotkey Modifier– This setting adds CTL or ALT to the hotkey to launch the calibration 
from the keyboard, if desired. 

• Calibration Touch Down Time (seconds) – This setting, when enabled, will launch the calibration 
program when the screen is touched for the assigned number of seconds. 

• Number of Calibration Points – This sets the number of calibration points that the calibration 
program uses during the calibration process. 

• Calibration Margin Percentage – This sets the distance from the edge of the screen that the 
calibration points are displayed. 

Video Driver 
The method of downloading video drivers was changed in ThinManager 3.0. In previous versions all of the 
video drivers were contained in the firmware and were downloaded at boot. In v3.0 the video was split out of 
the firmware and each thin client will only download the video driver that it needs. 

In ThinManager 3.1, like 3.0, one does not need to add the video module to the terminal but only needs to 
have the video module installed in ThinManager to make it available. As each terminal connects to 
ThinManager it will download the correct module.  

These modules are normally installed with ThinManager 3.1. See Installing a Module to see how to update or 
add new modules. 

The current video driver list includes: 
• AMD Geode Video Driver 

• Core Video Driver 

• Geode Video Driver 

• Intel i8XX Video Driver 

• Intel i8XX//i9XX Video Driver 

• Legacy Video Driver 

• MultiMonitor Video Driver 

• S3 Savage Video Driver 

• VIA CLE266 Video Driver 

Note: Users with ThinManager 2.6 and earlier may need to add the individual video module to the terminal if 
using certain models of ThinManager Ready thin clients. This doesn’t apply to ThinManager 3.0 and 
later. 
See http://www.thinmanager.com/support/downloads.shtml for details. 
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Multiple Monitors 

Introduction to Multiple Monitors 
ACP ThinManager has two methods of providing multiple monitors in a thin client system - the Share 
Keyboard and Mouse method and the MultiMonitor method. 

The Share Keyboard and Mouse module allows several ThinManager Ready thin clients, each with a single 
video port, to be controlled with a single keyboard and mouse without the need of a KVM switch 
(Keyboard/Video/Mouse). The Share Keyboard and Mouse system ties several desktops together with a 
common mouse and keyboard so that the user has increased real estate under their control. Because each 
screen is still an independent desktop, programs don't need to be rewritten in a new resolution for a larger 
desktop. Instead, one would run the normal sized application on each of the desktops, allowing the operator 
to view different windows on different monitors. 

See Share Keyboard and Mouse Modules for details on deployment. 

The MultiMonitor method uses specific ThinManager Ready thin clients that have multiple video ports built 
into the hardware. Each MultiMonitor thin client can have from two to five monitors attached. These monitors 
can be configured to merge into an expanded desktop (called “spanned” by ACP) or can display individual 
desktops (called “screened”  by ACP), or combinations of “spanned” and “screened” sessions. 

See MultiMonitor for details on deployment. 

Share Keyboard and Mouse Modules 
The Share Keyboard and Mouse module allows several ThinManager Ready thin clients to be controlled 
with a single keyboard and mouse without the need of a KVM switch (Keyboard/Video/Mouse). 

The Share Keyboard and Mouse has a Master module that is added to the controlling terminal, and a Slave 
module that is added to the dependent terminals. 
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Shared Keyboard and Mouse Layout 

The Share Keyboard and Mouse can be used by placing several monitors connected to ThinManager Ready 
thin clients side-by-side or top-to-bottom. The Share Keyboard and Mouse Master module is loaded on the 
center thin client. This module is configured by adding the IP addresses of the secondary slave thin clients. 
The other terminals receive the Share Keyboard and Mouse Slave module. 

 

Share Keyboard and Mouse Master Module 

Once the Share Keyboard and Mouse Master Module is added to a terminal, it can be configured by 
highlighting it in the Installed Module window and selecting the Configure button. 
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Share Keyboard and Mouse Master Module Properties 

• Left Terminal IP Address - Enter the correct IP address for the Slave terminal on the left of the 
master terminal, if used, and select the Set button. 

• Right Terminal IP Address - Enter the correct IP address for the Slave terminal on the right of the 
master terminal, if used, and select the Set button. 

• Top Terminal IP Address - Enter the correct IP address for the Slave terminal on the top of the 
master terminal, if used, and select the Set button. 

• Bottom Terminal IP Address - Enter the correct IP address for the Slave terminal on the bottom of 
the master terminal, if used, and select the Set button. 

• Allow Interactive Shadow of Master  - Normally a terminal with the master module loaded is 
blocked from interactive shadow. If you want to allow interactive shadowing on the master, highlight the 
Allow Interactive Shadow of Master parameter, select Yes from the Value drop-down, and select the 
Set button. 

The Share Keyboard and Mouse Slave module is loaded on the secondary thin clients using the same 
methods as other modules are loaded.  
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Share Keyboard and Mouse Slave Module Properties 

• Master IP Address  - This setting allows the slave module to be configured to connect to a specified 
master by entering the IP address of the master terminal, and selecting the Set button. 

Select the Done button when finished. 

Once the ACP Enabled thin clients are booted, the mouse on the master thin client can be moved seamlessly 
into the other desktops. The keyboard will be active in whatever screen the mouse pointer is on. 

This allows an operator to have control of several displays with only one keyboard and mouse. The mouse 
movement is seamless, allowing access to displays without switching. 

Note: A Master Share Keyboard and Mouse session cannot be interactively shadowed in ThinManager 
unless it is configured to allow it. 

The keyboards and mice for the slave thin clients can be left attached, but stowed away until a multi-user 
configuration is needed. 

The Share Keyboard and Mouse Master module is licensed for each master thin client. The Share 
Keyboard and Mouse Slave module is free. Each master module can have 1 to 4 slave units. Future 
releases will expand the number of slaves that the master can control. 
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MultiMonitor  
 

MultiMonitor is configured in the Terminal Configuration Wizard or the Group Configuration Wizard  

 

MultiMonitor – Terminal Hardware 

MultiMonitor configuration is initiated in the Terminal Configuration Wizard when a MultiMonitor-capable 
thin client is selected on the Terminal Hardware page. 

Select the Next button to continue. 
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MultiMonitor – Enable MultiMonitor 

MultiMonitor requires the use of Terminal Server Groups. Once the Use Terminal Server Groups checkbox 
is selected on the Terminal Server Specification page the Enable MultiMonitor checkbox becomes visible. 

Select the Use Terminal Server Groups and the Enable MultiMonitor checkboxes, and then select the 
Next button.  

Select the Next button to continue. 
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MultiMonitor – Video Settings 

The MultiMonitor Video Setting allows the user to choose how many monitors will be connected to the 
MultiMonitor thin client using the Number of Monitors radio button. 

The Color Depth dropdown allows the color depth to be set for all the monitors. 

The Resolution and Refresh Rate can be set for each monitor using the dropdowns. 
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MultiMonitor – Video Settings 

The monitors do not need to use the same resolutions but can be individually configured. 

Select the Next button to continue. 
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MultiMonitor – Monitor Layout 

The Monitor Layout page allows the configuration of the MultiMonitors. 

The Choose your monitor layout dropdown will display the various physical arrangements that the monitors 
can be placed in. Select the layout that matches your layout.  

                                

Sample Monitor Layouts 

The Main Monitor radio button determines which screen is considered the main monitor. This monitor will 
display the TermSecure login window, Main Menu, and ThinManager messages. 

The Choose your screen layout dropdown with allow the assignment of sessions to the monitors. The 
monitors can be combined into a “Spanned” session that contains two or more monitors or they can be 
configured to hold an individual session per monitor, called “Screened”, or a combination of the two. 
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Samples of Four-Monitor Configurations 

Note: The desktop of a spanned session is limited to 4096x2048. The selection of monitor resolution on the 
MultiMonitor Video Settings page can affect the number of monitors that you can add to a spanned 
session. 

The TermSecure Initial Screen radio button determines which screen is considered the main monitor for 
TermSecure. This monitor will display the TermSecure Main Menu window and messages. 

Select the Next button to continue. 
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MultiMonitor – Terminal Server Group Selection 

The Terminal Server Group Selection page allows Terminal Server Groups to be assigned to each monitor 
group. Highlight the desired group and select the arrow to move it to the desired screen. 
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MultiMonitor – Terminal Server Group Selection 

The number of available screens is based on the combination of screened and spanned sessions selected on 
the Monitor Layout page. 

Select the Next button to continue. 



 

ACP ThinManager 3.1 Help Manual Multiple Monitors  ••••  377 

 

MultiMonitor – Screen Options 

Terminals using MultiSession can be configured to allow sessions to be moved from monitor to monitor for 
user preference. This is configured by selecting the Allow groups to move to/from screen checkbox. If left 
unselected the sessions will stay in the assigned monitor. 

The Main Monitor drop-down determines which monitor will display the Terminal Server Group Selector 
menu. 
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MultiMonitor - Screen Options 

The Screen Options settings are: 
• Allow groups to move to/from screen – This checkbox, if selected, will allow a session from a 

MultiSession group to be moved to or from the monitor to suit a user’s preference. 

• Show Group Selector – This checkbox, if selected, will display the Terminal Server Group Selector 
to allow the user to switch between MultiSession groups. 

• Main Monitor – This drop-down sets what monitor in a spanned set will display the Terminal Server 
Group Selector menu. 

• Selector Options – This button launches the Group Selector Options window to allow configuration 
of the Terminal Server Group selector. 
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Group Selector Options Window 

The Group Selector Options is covered in Terminal Interface Options. 

Each Terminal Server Group that is to be moved needs to have this property configured in the Terminal 
Server Group configuration. 

 

Terminal Server Group Wizard – Group Option 

To configure a Terminal Server Group to be moved, open the Terminal Server Group Wizard for the group 
and navigate to the Group Options page. Select the Allow Group to be moved (MultiMonitor) checkbox 
and select the Finish button to accept the change. See Terminal Server Group List for details on the Terminal 
Server Group Wizard. 

Select the Next button to continue with the configuration as shown in Terminal Server Group – Group Options 
Page. 
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Reports 

New Feature 
ThinManager 3.1 introduces the ability to run reports to show and collect data on the ThinManager system. 
These reports can show the event log, configurations, uptimes, and other data. 

A Reports tab on the Details pane will show a report for a highlighted ThinManager Server, terminal, terminal 
group, terminal server, TermSecure user, or TermSecure user group. 

Reports can be scheduled to be run and saved as *.html files for storage or further analysis. 

Report Template Installation 
ThinManager 3.1 will install a number of reports into the ThinManager folder (C:\Program 
Files\Automation Control Products\ThinManager\ReportTemplates) during 
installation. 

Additional report templates can be downloaded from www.thinmanager.com/support/downloads.shtml as they 
become available. 

New reports are installed by selecting Install > Reports from the ThinManager menu. This launches the 
Reports window. 
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Reports Window 

Select the Install button to launch a file browser.  
• Report Templates – If this radio button is selected the file browser will browse for *.html files.  

• SQL Files – If this radio button is selected the file browser will browse for *.sql files. 

• Images, Finished Reports, etc. – If this radio button is selected the file browser will browse for 
assorted files. 

 

File Browser 

Each report has a *.html component and a *.sql component. Select the Report Templates radio 
button, browse to the new *.html file, and select Open to install. Select the SQL Files radio button, 
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browse to the new *.sql file and select Open to install. Once these two components are added the report 
will be available. 

Selecting Reports 
The reports are displayed on a Report tab in ThinManager. To select which report will be displayed on the 
Report tab select View > Reports from the ThinManager menu to launch the Select Reports window. 

 

Select Reports Window 

The Select Reports window has four fields that determine which report is displayed on the report tab. 
• System Report – This selects the report to display on the report tab when the ThinManager Server is 

highlighted. 

• Terminal Report – This selects the report to display on the report tab when a terminal or terminal 
group is highlighted. 

• Terminal Server Report – This select the report to display on the report tab when a terminal server 
is highlighted. 

• TermSecure User Report – This selects the report to display on the report tab when a TermSecure 
User or TermSecure User Group is highlighted. 

Use the drop-down list to select the desired report. 
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Report Tab 
The reports selected in the Select Reports window will be displayed on the Report tab in ThinManager. 

 

Report Tab 

Highlight the desired ThinManager Server, terminal, terminal group, terminal server, TermSecure user, or 
TermSecure group, then select the Report tab to display the report. 
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Print Report 
A Report can be printed by selecting the Report tab then selecting View > Print from the ThinManager menu. 
A Print window will be displayed to allow the selection of the printer. 

 

Print Window 

Highlight the desired printer and select the Print button to print the report. 
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Scheduling Reports 
Reports can be scheduled to be run once at a specified time or to be run regularly at a specific time. The 
reports are saved as *.html files for storage or further analysis. 

To schedule report generation open the ThinManager Server Configuration Wizard by highlighting the 
ThinManager Server and selecting File > Modify. 

 

ThinManager Server Configuration Wizard – System Schedule 

Navigate to the System Schedule page and select the Edit Schedule button to launch the Event Schedule 
window. 
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Event Schedule Window 

Select the Add button to open the Schedule window. 
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Schedule Window 

The Schedule window allows system events to be configured. 
•  Event Type – This drop-down allows the event to be chosen. There are two types: 

• Backup Configuration Database – This allows a scheduling of automatic configuration 
backups. 

• Run Report – This allows a report to be run and saved as a *.html file on a regular basis. 

• Report Template File - This drop-down allows the selection of the report to run. 

• Report Output File – This applies the naming convention to the saved reports. 

• Auto Generate Filename – This checkbox, if selected, will save the file to the ThinManager 
folder with the report name and a time stamp as its title.    

• If the Auto Generate Filename is unselected, the field allows entry of the desired filename. 
The filename needs to end in .html. 

There are a few switches that allow the file name to be modified with a timestamp for 
identification purposes. If you do not use a timestamp, the file will be overwritten each time 
the report is run. 
• %c – Adds date and time 
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• %h – adds hour (0-24) 

• %M – adds minute (0-59) 

• %x – adds date 

• %X – adds time 

• Repeat Interval – These radio buttons allow the frequency of the report generation to be set. 

• Time – The fields to set the time of the report generation changes to match the Report Interval 
selected by the radio button. The Time field may allow dates, days, hours, or intervals to be set 
for the report. 

Once the report is configured, select OK to accept the report schedule. 

 

Event Schedule 

The scheduled report will be displayed in the Event Schedule window. 
• Select Add to add another report schedule. 

• Select Edit to edit the schedule of a highlighted report.  

• Select Delete to delete the schedule of a highlighted report.  

• Select OK to accept the schedules and close the window. 

When a report is run the files are saved for viewing. 
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Saved Reports 

Once the report has run it can be opened in a web browser. 
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Report Shown in Internet Explorer 

Once the report is generated the data can be saved or reformatted as desired using standard HTML tools. 
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Changing the Report Logo 
Each report template has a ThinManager TM3 logo as part of the report header. This can be changed to your 
company logo. 

1. Create a copy of the desired logo in *.jpg format with a size of 150x50 pixels. A white 
background is helpful if the logo is irregularly shaped. 

2. Name the file logo150x50.jpg. 

3. Copy the logo150x50.jpg into the ThinManager folder ( C:\Program 
Files\Automation Control Products\ThinManager\Reports by default). 

4. Open the report to see the change. 

 

Report with New Company Logo 

The new logo will be displayed on all reports. 
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Shadowing  

Shadowing of a ThinManager Ready terminal can be initiated from within ThinManager by using the new 
Shadow tab in the Detail pane of ThinManager. To shadow, highlight the desired terminal in the 
ThinManager tree and select the Shadow tab. 

 

Shadow – Shadow Scaled to Window 

The shadowed terminal can be viewed full-sized or scaled to fit in the Details pane. Select RemoteView > 
Shadow scaled to Window to scale the session and unselect the option to view it life sized. 
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Shadow Access 
Access to the shadow function is controlled by membership in ThinManager User Groups. See ThinManager 
Security Groups for details. 

• ThinManager Administrators and Administrators can shadow terminals and interactively control 
the terminal session. 

• ThinManager Power Users can shadow terminals from within ThinManager but cannot interact with 
the session. They are in View-only mode. 

• ThinManager Interactive Shadow Users can shadow terminals from within ThinManager and can 
interact with the session. 

• ThinManager Shadow Users can shadow terminals from within ThinManager but cannot interact 
with the session. They are in View-only mode. 

• ThinManager Users cannot shadow a terminal. 

RemoteView > Interactive Shadow on the menu bar prevents the interaction with the shadowed session if 
unselected. 
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Configure Shadowing 
Shadowing can be configured on the Terminal Options page of the Terminal Configuration Wizard or 
Terminal Group Configuration Wizard. 

 
Terminal Configuration Wizard - Shadow Configuration 

The Allow terminal to be shadowed drop-down box allows the configuration of Shadowing Options. 
• No - Prevents members of the Group from being shadowed. 

• Ask - Will display a message window that will prompt for a positive response before the shadowing is 
allowed. 

• Warn - Will display a message window alerting the terminal that it is to be shadowed, but doesn’t 
require a positive response before the shadowing is allowed. 

• Yes - Allows shadowing to occur without warning or recipient input. 

Allow Interactive Shadow will allow members with Interactive Shadow privileges to shadow the terminal. 
The Interactive Shadow privileges are configured in the ThinManager Server Configuration Wizard. See 
ThinManager Server Configuration Wizard or ThinManager Security Groups for details. 

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. Unselecting 
the Allow Interactive Shadow checkbox will prevent shadowing from within ThinManager.  
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Shadow Keystrokes 
Because the CTL+ALT+DEL and the CTL+ESC keystrokes can’t be sent to the local machine to the 
shadowed ThinManager Ready thin client, there is a menu item to send these commands. Select 
RemoteView > Send Key > Send Ctl+Alt+Del or RemoteView > Send Key > Send Ctl+Esc to send these 
commands. 

Note: The Key Block Module will block these commands from being sent to a shadowed session. 

Changing the tab or selecting another tree icon will break the shadow connection. 
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ThinManager Security 

ThinManager Security Groups 
Access to ThinManager can be assigned to Windows User Groups on the ThinManager Security Groups 
page. 

 

ThinManager Security Groups 

ThinManager allows different levels of access and functionality based on standard Windows groups.  
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Standard Windows Groups can be created in the Computer Management console and given different 
privileges in ThinManager. 

ThinManager 3.1 comes with privileges pre-defined for six groups: 
• Administrators - The Microsoft defined Administrator group is given all privileges by default in 

ThinManager. This may be denied by unselecting the various Windows User Group Permissions. 

• ThinManager Administrators have full permission to do anything within ThinManager including the 
power to logoff sessions, kill processes, send messages, restart terminals, calibrate touch 
screens, change terminal configurations, update firmware, update the TermCap, and restore 
configurations. Administrators and members of ThinManager Administrators can shadow 
terminals and interactively control the terminal session. These privileges may not be removed. 

• ThinManager Interactive Shadow Users - Members of this group may shadow a terminal 
interactively. 

• ThinManager Power Users can logoff sessions, kill processes, send messages, restart terminals, 
and calibrate touch screens. They cannot change terminal configurations, update firmware, 
update the TermCap, and restore configurations. ThinManager Power Users can shadow 
terminals from within ThinManager but cannot interact with the session. 

• ThinManager Shadow Users - Members of this group may shadow a terminal, but not interactively. 

• ThinManager Users can view only. They cannot logoff sessions, kill processes, send messages, 
restart terminals, or calibrate touch screens. ThinManager Users cannot shadow a terminal. 

Additional Windows User Groups can be configured by selecting the Add Group button to launch the New 
Windows Group window. 

 

New Window User Group Window 

Adding a Windows Group name in the field of the New Window Group window and selecting the OK button 
will add the Windows User Group to the drop-down list. 
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New ThinManager Security Group 

Select the group from the Windows Users Group drop-down. 

Choose the permissions you want to grant to the group by selecting and unselecting the Windows Users 
Group Permissions checkboxes. 

Members of the Windows User Group will have the selected permissions the next time they login. 

Note: Although ThinManager has Windows User Groups pre-configured with privileges, these groups have 
not been created on the terminal servers. 

To Create A Windows User Group Open the Computer Management Console by selecting Start > Settings 
> Control Panel > Administrative Tools > Computer Management. 
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Created ThinManager Security Groups 

Highlight Groups in the tree and select Action > New Group. 

Name the group and select the Create button.  

Add Users to the Windows User Group. 

Members of the Windows User Group will have the selected permissions the next time they login. 

If groups are not created, members of the standard Windows Administrator group have full privileges in 
ThinManager while members of the standard Windows User group will be denied access. 

Note: The thinserver service will need to be stopped and restarted and the users will need to re-login for the 
changes to take effect. 

ThinManager Server Security  
ThinManager has a number of security settings for the ThinManager Server. Open the ThinManager Server 
Configuration Wizard by right clicking on the ThinManager Server in the tree and selecting Modify, or 
highlight the ThinManager Server and select Edit > Modify from the menu. 
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ThinManager Server Configuration Wizard 

The second page of the wizard has two settings related to security: 
• Allow unknown terminals to connect - This, when unchecked, will prevent any new terminals 
connecting to the system. 

• Require passwords on unknown terminals -  This checkbox, if checked, allows new terminals to 
be added, but only if the installer has the password. 
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Terminal Replacement 

On the Terminal Replacement page of the ThinManager Server Configuration Wizard is the Enable 
replacement checkbox. This allows failed terminals to be replaced. If this is unchecked, terminals can still be 
added, but only by using the Create New Terminal process. 

This is a global setting that affects all terminals connected to this ThinManager Server. The Enable 
replacement checkbox is also found on the Terminal Configuration Wizard of each terminal and the 
Terminal Group Configuration Wizard of each Terminal Group so that the setting can be applied to 
individual terminals and Terminal Groups. 

Windows Security 
The ACP ThinManager system delivers a Windows 2000/2003 desktop to each thin client by default. Each 
thin client has full access to the server resources, as if it is the server. However, just because the thin client 
has the ability to have full access to the server resources doesn’t mean that the user should be granted full 
access to the server. To prevent unauthorized changes to the server, it is recommended that each user profile 
have security policies applied through the System Policy Editor to limit access to the needed functions. 
Windows 2000/2003 Security procedures are discussed in the Windows on-line help and in many books and 
articles. 

Administrators usually require that each user login to a terminal with their personal account and have the 
Microsoft policy determine the user’s access rights. 
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Note: Task Manager has a feature that allows the launching of applications. If using an Initial Application, 
access to Task Manager should be denied in the security policy or with the Key Block Module to prevent a 
user from launching unauthorized programs. 
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TermSecure 

 

TermSecure Overview 
TermSecure is a new ThinManager feature that allows users to logon to a ThinManager Ready thin client and 
access user-specific or terminal-specific Terminal Server Groups. This does not replace the Windows logon, 
but adds an additional layer of security and control. Terminals and Terminal Server Groups can be assigned 
TermSecure Access Group permissions. A TermSecure User can use those terminals and Terminal Server 
Groups only if the TermSecure User has been assigned to the same Access Group. 

TermSecure has two main attributes: 
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���� allows a user to leave one terminal, logon to a different 
terminal, and reconnect to their session, essentially having the session follow him from terminal to terminal. 

Although TermSecure has these two attributes, SecureAccess and SmartContext are not discussed as 
products, features, or items, but are invisible components of TermSecure. 

Note: TermSecure requires the usage of Terminal Server Groups instead of using individual terminal servers.  

 

Users 
There are three types of users in a ThinManager system. Windows Users and TermSecure Users are 
important to TermSecure. 

Windows Users 
Windows Users are the Microsoft accounts created in Windows that allow access to the Windows terminal 
servers. These are configured within Windows and authenticated by Windows. They can be given varying 
levels of access and power using Windows User Groups and Group Policies. 
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TermSecure Users 
TermSecure Users are users who can go to a ThinManager Ready thin client and receive access to specific 
Terminal Server Groups due to their membership in a TermSecure Access Group. The login and 
authentication is done by ThinManager a level above the Windows login.  

TermSecure grants and limits access to terminals and Terminal Server Groups but a Windows User login is 
still required to actually logon to the terminal server. 

ThinManager Security Group Users 
ThinManager Security Group Users are Windows User Group members who have been configured in the 
ThinManager Server Configuration Wizard to have varying levels of access and control within the 
ThinManager program. 

These groups are configured on the ThinManager Security Groups page of the ThinManager Server 
Configuration wizard. See ThinManager Security Groups for details. 

Deploying TermSecure 
TermSecure requires a number of steps to configure and deploy TermSecure: 

1. TermSecure Access Groups can to be created. 
See Creating Permissions Groups for details. 

2. Terminals can be assigned TermSecure Access Groups to limit access to specific users.  
See Permission Groups for Terminals for details. 

3. Terminal Server Groups can be assigned TermSecure Access Groups to limit access to specific 
users.  
See Permission Groups for Terminal Server Groups for details. 

4. TermSecure Users need to be created and assigned to TermSecure Access Groups, if desired.  
See TermSecure User Configuration Wizard for details. 

5. A Login strategy needs to be put in place. The TermSecure User can use the Terminal Login, their 
TermSecure login, or a Windows login to access the terminal servers.  
See Windows Login Information for details. 

6. USB drives and ProxCards, if used, need to have the identification number entered in their 
configuration.  
See Card/Badge Information for details. 

7. The TermSecure User can then login to a ThinManager Ready thin client using TermSecure  
TermSecure prompts the TermSecure User to login to the terminal servers using a Windows User 
account, or it will pass the pre-configured Windows User account information to the terminal server 
for auto-login, based on the login strategy selected.  

8. The TermSecure User is granted access to all Terminal Server Groups that share the same 
TermSecure Access as the TermSecure User, and is denied access to Terminal Server Groups that 
they don’t share a TermSecure Access Group membership.  

TermSecure User Configuration Wizard 
ThinManager 3.0 introduces a new function of TermSecure User configuration for use with TermSecure. A 
TermSecure User can be configured with a user name, password, and additional Terminal Server Groups. 
When the user logs into a terminal with that identity, TermSecure will allow the user access to the 
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personalized Terminal Server Groups for that user in addition to the Terminal Server Groups already 
assigned to the terminal. 

Note: The TermSecure Users branch of the ThinManager tree will not be visible unless a valid TermSecure 
license is installed on the ThinManager Server. 

The TermSecure User Configuration Wizard is launched by right clicking on the TermSecure Users branch 
of the ThinManager tree and select Add TermSecure User.  

TermSecure User Information 

 

ThinManager User Information 

The TermSecure User Information has fields for the user name and password that will be used by the 
TermSecure User to log into ThinManager security to access TermSecure functions.  

The TermSecure User Information is for account information: 
• User Name - Enter the user name that the user will use to log into the TermSecure system. Although 

this can be the same as the Windows user name, the TermSecure user name is independent of the 

Microsoft Windows login. This TermSecure user name can be tied to a Windows login later in the 

wizard on the Windows Login Page.  
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• Password - Enter the password for the TermSecure User in this field. 

• Verify Password - Re- enter the password for the ThinManager User in this field.  

• The Password Options button launches the Password Maintenance Options window that 

regulates rules for the ThinManager User password. 

 

Password Maintenance Options 

Password Complexity Requirements: 

• Minimum Password Length - Sets the amount of characters that the password must contain to be 
valid. 

• Must contain numbers - This checkbox, if checked, will require that the password contain at least 
one number in it. 

• Must contain symbols - This checkbox, if checked, will require that the password contain at least 
one symbol in it. 

• Must contain capital letters - This checkbox, if checked, will require that the password contain at 
least one capital letter in it. 

Password Maintenance: 

• Allow User to change password - This checkbox, if checked, will allow the user to change the 
password at the TermSecure menu. 

• Force User to change password at next login - This checkbox, if checked, will require the user to 
change the password at the TermSecure menu when they login the next time. 

• Force User to change password periodically - This checkbox, if checked, will require the user to 
change the password at the TermSecure menu on the schedule set by the User must change 
password every X days field. 
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• User must change password every X days - This field sets the time period between the scheduled 
password changes caused by the Force User to change password periodically checkbox. 

The OK button closes the window with any changes. The Cancel button closes the window without changes. 

Group: 

• The Change Group button opens the Choose User Group window that allows a User to be placed 
in an existing TermSecure Users Group. 

 

Choose User Group 

If TermSecure User Groups have been created, the Choose User Group window will display the 
TermSecure User Group branch of the ThinManager tree. 

o To add the TermSecure User to a TermSecure Users Group, highlight the desired 
TermSecure Users Group and select the OK button. 

o To change the TermSecure User to a different TermSecure Users Group, highlight the 
desired TermSecure Users Group and select the OK button. 

o To remove the TermSecure User from all TermSecure Users Groups, highlight the top-level 
Users branch and select the OK button. 

The OK button closes the window with any changes. The Cancel button closes the window without changes. 

Copy Settings: 

• The Copy Settings from another User checkbox, if selected, activates the Copy From button that 
allows the configuration of an existing TermSecure User to be applied to the current TermSecure 
User. 

• The Copy From button opens the Select User window that allows the selection of the desired 
TermSecure User configuration. 
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Select User Window 

The Select User window will show a tree with the existing TermSecure User Groups and the TermSecure 
Users.  

Highlight the TermSecure User whose configuration you want to copy and select the OK button. The OK 
button closes the window with any changes. The Cancel button closes the window without changes. 
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Card / Badge Information 

 

Card / Badge Information Page 

The Card / Badge Information Page enables the use of Identification devices such as USB flash drives, HID 
ProxCards, and WaveTrend Radio Frequency IDs (RFIDs) as login devices. This will be covered later. See 
Card and Badge Configuration for a TermSecure User for details 

Note: Terminals using the USB flash drives, HID ProxCards, and WaveTrend RFIDs as login devices will 
need the appropriate module added. See TermSecure Modules for details. 

Select the Next button to continue with the configuration. 
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Terminal Server Group Selection 

 

Terminal Server Group Selection 

The Terminal Server Group Selection page allows Terminal Server Groups to be assigned to the 
TermSecure User. When the TermSecure User logs onto a terminal, these Terminal Server Groups will be 
available on the terminal for him. 

• Add User specific Terminal Server Groups? - This setting, if set to Yes, will allow the selection of 
Terminal Server Groups for the TermSecure User that will be added to the terminal when the 
TermSecure User logs in top the terminal. Selecting Yes will display the Enable MultiSession 
checkbox. 

• Enable MultiSession - This checkbox, if selected, will allow the TermSecure User to run more than 
one Terminal Server Group at a time.  

Select the Next button to continue with the configuration. 
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Terminal Server Group Specification 

 

Terminal Server Group Specification Page 

The Terminal Server Group Specification page allows Terminal Server Groups to be assigned to the 
TermSecure User if the Add User specific Terminal Server Groups? radio button is set to Yes. 

Move a Terminal Server Group you want the TermSecure User to use into the Selected Terminal Server 
Groups list by double-clicking on it in the Available Terminal Server Groups list or by highlighting it and 
clicking the Right Arrow button. 

To add a new Terminal Server Group, select the Edit Server Groups button to launch the Terminal Server 
Group Wizard. See Terminal Server Group List for details. 

Select the Next button to continue with the configuration. 
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Windows Login Information 

 

Windows Login Information 

The Windows Log In Information page allows the configuration of how the TermSecure User will log on to 
the Windows terminal servers. 

There are several Windows login options for the TermSecure User. 

1. The TermSecure User can use the terminal’s username and password to auto-log on to the terminal 
server. To do this, check the Use Terminal Configuration Login Information checkbox 

2. The TermSecure User can use the TermSecure User username and password to auto-log on to the 
terminal server. To do this, check the Same as TermSecure User username/password checkbox. 
The TermSecure User username and password must match a Windows User username and 
password to get authenticated by Windows. 

3. The TermSecure User can use a separate username and password to auto-log on to the terminal 
server. To do this, use the fields for the Username, Password, and Domain that are provided. 

4. The TermSecure User can be required to manually log onto the terminal servers. To do this, leave the 
checkboxes unchecked and the Username, Password, and Domain empty. 

Select the Next button to continue with the configuration. 
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Terminal Interface Options 

 

Terminal Interface Options 

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User because a 
terminal using MultiSession will need to have a method to switch between sessions.  

Group Selector Options allow on-screen switching of sessions. 

• Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the 
hotkeys that were configured for use with the terminal. 

• Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down 
menu that can be activated by mouse.  

• Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 

• Selector Options - This button, if selected, will launch the Group Selector Options window. 
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Group Selector Options Window 

• Auto-hide Group Selector - This checkbox, if selected, will hide the on-screen group selector until 
the mouse is moved over its location. The OK button closes the window with any changes. The 
Cancel button closes the window without changes. 

Terminal Hotkeys allows the selection of keyboard combinations that allow switching between sessions. 

• Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the 
hotkeys that were configured for use with the terminal. 

• Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between 
the two active sessions of a Terminal Server Group that is using Instant Failover. 

• Change Hotkeys - This button, if selected, will launch the Select Hotkeys window for Instant 
Failover. 

 

Select Hotkeys Window for Instant Failover 

The hotkey combination for switching between Instant Failover sessions can be changed by selecting the Alt 
Key radio button or by selecting a different function key from the dropdown. The OK button closes the window 
with any changes. The Cancel button closes the window without changes. 

• Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between different 
sessions of a terminal using MultiSession. 

• Change Hotkeys - This button, if selected, will launch the Select Hotkeys window for the Group 
Selector. 
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Select Hotkeys for the Group Selector 

The hotkey combination for switching between Terminal Server Group sessions can be changed by selecting 
the Alt Key radio button or by selecting a different function key from the dropdown. The OK button closes the 
window with any changes. The Cancel button closes the window without changes. 

Main Menu Options allow switching between sessions. 

• Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the 
hotkeys that were configured for use with the terminal. 

• Enable Main Menu Hot Key - This checkbox will be displayed if TermSecure is being used and will 
allow the TermSecure menu to be shown with a hot key, if selected. 

• Main Menu Options - This button, if selected, will launch the Main Menu Options window to 
configure the TermSecure Main Menu options. 

 

Main Menu Options 

The Allow reboot/restart checkbox, if selected, will place a Shut Down button on the Main Menu that leads to 
a Reboot/Restart menu to reboot or restart the terminal. The OK button closes the window with any changes. 
The Cancel button closes the window without changes. 

Note: If the Main Menu Options window is launched from the Terminal Configuration Wizard for a terminal 
using TermSecure, a checkbox is displayed that enables a virtual keyboard. 
See Main Menu Configuration – Terminal Configuration Wizard for details. 

 

Note: It is possible to unselect the Show Group Selector on Terminal, Enable Group Hotkeys, and the 
Enable Main Menu Hot Key checkboxes, making it impossible to login a TermSecure User manually. 
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While the manual lockout might normally be undesirable, it might be desired if one is using the USB of 
ProxCard badge login to limit logons to badge holders. 

Select the Next button to continue with the TermSecure User Configuration wizard. 

User Options 

 

User Options 

Log In / Log Out Options 

• Inactivity Timeout - TermSecure will log a TermSecure Users off the terminal after this much 
inactive time has passed.  

• Reset Sessions at Logout - This checkbox, if selected, will logoff a session when the TermSecure 
User logs off. 

• Activate User Group at Log In - This checkbox, if selected, will display the TermSecure User’s first 
Terminal Server Group when the user logs in to the terminal. 

User Schedule 

• Set Schedule - 

Selecting the Schedule button on the User Options page will launch the Event Schedule window and allow 
a schedule to be created for terminal events. 

See Terminal Schedule for details. 
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Terminal Effects 

• Enable Terminal Effects - This allows the use of Terminal Effects. This currently includes sliding 
Windows and message rollups. 

Shadowing 

• Allow terminal to be shadowed - This drop-down box allows the configuration of Shadowing 
Options. 

o No - Prevents the TermSecure Users from being shadowed. 

o Ask - Will display a message window that will prompt for a positive response before the 
shadowing is allowed. 

o Warn - Will display a message window alerting the terminal that it is to be shadowed, but 
doesn’t require a positive response before the shadowing is allowed. 

o Yes - Allows shadowing to occur without warning or recipient input. 

• Allow Interactive Shadow - This checkbox, if selected, will allow members with Interactive Shadow 
privileges to shadow this TermSecure User. 

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. Unselecting 
this will prevent shadowing from within ThinManager. 

Select Finish to finish the configuration. 

TermSecure Users Group Configuration Wizard 
TermSecure Users can be organized into TermSecure User Groups, just as Terminals can be organized into 
Terminal Groups. This Section will show the configuration of a TermSecure User Group. 

The TermSecure Users Group Configuration Wizard can be launched by right clicking on the TermSecure 
Users branch of the tree and selecting Add TermSecure User Group.  
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TermSecure User Group Information 

  

ThinManager User Information 

The TermSecure User Group Information has fields for the group name and membership.  

• User Name - This field names the TermSecure User Group. 

• Password - This field is unused since each TermSecure User will login as a separate entity. 

• Verify Password This field is unused.  

• Password Options - This button launches the Password Maintenance Options window that 
regulates rules for the ThinManager User password. 

• Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 
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Password Maintenance Options 

Password Complexity Requirements: 

• Minimum Password Length - Sets the amount of characters that the password must contain to be 
valid. 

• Must contain numbers - This checkbox, if checked, will require that the password contain at least 
one number in it. 

• Must contain symbols - This checkbox, if checked, will require that the password contain at least 
one symbol in it. 

• Must contain capital letters - This checkbox, if checked, will require that the password contain at 
least one capital letter in it. 

Password Maintenance: 

• Allow User to change password - This checkbox, if checked, will allow the user to change the 
password at the TermSecure menu. 

• Force User to change password at next login - This checkbox, if checked, will require the user to 
change the password at the TermSecure menu when they login the next time. 

• Force User to change password periodically - This checkbox, if checked, will require the user to 
change the password at the TermSecure menu on the schedule set by the User must change 
password every X days field. 

• User must change password every X days - This field sets the time period between the scheduled 
password changes caused by the Force User to change password periodically checkbox. 

The OK button closes the window with any changes. The Cancel button closes the window without changes. 

Group: 

• The Change Group button opens the Choose User Group window that allows a TermSecure Users 
Group to be placed in an existing TermSecure Users Group. 
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Choose User Group 

If TermSecure User Groups have been created, the Choose User Group window will display the 
TermSecure User Group branch of the ThinManager tree. 

o To add the TermSecure User Group to another TermSecure Users Group, highlight the 
desired TermSecure Users Group and select the OK button. 

o To move the TermSecure User Group to a different TermSecure Users Group, highlight the 
desired TermSecure Users Group and select the OK button. 

o To remove the TermSecure User Group from all TermSecure Users Groups, highlight the 
top-level Users branch and select the OK button. 

The OK button closes the window with any changes. The Cancel button closes the window without changes. 

Select Next to continue. 
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TermSecure Group - Terminal Server Group Selection 

 

Terminal Server Group Selection 

The Terminal Server Group Selection page allows Terminal Server Groups to be assigned to the TermSecure 
User. When the TermSecure User logs onto a terminal, These Terminal Server Groups will be available on 
the terminal for him. 

• Add User specific Terminal Server Groups? - This setting, if set to Yes, will allow the selection of 
Terminal Server Groups for the TermSecure User that will be added to the terminal when the 
TermSecure User logs in top the terminal. 

• Enable MultiSession - This checkbox, if selected, will allow the TermSecure User to run more than 
one Terminal Server Group at a time. 

• Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 

Select the Next button to continue with the configuration. 
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TermSecure Group - Terminal Server Group Specification 

 

Terminal Server Group Specification Page 

The Terminal Server Group Specification page allows Terminal Server Groups to be assigned to the 
TermSecure User Group if the Add User specific Terminal Server Groups? radio button is set to Yes. 

Move the Terminal Server Groups you want the TermSecure User Group into the Selected Terminal Server 
Groups list by double-clicking on it in the Available Terminal Server Groups list or by highlighting it and 
clicking the Right Arrow button. 

To add a new Terminal Server Group, select the Edit Server Groups button to launch the Terminal Server 
Group Wizard. See Terminal Server Group List for details. 

Select the Next button to continue with the configuration. 
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TermSecure Group - Windows Login Information 

 

Windows Login Information 

The Windows Log In Information page allows the configuration of how the members of the TermSecure 
User Group will log on to the Windows terminal servers. 

There are several Windows login options for the TermSecure User Group. 

1. The members of the TermSecure User Group can use the terminal’s username and password to 
auto-log on to the terminal server. To do this, check the Use Terminal Configuration Login 
Information checkbox 

2. The members of the TermSecure User Group can use the TermSecure User username and 
password to auto-log on to the terminal server. To do this, check the Same as TermSecure User 
username/password checkbox. 

3. The members of the TermSecure User Group can use a separate username and password to auto-
log on to the terminal server. Because each user should logon with a unique user name and 
password, the Username, Password, Verify Password and Domain fields are inactive for the 
members of the TermSecure User Group. 

4. The TermSecure User can be required to manually log onto the terminal servers. To do this, leave the 
checkboxes unchecked and the Username, Password, and Domain empty. 

Select the Next button to continue with the configuration. 
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TermSecure Group - Terminal Interface Options 

 

Client Interface Options 

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User because a 
terminal using MultiSession will need to have a method to switch between sessions.  

Group Selector Options allow on-screen switching of sessions. 

• Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 

• Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the 
hotkeys that were configured for use with the terminal. 

• Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down 
menu that can be activated by mouse.  

• Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 

• Selector Options - This button, if selected, will launch the Group Selector Options window. 
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Group Selector Options Window 

• Auto-hide Group Selector - This checkbox, if selected, will hide the on-screen group selector until 
the mouse is moved over its location. The OK button closes the window with any changes. The 
Cancel button closes the window without changes. 

Terminal Hotkeys allows the selection of keyboard combinations that allow switching between sessions. 

• Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 

• Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the 
hotkeys that were configured for use with the terminal. 

• Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between 
the two active sessions of a Terminal Server Group that is using Instant Failover. 

• Change Hotkeys - This button, if selected, will launch the Select Hotkeys window for Instant 
Failover. 

 

Select Hotkeys Window for Instant Failover 

The hotkey combination for switching between Instant Failover sessions can be changed by selecting the Alt 
Key radio button or by selecting a different function key from the dropdown. The OK button closes the window 
with any changes. The Cancel button closes the window without changes. 

• Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between different 
sessions of a terminal using MultiSession. 

• Change Hotkeys - This button, if selected, will launch the Select Hotkeys window for the Group 
Selector. 
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Select Hotkeys for the Group Selector 

The hotkey combination for switching between Terminal Server Group sessions can be changed by selecting 
the Alt Key radio button or by selecting a different function key from the dropdown. The OK button closes the 
window with any changes. The Cancel button closes the window without changes. 

Main Menu Options allow switching between sessions. 

• Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 

• Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the 
hotkeys that were configured for use with the terminal. 

• Enable Main Menu Hot Key - This checkbox will be displayed if TermSecure is being used and will 
allow the TermSecure menu to be shown with a hot key, if selected. 

• Main Menu Options - This button, if selected, will launch the Main Menu Options window to 
configure the TermSecure Main Menu options. 

 

Main Menu Options 

The Allow reboot/restart checkbox, if selected, will place a Shut Down button on the Main Menu that leads to 
a Reboot/Restart menu to reboot or restart the terminal. The OK button closes the window with any changes. 
The Cancel button closes the window without changes. 

Note: If the Main Menu Options window is launched from the Terminal Configuration Wizard for a terminal 
using TermSecure, a checkbox is displayed that enables a virtual keyboard. 
See Main Menu Configuration – Terminal Configuration Wizard for details. 
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Note: It is possible to unselect the Show Group Selector on Terminal, Enable Group Hotkeys, and the 
Enable Main Menu Hot Key checkboxes, making it impossible to login a TermSecure User manually. 
While the manual lockout might normally be undesirable, it might be desired if one is using the USB of 
ProxCard badge login to limit logons to badge holders. 

Select the Next button to continue with the TermSecure User Group Configuration wizard. 

TermSecure Group - User Options 

 
User Group Options 

The User Group Options page has settings that configure several features. 

Log In / Log Out Options 

• Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 

•  Inactivity Timeout - TermSecure will log a member of the TermSecure Users Group off the terminal 
after this much inactive time has passed. Setting this to “0” will prevent it from logging off. 

• Reset Sessions at Logout - This checkbox, if selected, will logoff a session when the TermSecure 
User logs off. 

• Activate User Group at Log In - This checkbox, if selected, will display the TermSecure User’s first 
Terminal Server Group when the user logs in to the terminal. 

User Schedule 
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• Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 

• Set Schedule -Selecting the Schedule button will launch the Event Schedule window and allow a 
schedule to be created for terminal events. 

Terminal Effects 

• Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 

• Enable Terminal Effects - This enables terminal effects that currently include sliding windows and 
rollup message boxes. 

Shadowing 

• Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 

• Allow terminal to be shadowed - This drop-down box allows the configuration of Shadowing 
Options. 

o No - Prevents the TermSecure Users from being shadowed. 

o Ask - Will display a message window that will prompt for a positive response before the 
shadowing is allowed. 

o Warn - Will display a message window alerting the terminal that it is to be shadowed, but 
doesn’t require a positive response before the shadowing is allowed. 

o Yes - Allows shadowing to occur without warning or recipient input. 

• Allow Interactive Shadow - This checkbox, if selected, will allow members with Interactive Shadow 
privileges to shadow this TermSecure User. 

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. Unselecting 
this will prevent shadowing from within ThinManager 

Select Finish to complete the configuration. 
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Adding a TermSecure User to the TermSecure User 
Group 
To add a TermSecure User to a TermSecure User Group, create a new TermSecure User by right clicking on 
the TermSecure Users branch in the ThinManager tree and select the Add TermSecure User option. 

 

TermSecure User Information Page 

Enter a name for the TermSecure User in the User Name field. 

Select the Change Group button. 

This will launch the Choose User Group window. 
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Choose User Group Window 

Highlight your TermSecure Users Group and select OK. This will accept the changes and close the window. 
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TermSecure User Information Page 

The TermSecure User Group will now be displayed in the Group field. 

Select Next to continue. 
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Card/Badge Information 

The Card/Badge Information options are available because these are individual settings, not group settings. 

Select Next to continue. 
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Terminal Server Group Specification 

Each of the settings that have the Group Setting checkbox selected in the TermSecure User Group wizard 
will be grayed out because the Group Setting enforces the configuration of each chosen parameter. 

Select the Finish button to accept the configuration. 
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TermSecure Login 
To log in a TermSecure User on a terminal, go to a terminal that has the Enable TermSecure checkbox 
selected on the Terminal Server Specification page.  

Type CTL+m at the keyboard.  

The Main Menu will be displayed on the terminal. 

 
TermSecure Main Menu 

The About button to see details about the terminal. 

 

About Menu 

Select OK to close the About window. 

Select the Log In button to login. 

 

TermSecure Log On Screen 

Enter your TermSecure User user name in the Enter User Name field. 

Select OK. 
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Password Screen 

Enter the password in the field. 

Select the OK button. If the user name and password are correct, ThinManager will allow the login. 

ThinManager With TermSecure Log On 

Once a TermSecure User is logged into a terminal, ThinManager will display the TermSecure User’s name 
after the terminal name in the tree.  

ThinManager will add the name of the terminal after the TermSecure User name in the tree. 
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Right-clicking on a terminal and selecting Go to TermSecure User will move the focus to the TermSecure 
user that is logged into the terminal. 

Right-clicking on a TermSecure user and selecting Go to Terminal will move the focus to the terminal that 
the TermSecure user is logged into. 

Logging Out 
The TermSecure User can be logged out by: 

• Opening the TermSecure Main Menu (type CTL+m) on the terminal and selecting the Log Off 
button. 

• Right clicking on the TermSecure User in the ThinManager tree and selecting Logoff User. 

• Restarting or Rebooting the terminal that has a TermSecure User logged in. 

 
Main Menu 

The Switch User button will log off the TermSecure User and open the Login screen for another TermSecure 
User. The Log Off button will log of the TermSecure User and return to the terminal’s display. 

TermSecure Menu 
The TermSecure Menu that is displayed on a terminal that allows TermSecure Users to manually log on to a 
ThinManager Ready terminal is configurable for use with TermSecure. This menu is generated from the 
terminal and not the terminal server session.  

 

Basic TermSecure Menu 

The TermSecure Menu can be configured by a number of settings in the Terminal Configuration Wizard 
and TermSecure User Wizard. 

The Main Menu is activated on the Terminal Interface Options page of the Terminal Configuration Wizard 
and/or TermSecure User Configuration Wizard. 

Main Menu Configuration - Terminal Configuration Wizard 

Open the Terminal Configuration Wizard by double clicking on the desired terminal in the ThinManager 
tree. Terminals using Terminal Server Groups will display the Terminal Interface Options page. This page 
will display Main Menu options when TermSecure is enabled for the terminal. 
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Terminal Interface Options Page 

A terminal using MultiSession will need to have a method to switch between sessions. This is configured on 
the Terminal Interface Options page. For terminals using TermSecure, additional Main Menu options are 
available, as shown. See Terminal Interface Options for a terminal for a comparison. 

Group Selector Options allow on-screen switching of sessions. 

• Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down 
menu that can be activated by mouse.  

 

On-Screen Group Selector 

• Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 

• Selector Options button will launch the Group Selector Options window that allows configuration 
of the on-screen Group Selector. 
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Group Selector Options Window 

The Auto-hide Group Selector checkbox, if selected, will hide the Group Selector until the mouse is 
move to that space. 

The Group Selector Menu Size drop-down box allows the setting of the size of the Group Selector 
font.  

Terminal Hotkeys on the Terminal Interface Options page allows the selection of keyboard combinations 
that allow switching between sessions and launching the TermSecure Main Menu. 

• Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between 
the two active sessions of a Terminal Server Group that is using Instant Failover. 

• Change Hotkeys - This button allows the Instant Failover hotkey to be configured. 

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow 
the Instant Failover hotkeys to be changed from the default. 

 

Select Instant Failover Hotkeys  

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by 
selecting the Alt Key radio button or using the drop-down to select another function key. 

• Enable Group Hotkeys - This checkbox, if selected, allows the hotkey switching between different 
sessions of a terminal using MultiSession. 

• Change Hotkeys - This button allows the Group hotkey to be configured. 

Selecting the Change Hotkeys button when Enable Group Hotkeys is selected will allow the 
MultiSession Switching hotkeys to be changed from the default. 
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Select MultiSession Switching Hotkeys 

The default hotkey for MultiSession switching is set to Control+Page Up and Control+Page Down. 
This can be changed by selecting the Alt Key radio button or using the drop-down to select another 
hot key. 

• Enable Main Menu Hotkeys - This checkbox, if selected, allows the Main Menu to be launched with 
a hotkey combination. This terminal option is only configurable in the Terminal Configuration Wizard. 

 
Main Menu 

The Main Menu can be launched with the Ctrl+ m hotkey if the Enable Main Menu Hotkey checkbox 
is selected. 

• Change Hotkey - This button allows the Main Menu hotkey to be configured. 

Selecting the Change Hotkey button when Enable Main Menu Hotkey is selected will allow the 
TermSecure Main Menu hotkey to be changed from the default. 



 

442  ••••  TermSecure ACP ThinManager 3.1 Help Manual 

 

Enable Main Menu Hotkey 

The default hotkey for launching the Main Menu is Control+m. This can be changed by selecting the 
Alt Key radio button or using the drop-down to select another hotkey. 

Main Menu Options: 

• Show Main Menu on Group Selector - This adds a Main Menu launch command to the Group 
Selector. 

 
Group Selector with Main Menu Option 

Moving the mouse over the Group Selector menu and selecting the Main Menu entry will launch the 
Main Menu. 

• Main Menu Options - This allows the addition of a Restart and Reboot button to the TermSecure 
Menu. It also enables an on-screen keyboard to aid with logins. 

Selecting the Min Menu Options button will allow the TermSecure Main Menu to be changed from 
the default. 

 

Main Menu Options 

The Allow reboot/restart checkbox, if selected, will add a Shut Down button to the TermSecure 
Main Menu. The Shut Down button leads to a menu with a Restart and Reboot button. 
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Main Menu with Shut Down Button 

Once the user logs out, a Shut Down button will appear on the Main Menu. Selecting the Shut Down 
button will launch the Shut Down Menu. 

 

Shut Down Menu 

The Shut Down window has two buttons. 
• Restart , when selected, will log off the TermSecure User, reload the configuration and load any 

changes. 

• Reboot, when selected, will log off the TermSecure User, power off the terminal and reload firmware 

and configuration. 

The Show Virtual Keyboard checkbox, if selected, will display an on-screen keyboard to assist in logins. 
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Virtual Keyboard 

The virtual keyboard allows users to login to terminals that use a touch screen instead of a keyboard and 
mouse. 
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Main Menu Configuration - Terminal Group Configuration Wizard 

The Main Menu Group Selection and Hotkey options are also configurable in the Terminal Group 
Configuration Wizard on the Terminal Interface Options page. 

 
TermSecure User Configuration Wizard - Terminal Interface Options Page 

The Terminal Interface Options window of the Terminal Group Configuration is the same as the Terminal 
Interface Options window of the Terminal Configuration Wizard except for the Group Setting checkboxes. 
The Group Setting checkbox, if selected, will apply that setting to all members of the group. 

See Terminal Interface Options for details on this configuration. 
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Main Menu Configuration - TermSecure User Configuration Wizard 

The Main Menu Group Selection and Hotkey options are also configurable in the TermSecure User 
Configuration Wizard on the Terminal Interface Options page. 

 

TermSecure User Configuration Wizard - Terminal Interface Options Page 

The Terminal Interface Options window of the TermSecure User Configuration is the same as the 
Terminal Interface Options window of the Terminal Configuration Wizard except for the absence of the 
Enable Main Menu Hotkey checkbox. This setting affects the display on the terminal and is not available for 
configuration for TermSecure Users. 

See Terminal Interface Options for details on this configuration. 
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Main Menu Configuration - TermSecure User Group Configuration Wizard 

The Main Menu Group Selection and Hotkey options are also configurable in the TermSecure User Group 
Configuration Wizard on the Terminal Interface Options page. 

 

TermSecure User Configuration Wizard - Terminal Interface Options Page 

The Terminal Interface Options window of the TermSecure User Group Configuration is the same as the 
Terminal Interface Options window of the Terminal Configuration Wizard except for the absence of the 
Enable Main Menu Hotkey checkbox and the addition of Group Setting checkboxes. 

The Enable Main Menu Hotkey setting affects the display on the terminal and is not available for 
configuration for TermSecure Users and TermSecure User Groups. 

The Group Setting checkbox, if selected, will apply that setting to all members of the group. 

See Terminal Interface Options for details on this configuration. 
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Permissions 

 

Creating Permissions Groups 
Permissions grant or limit access through the TermSecure Access Groups. Select the Permissions button in 
the Terminal Configuration Wizard, the Terminal Group Configuration Wizard, the Terminal Server 
Group Wizard, the TermSecure User Wizard, or the TermSecure Users Group Wizard to set these up. 
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Creating a TermSecure Access Group  

Selecting Manage > TermSecure Access Groups from the ThinManager menu will launch the Access 
Groups window. 

 

Access Groups Window with Default Groups 

Select the Add button to add an Access Group. The Add button launches an Access Group window. 

 

Permission Group Creation Window 

Enter a name for the new TermSecure Access Group and select OK to create the group. 
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Additional TermSecure Access Groups Created 

The created Access Groups will be displayed in the Access Group window. These TermSecure Access 
Groups, like Microsoft User Groups, do not have settings and parameters, but instead get their usefulness by 
adding members to them or applying restrictions to them. 
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Permission Groups for Terminals 
TermSecure Access Groups are assigned to a terminal on the first page of the Terminal Configuration 
Wizard. 

Open the Terminal Configuration Wizard for an existing terminal by double clicking on it in the tree. Start the 
Terminal Configuration Wizard for a new terminal by selecting Edit > Add Terminal. 

 

Terminal Configuration Wizard 

Select the Permissions button on the first page of the Terminal Configuration Wizard to launch the 
Permissions window to apply the TermSecure Access Groups to the terminal. 
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 Permissions Window 

By default, the terminal uses the Unrestricted access group, allowing anyone access to the Terminal Server 
Groups that are assigned to the terminal. 

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be 
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or 
highlighting the desired group and selecting an arrow. 

 

Object Permissions 

If the terminal has the Unrestricted access group removed from Member Of list and is replaced by other 
Access Groups, TermSecure will deny access to the terminal except for members of the selected access 
groups. 

Note: Removing the Unrestricted group from a terminal and adding a different group will render the terminal 
functionless until a member of the group logs in. 

Select OK to close the Permissions window. 
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Permission Groups for Terminal Server Groups 
TermSecure Access Groups are assigned to a Terminal Server Group on the first page of the Terminal 
Server Group Wizard. 

Open the Terminal Server Group Wizard for an existing Terminal Server Group by double clicking on it in the 
tree. Start the Terminal Server Group Configuration Wizard for a new Terminal Server Group by right clicking 
on the Terminal Server Group branch icon and selecting Add Terminal Server Group. 

 
Terminal Server Group Configuration Wizard 

Select the Permissions button on the first page of the Terminal Server Group Configuration Wizard to launch 
the Permissions window to apply the TermSecure Access Group to the Terminal Server Group. 
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 Permissions 

By default, the Terminal Server Group uses the Unrestricted access group, allowing anyone access to the 
Terminal Server. 

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be 
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or 
highlighting the desired group and selecting an arrow. 

 

Permissions Changed 

If the Terminal Server Group has the Unrestricted access group removed from Member Of list and is 
replaced by other Access Groups, TermSecure will deny access to the terminal except for members of the 
selected access groups. 

Note: Removing the Unrestricted group from a terminal and adding a different group will render the Terminal 
Server Group functionless until a member of the group logs in. 

Select OK to close the Permissions window. 

Permission Groups for TermSecure Users 
TermSecure Access Group permissions can be applied to TermSecure Users. 
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Open the TermSecure User Configuration Wizard by double clicking on a TermSecure User icon or by right 
clicking on the TermSecure User branch of the ThinManager tree and selecting Add TermSecure User.  

TermSecure Access Groups are configured on the first page of the wizard by selecting the Permissions 
button. 

TermSecure User Information 

 

TermSecure User Information 

Selecting the Permissions button will open the Permissions window that allows the assignment of a 
TermSecure Access Groups. 
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 Permissions 

The Permissions window for TermSecure Users does not show the Unrestricted or the All Users groups, 
just the created groups. Access can be granted or denied by moving the Access Groups into or out of the 
Member Of list by double clicking or highlighting the desired group and selecting an arrow. 

Select OK to close the Permissions window. 

Shortcut Method of Adding TermSecure Access Groups 
Members can be added to TermSecure Access Groups quickly through the TermSecure Access Group 
Wizard. 

Open the TermSecure Access Group Wizard by selecting Manage > TermSecure Access Groups from the 
ThinManager menu. This will launch the Access Groups window. 

 

Access Groups Window 

Highlight the desired TermSecure Access Group and select the Edit button. 
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Access Group Window 

Select the Edit Members button to launch the Access Group Members window. 

 

Access Group Members Window 

Select the Terminals, Terminal Server Groups, or TermSecure Users radio button to configure that 
category and select the Add button. 
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Select Terminal Window 

A Select Terminal window will be displayed with a tree of the configured terminals and terminal groups. 

Select the desired terminals and terminal groups and select OK for each addition. 

 

Access Group Members 

The Access Group Members window will show the members of the TermSecure Access Group. These can be 
removed by highlighting and selecting the Remove button. 
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Terminal Server Groups and TermSecure Users can be added by the same process of adding by selecting 
the appropriate radio button. 

 

Terminal Server Group Selection 

 

Member Terminal Server Groups  

Members can be removed by highlighting them and selecting the Remove button. 
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Card and Badge Configuration for a TermSecure User 
TermSecure allows the use of USB drives and RFID cards as login devices at terminals. This is configured on 
the Card/Badge Information page of the TermSecure User Configuration Wizard. The TermSecure 
Users Configuration Wizard can be launched by double clicking on a TermSecure User in the ThinManager 
tree or by right clicking on the TermSecure Users branch of the tree and selecting Add TermSecure User.  

  
Card / Badge Information Page 

• This user will use a card, badge, or other device to log in - This checkbox, if selected, enables 

the use of a USB device, card or badge to login to a terminal. 

• Enter Card/Badge ID number - This field is for the unique identification number of the ID device. 

This can be filled manually or automatically. See Automatic Card/Badge ID Number Entry and Manual 

Card/Badge ID Number Entry for instructions on the methods. 

• Always Prompt for Password - This checkbox, if selected, will require a password in addition to the 

ID device to login to a terminal as a TermSecure User. 
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Automatic Card/Badge ID Number Entry 
ThinManager can be configured to automatically add the Card/Badge ID number. There are a few conditions 
that need met to allow this to happen.  

• The Display “Create New User” dialog for unknown users check box on the Options page must 
be selected.  

• The terminal must use Terminal Server Groups. 

• The terminal needs the Enable TermSecure checkbox on the Terminal Specification page of the 
Terminal Configuration Wizard. 

• The USB Drive module, RF Ideas pcProx Module, or Wavetrend Tag Reader Module need added 
to the terminal. The USB Drive module needs the Use with TermSecure parameter set to Yes. 

• The user needs to scan the card or insert the USB drive to start the TermSecure Configuration 
Wizard. 

Automatic Card/Badge use starts with the enabling of the Create New User dialog box. This is configured on 
the Options window that is opened by selecting View > Options. 

 

Options Window 

The Display “Create New User” dialog for unknown users check box, if selected, will launch the 
TermSecure User Configuration Wizard on the ThinManager Server when an unknown ID device (USB key 
or ID card) is read by a terminal. Once this checkbox is selected, scanning a new ID card or inserting an 
undefined USB key will launch the TermSecure User Configuration Wizard with the Enter Card/Badge ID 
number automatically filled in. 
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TermSecure User Configuration – TermSecure User Replacement 

When a new card is scanned or a new USB key is inserted into a USB slot on the terminal the TermSecure 
User Configuration is launched with an option to assign the card to an existing user. 

Selecting Next will open the TermSecure User Configuration Wizard and allow a new TermSecure user to be 
configured. 

Selecting Assign Card Number to Existing User will launch the Select TermSecure User to replace 
window to assign the card/badge number to an existing TermSecure User account.  
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Select TermSecure User To Replace Window 

Highlight the desired TermSecure user and select OK. The wizard will display the TermSecure User 
Information page with the selected user entered. 
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TermSecure User Information Page 

If a TermSecure user was selected for the badge, the user will be displayed in the User Name field of the 
TermSecure User Information page. 

Selecting Next will continue with the configuration and show the Card/Badge Information page. 
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Card/Badge Information Page 

The card, badge, or USB drive number will be entered in the Enter Card/Badge ID number field.  

Select Back to change the configuration, select Next to continue, select Finish to accept the changes, or 
select Cancel to cancel changes. 

Manual Card/Badge ID Number Entry 
If the Display “Create New User” dialog for unknown users check box on the Options window is 
unselected, the Enter Card/Badge ID number field will need to be entered manually. The Card/Badge ID 
number is accessible in the event log. To configure a terminal to allow a device one needs to: 

• Turn the Event Log on 

• Have the appropriate hardware on the terminal, either a USB port or a ProxCard reader. 

• Add the appropriate module. 

• Use the device once to have the device’s identifier entered to the event log. 

• Open the TermSecure User Configuration Wizard and enter the ID number to tie the TermSecure 
User to the device. 

• Login with the ID device. 



 

466  ••••  Permissions ACP ThinManager 3.1 Help Manual 

Event Log 

The Event Log is configured in the ThinManager Server Configuration Wizard. 

Open the ThinManager Server Configuration Wizard by double clicking on the ThinManager Server icon in 
the tree, or highlighting it and selecting Edit > Modify from the menu. 

Navigate to the Historical Logging page. 

 
Historical Logging Page 

All events may be selected to be logged, but the Terminal Events checkbox is critical to the TermSecure 
Device detection. Select the Terminal Events checkbox and select the Finish button. 
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USB Device 

When using the USB drive, the USB Flash Drive Module needs added to the terminal. 

Open the terminal by double clicking on it in the ThinManager tree. Navigate to the Module Selection page. 

 
USB Flash Drive Module 

Select the Add button. Highlight the USB Flash Drive Module in the TermSecure Section and select OK to 
accept the module and to return to the Module Selection page. 

Highlight the USB Flash Drive Module and select the Configure button to launch the Module Properties 
window. 
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USB Flash Drive Module Properties 

The USB Flash Drive Module has several parameters. 

• Drive Access Rights in Session - This lets the USB device to be used as a removable storage drive 
when set to ReadWrite. Read Only will allow the device to be read for its ID number, but not used as 
a drive. None blocks any access. 

• Use with TermSecure - This needs to be set to YES to allow the device to be a TermSecure 
identifier. A NO setting, in conjunction with a ReadWrite Access Rights setting, will allow the device 
to be used as a remote storage drive  

• Allow Manual Login - If set to YES, allows a TermSecure User to use the hotkey to initiate logins, or 
the device. If set to NO, it will force a TermSecure User to use a device to login. 

• Prompt for Password - NO allows the device to login without a password. YES forces every 
TermSecure User to enter a password after using the device. 

Configure the USB parameters as desired and select Finish to close the Terminal Configuration Wizard. 

Restart the terminal. 

ProxCard Reader  

A ProxCard Reader works much the same as the USB device, but uses a different module, the RF Ideas 
pcProx Module. 

Open the terminal by double clicking on it in the ThinManager tree. Navigate to the Module Selection page. 

Select the Add button. 

Highlight the RF Ideas pcProx Module in the TermSecure Section and select OK to accept the module and 
to return to the Module Selection page. 

Highlight the RF Ideas pcProx Module and select the Configure button to launch the Module Properties 
window. 
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RF Ideas ProxCard Module Properties 

The RF Ideas pcProx Module has several parameters. 

• Port - The RF Ideas pcPRoxCard Reader connects to a ThinManager Ready thin client through the 
serial port. The Port setting specifies which COM Port the reader is attached to. 

• Number of Data Bits – The reader can use 26, 37, or all (RAW) data bits for identification. 

• Use Facility Code - This, if set to YES, includes the facility code as part of the identifier number.  

• Allow Manual Login - If set to YES, allows a TermSecure User to use the hotkey to initiate logins, or 
the device. If set to NO, it will force a TermSecure User to use a device to login. 

• Prompt for Password - NO allows the device to login without a password. YES forces every 
TermSecure User to enter a password after using the device. 

Configure the ProxCard parameters as desired and select Finish to close the Terminal Configuration Wizard. 

Restart the terminal. 

WaveTrend Tag Reader Module 

A WaveTrend Tag Reader works much the same as the USB device, but uses a different module, the 
WaveTrend Tag Reader Module. 

Open the terminal by double clicking on it in the ThinManager tree. Navigate to the Module Selection page. 

Select the Add button. 

Highlight the WaveTrend Tag Reader Module in the TermSecure Section and select OK to accept the 
module and to return to the Module Selection page. 

Highlight the WaveTrend Tag Reader Module and select the Configure button to launch the Module 
Properties window. 
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WaveTrend Module Properties 

The WaveTrend Tag Reader Module has several parameters. 

• Port - The WaveTrend Tag Reader Module connects to a ThinManager Ready thin client through the 
serial port. The Port setting specifies which COM Port the reader is attached to. 

• Use Vendor Code - This, if set to YES, includes the vendor code as part of the identifier number.  

• Allow Manual Login - If set to YES, allows a TermSecure User to use the hotkey to initiate logins, or 
the device. If set to NO, it will force a TermSecure User to use a device to login. 

• Prompt for Password - NO allows the device to login without a password. YES forces every 
TermSecure User to enter a password after using the device. 

• Entry Signal Strength - The signal strength required to register the card as in range 

• Exit Signal Strength - The signal strength required to register the card as out of range 

• Entry Sensitivity - The number of reads above the Entry Signal Strength reads that are required to 
register as “Entered” 

• Exit Sensitivity - The number of reads below the Exit Signal Strength that are required to register as 
“Exited”  

Configure the WaveTrend parameters as desired and select Finish to close the Terminal Configuration 
Wizard. 

Restart the terminal. 
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Device Identifier Number 

Next the ID device needs to be scanned or inserted to help find the ID number. 

Insert the USB device or scan the ProxCard on the terminal. 

A TermSecure message should be displayed. 

 

TermSecure Message 

The ID device will not work so the terminal will send a message with the ID device’s identifier number. 
• Record this number. 

This number is also entered in the event log if the Terminal Events were selected in the ThinManager Server 
Configuration Wizard. 

• Open ThinManager. 

• Highlight the terminal in the tree and select the Event Log tab. 

The ID for the device is entered in the log. 



 

472  ••••  Permissions ACP ThinManager 3.1 Help Manual 

 

ThinManager Event Log 

Next the ID number needs to be associated with the TermSecure User. 
• Open the TermSecure User Configuration Wizard for the user you want to have use that ID device. 

• Navigate to the Card / Badge Information page. 
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Card / Badge Information Page 

• Select the This user will use a card, badge, or other device to log in checkbox. 

• Enter the ID Identifier from the earlier steps into the Enter Card/Badge ID number field. 

• Select the Always Prompt for Password, if desired. 

Now the Terminal is configured, the ID device is identified, and the TermSecure User is configured to use the 
device. 

• Insert the USB device into the USB port on the ThinManager Ready thin client or scan the ProxCard 

on the card scanner. 

The USB device will log the TermSecure User into the terminal server. 
• Open ThinManager. 

• Highlight the ThinManager Server and select the Event Log tab. 
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Event Log 

The Event Log will show the results of the successful login. The terminal will have the TermSecure User 
added to its icon in the tree, while the TermSecure User icon will show the name of the terminal that it is 
logged into. 
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WinTMC Fat Client 

WinTMC Overview 
WinTMC is a ThinManager Client for PCs running Windows NT/2000/XP operating systems. WinTMC 
provides similar functionality to that of a ThinManager Ready Terminal. The WinTMC client can use failover, 
Instant Failover, SmartSession, MultiSession, and AppLink, among others. Once the WinTMC client is 
installed the client can be managed remotely through ThinManager instead of locally. 

See WinTMC Installation for details on installation. 
 

Local WinTMC Configuration  
When WinTMC starts, a Configure button will be displayed on the splash screen.  

 

WinTMC Splash Screen 

Click on the Configure button to configure the initial WinTMC settings.  
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WinTMC ThinManager Server List Configuration 

The ThinManager Server List allows the WinTMC to be pointed to one or more ThinManager Servers to 
retrieve its configuration. 

Enter the IP address or name of your ThinManager Servers in the Enter new ThinManager Server Name or 
IP Address field and click the Add button to add them to the Current ThinManager Servers list.  

The WinTMC will try to connect to the ThinManager Servers in the order listed, so the order can be changed 
with the Move Up and Move Down buttons. 

Unneeded ThinManager Servers can be removed with the Delete button. 

This configuration menu can be password protected by selecting the Set Password button. Once the 
password is set, when WinTMC is started and the Configure button is clicked, a password will be required to 
change the configuration. 

 

No ThinManager Server Specified 

If the OK button is selected without entering a ThinManager Server, an error window will remind you to enter 
a ThinManager Server address. 

Once the local configuration is set, WinTMC will connect to a ThinManager Server and attempt to retrieve its 
configuration.  
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Terminal Replacement Dialog 

If the WinTMC PC has not been defined, the user will be prompted with a dialog box to allow for the creating a 
new configuration or replacing an existing terminal configuration on the ThinManager Server.  

This functionality is similar to that of the create/replacement menu on a ThinManager Ready Thin Client. See 
Replace or Create New Mode for details on that method. 

Once the WinTMC has been assigned a configuration you will not need to make a selection again. 

If you want to run WinTMC without the configure button, you can run it from a command line with the 
ThinManager Servers separated by semi-colons (i.e. WinTMC TMS1;TMS2;TMS3). This will eliminate 
the configure button when WinTMC is started.  

If you want to pre-create a WinTMC client in ThinManager using the Terminal Configuration Wizard, select 
GENERIC for the Make/OEM and PersonalComputer for the Model on the Terminal Hardware page of the 
Terminal Configuration Wizard. 
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WinTMC Settings in Terminal Hardware  

The Terminal Configuration Wizard includes a WinTMC Settings page. 
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WinTMC Settings 

WinTMC clients can also be configured on the WinTMC Settings page. These only apply to connections made 
by the WinTMC fat client.  

The settings include: 

Redirect Local Resources: 
• Redirect Serial Ports - This checkbox, if selected, will make local serial ports available in a 

session. Serial Port redirection does not work when you connect to a terminal server running 
Windows 2000 or earlier. 

• Redirect Drives - This checkbox, if selected, will make local drives available in a session. Drive 
redirection does not work when you connect to a terminal server running Windows 2000 or 
earlier. 

• Redirect Printers - This checkbox, if selected, will make your local printer available in a session.  

• Redirect Sound - This checkbox, if selected, will allow audio played in your session to play 
locally. Sound redirection does not work when you connect to a terminal server running Windows 
2000 or earlier. 

• Redirect Smart Cards - This checkbox, if selected, will make your smart card available in a 
session. Smart card redirection does not work when you connect to a terminal server running 
Windows 2000 or earlier. 

Client Control Settings: 
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• Allow Client to be closed - This checkbox, if selected, will enable your user to close the client 
(WinTMC program). 

• Allow client to be sized - This checkbox, if selected, will enable your user to resize the client. 

Experience Settings: 
• Show Desktop Background -  This checkbox, if selected, will enable your user to select a 

Windows Desktop Background. If not selected, the background will be a solid color.  

• Show window contents while dragging - This checkbox, if selected, will show the window 
contents to be shown while the window is being dragged.  

• Show menu/window animations - This checkbox, if selected, will enable menu/window 
animations on the client.  

• Show Themes -  This checkbox, if selected, will enable your user to select a Windows Theme.  

Note: These functions may be denied by user policies or terminal server configuration. Check the Microsoft 
Local Policy, Group Policy, and Terminal Services Configuration. See Non-ThinManager Components for 
details. 

WinTMC Licensing 
WinTMC requires a Terminal/WinTMC connection license. Existing Terminal Connection Licenses can be 
upgraded to support WinTMC connections. For customers using ThinManager Enterprise Class licenses, a 
WinTMC Connection License is required. 

See WinTMC Licensing for details. 
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TermMon ActiveX Control 
The TermMon ActiveX Control can be used to collect information about a terminal and perform terminal 
functions. For the purposes of this document Control will refer to the TermMon ActiveX Control. 

This section is not meant as a tutorial on ActiveX controls but is a datasheet on the properties and functions 
of the TermMon ActiveX control. 

Registering the Control 
The TermMon ActiveX Control can be found on the ThinManager CD as termmon.ocx. 

The Control must be registered before it can be used. Copy the file termmon.ocx to the computer where 
you want to use it. Register the OCX by executing regsvr32 <path\termmon.ocx>. 

Using the Control 

TermMon ActiveX Configuration Module 
If running the Control in the terminal’s terminal services session, no special configuration of the terminal in 
ThinManager is required. The TermMon ActiveX Control Configuration Module is not required. 

If the Control is not run in the terminal’s terminal services session, the TermMon ActiveX Control 
Configuration Module must be added to the terminal configuration in ThinManager. In the module 
configuration, Allow ActiveX Connections must be set to YES and Only Allow Connections from Session 
must be set to NO. 

The TermMon ActiveX Control Configuration Module can be used to prevent a connection from an 
application running in the terminal’s terminal services session. This is accomplished by adding the TermMon 
ActiveX Control Configuration Module to the terminal in ThinManager and setting the Allow ActiveX 
Connections option to NO.  

Read-Only Properties 
The following properties are read only strings. An event will be generated any time one of these properties 
changes. The Enable method must be invoked prior to reading these properties. 

• TerminalName - This is the name of the terminal. 

• TerminalModel - This is the terminal model number. 

• TerminalIP - This is the terminal IP address. 

• TerminalMAC - This is the terminal MAC Address. 

• TerminalBootLoaderVersion - This is the terminal network boot loader version. 

• TerminalFirmwareVersion - This is the firmware version that the terminal is running. 

• TerminalWindowsUsername - This is the Windows Username that is specified in the terminal’s 
ThinManager configuration. 
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• TermSecureUsername - This is the TermSecure username of the TermSecure user currently logged 
onto the terminal. If no TermSecure user is logged on, this value will be blank. 

• TermSecureWindowsUsername - This is the Windows Username associated with a TermSecure 
user. This is the Windows Username for all TermSecure user sessions. If no TermSecure user is 
logged on, this value will be blank. 

• TerminalServerGroupList - This is a comma-separated list of terminal server groups currently 
running on the terminal. 

• ConnectionState - This is the Control’s connection state with the terminal. 

• CurrentTerminalServerGroup - This is the Terminal Server Group that is currently being displayed 
on the terminal. 

• CurrentWindowsUsername - This is the Windows Username of the session where the Control has 
been executed. This property is not available when the RunInSession property is set to False. 

• TerminalServerName - This is the name of the Terminal Server where the Control is running. This 
property is not available when the RunInSession property is set to False. 

Read-Write Properties 
These properties can be set by the application. 

• RunInSession - When the RunInSession property is set to True, the Control will be running in the 
terminal’s terminal services session. The terminal IP address will be determined automatically by the 
control. 

• OverrideIP - If the RunInSession property is set to False, the OverrideIP property specifies the IP 
Address of the terminal that the Control will connect to. 

Note: To use the OverrideIP property, the TermMon ActiveX Control Configuration Module must be added to 
the terminal configuration in ThinManager. In the module configuration, Allow ActiveX Connections 
must be set to YES, and Only Allow Connections from Session must be set to NO. 

• WatchdogTime – This is the number of seconds before the watchdog will reset the terminal session. 
Once this property is set to a non-zero value, the property must be updated before the watchdog time 
reaches zero. To disable the watchdog, set this property to zero. The watchdog is disabled by default. 

Note: The Enable Method does not need to be called for watchdog operation. Watchdog operation is 
independent of the Enable and Disable Methods. 

Events 
When a property value changes, an event will be generated by the Control. When an Event occurs the event 
code can be used to determine the property that changed. The Event method must be invoked in order to 
receive events (except for WatchdogTime). The event code is provided by the Control as follows: 

• TermMonEvent.TerminalName     

• TermMonEvent.TerminalModel     

• TermMonEvent.TerminalIP     

• TermMonEvent.TerminalMAC     

• TermMonEvent.TerminalBootLoaderVersion   

• TermMonEvent.TerminalFirmwareVersion   
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• TermMonEvent.TerminalWindowsUsername   

• TermMonEvent.TermSecureUsername    

• TermMonEvent.TermSecureWindowsUsername   

• TermMonEvent.TerminalServerGroupList   

• TermMonEvent.ConnectionState    

• TermMonEvent.CurrentTerminalServerGroup   

• TermMonEvent.CurrentWindowsUsername   

• TermMonEvent.TerminalServerName    

• TermMonEvent.WatchdogTime 

Methods 
• Enable - Invoking this method will enable the Control. The Control will attempt to connect to the 

terminal and generate events to update the Control Properties. The Control will maintain a connection 
to the terminal as long as it is enabled. 

• Disable - Invoking this method will cause the Control to break the connection with the terminal. 
Events will be generated to clear the Control Properties. 

• Command - The Command method can be used to send terminal action commands. The Command 
method requires one parameter which is the terminal command to be performed. The Enable method 
must be invoked before these commands can be executed (except for noted exceptions). The 
supported commands are: 

o Reboot - This command will initiate a terminal reboot. 

o Restart - This command will initiate a terminal restart. 

o Calibrate - This command will initiate a touch screen calibration. 

o GotoMainMenu - This command will cause the Main Menu to be displayed. 

o SwitchToNextGroup - This command will switch to the next terminal server group. 

o SwitchToPrevGroup - This command will switch to the previous terminal server group. 

o SwitchInstFailover - This command will switch the instant failover group. 

o ChangeTermSecureUser - This command will disconnect any current TermSecure user 
sessions and then display the TermSecure Log On menu. 

o LogOffAndChangeTermSecureUser - This command will log off any current TermSecure 
user sessions and then display the TermSecure Log On menu. 

o LogOffTermSecureUser - This command will log off any current TermSecure user sessions 
and will return to a terminal server group which is assigned to the terminal. If no terminal 
server groups have been configured on the terminal, the TermSecure Log On menu will be 
displayed.  

o DisconnectTermSecureUser - This command will disconnect any current TermSecure user 
sessions and will return to a terminal server group which is assigned to the terminal. If no 
terminal server groups have been configured on the terminal, the TermSecure Log On menu 
will be displayed.  

o DisconnectSession - This command will disconnect the Terminal Services Session running 
on the terminal. This command does not require that the Enable Method be invoked prior to 
execution. 
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o LogOffSession - This command will log off the Terminal Services Session running on the 
terminal. This command does not require that the Enable Method be invoked prior to 
execution. 

 

The Command Method constants are provided by the Control as follows: 

o TermMonCommand.Reboot 

o TermMonCommand.Restart 

o TermMonCommand.Calibrate 

o TermMonCommand.GotoMainMenu 

o TermMonCommand.SwitchToNextGroup 

o TermMonCommand.SwitchToPrevGroup 

o TermMonCommand.SwitchInstFailover 

o TermMonCommand.ChangeTermSecureUser 

o TermMonCommand.LogOffAndChangeTermSecureUser  

o TermMonCommand.LogOffTermSecureUser 

o TermMonCommand.DisconnectTermSecureUser 

o TermMonCommand.DisconnectSession 

o TermMonCommand.LogOffSession 

 

• ChangeTerminalServerGroup - This method can be used to change the terminal server group 
currently displayed on the terminal. This method requires one parameter which is the name of the 
terminal server group that the terminal should switch to. 

• TermSecureCheckAccess - This method can be used to query the access rights of a TermSecure 
user. This method requires two parameters. The first parameter is the name of the user. The second 
parameter is the name of the Access Group. This method returns the result of the query as follows: 

o TermMonConst.Timeout - The request timed out. 

o TermMonConst.Busy - The Control is busy with another request. 

o TermMonConst.InvalidMember - The user is not a member of the specified TermSecure 
Access Group. 

o TermMonConst.ValidMember - The user is a member of the specified TermSecure Access 
Group. 

o TermMonConst.UserNotFound - The TermSecure Username was not found. 

o TermMonConst.GroupNotFound  - The Access Group Name was not found. 
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Control Constants 
Constant values provided by the Control are as follows: 

TermMonEvent 

• TerminalName    1 

• TerminalModel    2 

• TerminalIP    3 

• TerminalMAC    4 

• TerminalBootLoaderVersion  5 

• TerminalFirmwareVersion  6 

• TerminalWindowsUsername  7 

• TermSecureUsername   8 

• TermSecureWindowsUsername  9 

• TerminalServerGroupList  10 

• ConnectionState   11 

• CurrentTerminalServerGroup  12 

• CurrentWindowsUsername  13 

• TerminalServerName   14 

TermMonCommand 

• Reboot     100 

• Restart     101 

• Calibrate    102 

• GotoMainMenu    103 

• SwitchToNextGroup   104 

• SwitchToPrevGroup   105 

• SwitchInstFailover   106 

• ChangeTermSecureUser  107 

• LogOffAndChangeTermSecureUser 108 

• LogOffTermSecureUser   109 

• DisconnectTermSecureUser  110 

• DisconnectSession   111 

• LogOffSession    112 

TermMonConst 

• Success    0 

• Fail     1 

• Disconnected    2 



 

486  ••••  TermMon ActiveX Control ACP ThinManager 3.1 Help Manual 

• Connected    3 

• Timeout    4 

• Busy     5 

• Updating    6 

• RequestFailed    7 

• InvalidMember    8 

• ValidMember    9 

• UserNotFound    10 

• GroupNotFound    11 

 

TermMon ActiveX Demo Application 
The TermMon ActiveX Demo Application can be used to demonstrate the features of the Control. The demo 
application is found on the ThinManager CD in the Terminal ActiveX folder as TermMon.exe. 

To start the application in graphical mode, run TermMon.exe in a terminal’s terminal services session. 
This will allow the Control functionality to be demonstrated. The demo application can also be run non-
graphically using command line options. The format is as follows: 

TermMon -c <command> -f <output path and filename> -d <data> -a <ip 
address> 

The following commands are terminal action commands: 
• Reboot 
• Restart 
• Calibrate 
• GotoMainMenu 
• SwitchToNextGroup 
• SwitchToPrevGroup 
• SwitchInstFailover 
• ChangeTermSecureUser 
• LogOffAndChangeTermSecureUser 
• LogOffTermSecureUser 
• DisconnectTermSecureUser 
• ChangeTerminalServerGroup -d <groupname> 

The following commands return the result in the output filename. 
• TerminalName -f <output filename> 
• TerminalModel -f <output filename> 
• TerminalIP -f <output filename> 
• TerminalMAC -f <output filename> 
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Non-ThinManager Components 

Configuring RDP for Auto-Login 
RDP, the Remote Desktop Protocol , is configured by default to require users to enter a password when 
logging on to a Windows 2000 Terminal Server. This prevents a terminal from logging in automatically when 
using an initial program. The change in the configuration to allow the auto-login and initial program while 
using RDP is made in the Terminal Services Configuration.  

Note: The information included here is for your convenience. Because this information can change, please 
see Microsoft at www.microsoft.com for up-to-the-minute details.  

Select Start > Programs > Administrative Tools > Terminal Services Configuration to launch the 
Terminal Services Configuration Console.  
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Terminal Services Configuration Console- Windows 2000 

Double-click RDP-tcp in the right pane or highlight RDP-tcp and select Action > Properties to launch the 
RDP-tcp Properties. 
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RDP-tcp Properties 

Uncheck the Always prompt for password checkbox and click the OK button to allow auto-login. 

 

Configuring Windows 2003 Terminal Services for 
Multiple Logins 
Windows 2003 is set to prevent multiple logins by the same account. Although it is a “best practice” to have 
each user login with a unique account, a terminal using MultiSession can use the same terminal server in 
several Terminal Server Groups, making multiple logins desirable. This setting, and others, is changed in the 
Terminal Services Configuration Console. See Configuring RDP for Auto-Login. 

Open the Microsoft Terminal Services Configuration Console by selecting Start > Control Panel > 
Administrative Tools > Terminal Services Configuration. 
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Terminal Services Configuration Console- Windows 2003 

The Server Settings in the Terminal Services Configuration can be changed by double-clicking them. Four 
that are of interest are Licensing, Permission Compatibility, Restrict each user to one session and 
License server discovery mode. 

Single Session Per User 
The Single Session Per User setting controls multiple logins. Double-clicking the setting will launch a 
settings window. 

 

Terminal Services Configuration Console- Single Session Per User 

The Restrict each user to one session checkbox is selected by default in Windows 2003. Unselect it to 
allow multiple logins if needed for MultiSession. 
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Licensing Mode 
Microsoft has expanded the Terminal Server Client Access License (TS CAL) program in windows 2003. TS 
CALs are available in two types, TS Device CALs and TS User CALs.  

• The TS Device CAL licenses one device for any user to connect to Microsoft Terminal Servers. This 
functions like the previous Windows 2000 TS CAL. 

• The TS User CAL licenses one user for any device to connect to Microsoft Terminal Servers. 

To change between the Per Device licensing and Per User licensing, double-click Licensing to launch the 
Licensing Mode window. 

 

Terminal Services Configuration Console- Licensing Mode 

Select the desired mode from the Licensing Mode dropdown box and click OK. 

Permission Compatibility 
Microsoft has increased the security in each successive release of its terminal server software. These new 
policies prevent users from accessing the system folder, *.ini files, the registry, and other resources. Some 
programs such as HMI, SCADA, database, and control software  need access to these resources to function. 
Instead of making all the users administrators, the security can be set to the less strenuous Windows NT 4.0-
style security.  
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Terminal Services Configuration Console- Permission Compatibility 

Launch the Permission Compatibility window by double-clicking on the Permission Compatibility setting. 
Select the Relaxed Security radio button and select the OK button. 
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License Server Discovery Mode 
A new feature in Windows 2003, Service Pack 1 and later, is a setting to point the terminal server to a specific 
Terminal Server Licensing Server. This is the License server discovery mode setting in Terminal Services 
Configuration. This is easier than hard coding the license server into the registry. 

  

Terminal Server License Server Discovery Window 

Launch the Terminal Server License Server Discovery Window by double-clicking the License server 
discovery mode setting in Terminal Services Configuration window. 

Entering a valid Microsoft Terminal Server Licensing Server name in the Use these license servers field will 
force the terminal server to use the defined server as the license server. This keeps the terminal server from 
getting confused when there are multiple license servers. 

The Automatically discovered license servers field would be automatically populated with license servers 
found by the terminal server and can be used as a reference. The Check names button will check the 
validation of the name in the Use these license servers field. 
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Command Prompt 
Terminal Services has several commands that aid in managing the terminal server. Some useful ones are:  

 

Command Action 

change logon Temporarily disables logons to a Terminal Server 

change port Changes COM port mappings for MS-DOS program compatibility 

change user /install Puts the server into “Install Mode” 

change user /execute Removes the server from “Install Mode” 

Ipconfig Displays the IP addresses of the network card 

Logoff Logs off a user from a session and deletes the session from the server 

net send username “message” Sends a message to a user. username is the NT/2000 user name that the 
person or terminal is logged in as. “message” is the text of the message. 
Quotation marks are needed for any messages containing a space. 

query process Displays information about processes running on a Terminal server 

query session Displays information about sessions on a Terminal server 

query termserver Displays a list of all Terminal servers on the network 

query user Displays information about user sessions on a Terminal server 

reset session Resets a session to known initial values 

Shadow Monitors another user's session 

Tsdiscon Disconnects a client from a terminal server session 

Tsshutdn Shuts down the terminal server in an orderly manner 

See the Windows online help for additional commands and parameters. 

Other useful commands include: 

Command Action 

gpedit.msc Launches the Group Policy Editor 

tscc.msc Launches the Terminal Services Configuration Console 

tsadmin Launches the Terminal Services Manager 
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Alternative Terminal Keystrokes 
Certain keystrokes are not available in a terminal session. Microsoft has provided these alternatives. 

 

Keystroke Function 

ALT+PAGE UP  Switches between programs from left to right.  

ALT+PAGE DOWN  Switches between programs from right to left.  

ALT+INSERT  Cycles through the programs in the order they were started.  

ALT+HOME  Displays the Start menu.  

CTRL+ALT+BREAK  Switches the client between a window and full screen.  

CTRL+ALT+END  Brings up the Windows 2000 Security dialog box.  

ALT+DELETE  Displays the Windows menu.  

CTRL+ALT+Minus (-) symbol on the 
numeric keypad  

Places a snapshot of the active window, within the client, on the Terminal server 
clipboard (provides the same functionality as pressing PrintScrn on a local 
computer.)  

CTRL+ALT+Plus (+) symbol on the 
numeric keypad  

Places a snapshot of the entire client window area on the Terminal server 
clipboard (provides the same functionality as pressing ALT+PrintScrn on a local 
computer.)  
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Group Policy 
Windows 2003 has a number of features that can be allowed or prevented with a Group Policy. Group Policy 
is configured in the Group Policy Object Editor snap-in to the Microsoft Management Console. 

Access the Group Policy Editor by typing gpedit.msc at a command prompt to launch the Microsoft 
Group Policy Editor. 

 

Group Policy Settings 

Expanding the tree will show Group Policy settings that can affect the terminal server experience. 

Please refer to Microsoft documentation for information on using these features. 

 

DHCP Server Setup 
Dynamic Host Configuration Protocol (DHCP)  is a program that assigns IP addresses to devices on a 
network. Since a DHCP server can be used to provide IP addresses to ThinManager Ready thin clients, the 
instructions for configuring the Windows 2000 DHCP Server are provided.  
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Note: The information included here is for your convenience. Because this information can change, please 
see Microsoft at www.microsoft.com for up-to-the-minute details.  

To add DHCP to a Windows Server after installation select Start > Settings > Control Panel > Add/Remove 
Programs > Add/Remove Windows Components. A Windows Configuration Wizard will launch. 

 

Windows Components Wizard 

Highlight Networking Services in the list window and select the Details button. 
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Networking Services 

Check the Dynamic Host Configuration Protocol (DHCP) check box and select the OK button. 

The wizard will install the DHCP server. 

 

Application Server Mode 

As part of the Windows Components Wizard, you may be asked to confirm the terminal service mode. The 
terminal server needs to run in application server mode to work with thin clients. 
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DHCP Scope Configuration for Microsoft DHCP Server 

A DHCP server, in its simplest form, will assign an IP address to a computer that joins a network and requests 
one. A DHCP scope is a range of IP addresses that are available for assignment.  

ACP Enabled thin clients need more information from the DHCP server than just an IP address. They need 
the IP address of the ThinManager server (Option 066) and the name of the firmware ( Option 067) to 
download. This information needs to be added to the DHCP scope in the form of options. 

To establish a DHCP scope, open the Computer Management Console by selecting Start > Programs > 
Administrative Tools > Computer Management. 

 

Create a DHCP Scope 

Highlight DHCP in the Services and Applications folder of the tree pane and select Action > New Scope. 

A New Scope Wizard will launch that will guide the process of creating the scope. 
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Scope Range 

Set the range of IP addresses by entering the starting IP address for the scope and the ending IP address of 
the scope. 

Enter the desired subnet mask. 

Select the Next button to continue. 
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Scope Exclusions 

If computers are already assigned IP addresses in the scope range, they can be excluded from the range by 
adding the IP address(s) and selecting the Add button. 

Scope Options 

The DHCP Server needs two options configured before it will provide all the information that the terminal 
needs to boot. These options are Option 066 and Option 067. 
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Boot Server Host Name 

The Boot Server Host Name, Option 066, assigns a ThinManager server to the terminal.  

Open the Scope Options dialog box by highlighting the Scope Option folder in the tree pane of the Computer 
Management Console under the Services and Application > DHCP folder and selecting Action > 
Configure Options. 

Scroll through the list window and check the Option 066 check box.  

Enter the IP address of the desired ThinManager server in the String Value field.  
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Boot Server Host Name for Dual ThinManager Servers 

The DHCP Server can issue the IP address for a Primary ThinManager Server and a Secondary 
ThinManager Server by listing the IP addresses of both, separated with a space. 

Do not select the OK button yet.  
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DHCP Options 

The Option 067, Bootfile Name, tells the terminal what file to download during the boot process. 

Scroll through the list window and check the Option 067 check box.  

Enter firmware.acp in the String Value field.  

Select the OK button to accept the configuration of options. 
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Completed Scope 

Once the scope is added, the range is set, and the options are configured, it needs to be activated.  

Highlight the scope in the tree pane of the Computer Management Console. Select Action > Activate. The 
scope is now active. 

Scope Reservation 

Reservations allow an IP address to be reserved for a specific terminal instead of being assigned randomly. 
An IP address can be matched with a MAC address to create a reservation. This allows DHCP to assign a 
“static” IP address.  
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Scope Reservation 

The New Reservation window is launched by selecting the Reservation folder in the tree pane of the 
Computer Management Console under the Services and Application / DHCP folder and selecting Action > 
New Reservation. 

The MAC address of a terminal is displayed in the details-view pane of ThinManager. 

Enter a Reservation Name, the desired IP address, and the MAC address from the terminal. Select OK to 
finish. 

DHCP Properties 

The DHCP Server can be configured to check for duplicate IP addresses before issuing a new address. This 
is a good feature to use. 

Highlight DHCP under Services and Applications in the Computer Management tree and select Action > 
Properties, or right-click on DHCP and select Properties. The DHCP Properties window will launch. 



 

ACP ThinManager 3.1 Help Manual Non-ThinManager Components  ••••  507 

 

DHCP Properties – Advanced Tab 

Select the Advanced tab. Replace the zero in the Conflict detection attempts field with an integer. This will 
prompt the DHCP Server to check for duplicate IP addresses before assigning an IP address. 

Select OK when finished. 
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Creating Microsoft User Profiles 
A terminal needs a valid Windows 2000/Windows 2003 User Profile to log onto a terminal server.  

To create a user profile open the Computer Management Console by selecting Start > Programs > 
Administrative Tools > Computer Management in Windows 2000 or by selecting Start > Administrative 
Tools > Computer Management in Windows 2003.  

 

Computer Management Console 

Highlight the User sub-folder of Local Users and Groups in the Computer Management tree pane.  

Select Action > New User. This will launch a New User dialog box.  
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New User Dialog  

Enter the user name for the user in the User name field. 

Enter a password in the Password field.  

Re-enter the password in the Confirm password field.  

The User must change password at next logon check box forces the user to change the password. 

Select the Create button to finish the profile.  

Select the Close button to return to the Computer Management Console. 
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Microsoft TS CALs – Terminal Server Client Access 
Licenses 

Microsoft Client Access Licenses (CALs) 
ACP Enabled Thin Clients require a terminal server with Windows 2000 Server with Terminal Services 
enabled, or Windows 2003 Server with Terminal Services enabled as an operating system. 

Each of these operating systems requires a standard Microsoft Client Access License (CAL) for each 
connection to the server. These are based on concurrent use; a 5-pack would allow more than five users to 
access server resources, but only five users at a time.  

Microsoft Terminal Server Client Access Licenses (TS CALs) 
Terminals, such as thin clients and fat clients, require an additional license, the Microsoft Terminal Server 
Client Access License (TS CAL)  to connect to the server using either RDP or ICA. This licensing is per 
seat; ten terminals would require ten TS CALs, even if only two were connected at a time.   

Windows NT 4.0 Terminal Server Edition was sold with TS CALs. These were installed on each NT 4.0 
Terminal Server. Additional TS CALs are available from Microsoft. 

Windows 2000 and Windows 2003 have an improved method of license management. All TS CALs are 
installed on a Terminal Services Licensing Server. This acts as a repository for all TS CALs. The terminal 
servers request TS CAL authentication from the Terminal Services Licensing Server as terminals attach to 
terminal servers. 

Note: The Terminal Server Licensing Server does not need to be a separate computer but can be run on any 
Windows 2000 or 2003 server, including Windows 2000/2003 Terminal Servers.  

In Windows 2000, Microsoft requires that the Terminal Server Licensing Server be installed on the Primary 
Domain Controller in a domain. 

The Terminal Services Licensing server is activated through the Internet by connecting to the Microsoft 
Certificate Authority and License Clearinghouse.  

Windows 2000/2003 Server with Terminal Services enabled will issue 90-day temporary licenses while the 
Terminal Services Licensing server is being setup and activated. If this period has elapsed, the terminal will 
not connect to the terminal server and will display an “Error Number 50” message box. 

Windows 2000/2003 Server is not normally sold with TS CALs. These need to purchased separately and 
installed on the Terminal Services License server.  
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Windows 2003 TS CALS 
Microsoft has expanded the Terminal Server Client Access License (TS CAL) program in windows 2003. TS 
CALs are available in two types, TS Device CALs and TS User CALs.  

• The TS Device CAL licenses one device for any user to connect to Microsoft Terminal Servers. This 
functions like the previous Windows 2000 TS CAL. 

• The TS User CAL licenses one user for any device to connect to Microsoft Terminal Servers. 

To change between the Per Device licensing and Per User licensing, double-click Licensing to launch the 
Licensing Mode window. 

Microsoft Terminal Server Licensing Activation 
In Windows 2000 and 2003, all the TS CALs are installed on a single Terminal Server Licensing Server. This 
allows a single site for management and authentication of terminal server connections. A server becomes a 
Terminal Server Licensing Server by selection of the option during the installation phase or by selecting 
Add/Remove Programs > Add/Remove Windows Components from the Control Panel and selecting the 
Terminal Services Licensing. 

Note: The information included here is for your convenience. Because this information can change, please 
see Microsoft at www.microsoft.com for up-to-the-minute details.  

The licensing of the Microsoft components of a Windows 2000 terminal server is a two-step process; one 
must first authorize the Terminal Server Licensing Server, then one must activate the licenses. The license 
activation will be repeated for each license pack. 

Note: The Terminal Server Licensing Server does not need to be a separate computer but is usually installed 
on a Terminal Server. Microsoft requires that the Terminal Server Licensing Server be installed on the 
Primary Domain Controller in a 2000 domain. 
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To begin the process select Start > Programs > Administrative Tools > Terminal Server Licensing on the 
Terminal Server Licensing Server. 

 

Terminal Services Licensing 

Highlight desired server. 

 

Selected Terminal Server 

Select Action > Activate Server from the menu bar. 
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Licensing wizard 

The Licensing Wizard will launch. 

 Follow the steps of the wizard by selecting Next.  

Note: The ID numbers shown on screens have been changed to “1234”. Please use the appropriate numbers 
that apply to your server and licenses. 

 

Connection Method 

There are several methods for connecting to the Microsoft License Clearinghouse. 
• Internet - Allows activation through a direct connection to Microsoft. The Licensing Server must have 

Internet access. 

• World Wide Web - Allows activation at Microsoft’s web site through a web browser. 
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• Fax - Allows activation through faxes to Microsoft. 

• Telephone - Allows activation through the telephone. 

Select the desired method from the drop-down box and select Next. 

Note: This section will detail the World Wide Web method. 

 

License Server Activation 

The server needs a License Server ID for authorization. This is done on the Microsoft web site. 

Go to the https://activate.microsoft.com site mentioned in the dialog box. 
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Microsoft Terminal Services Licensing Web Site 

Select Activate a license server and select Next. 
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Customer Information Entry Form 

Fill out the information forms and select Next. The Product ID is supplied by the Licensing Wizard. 
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Customer Information 

Continue with web-based wizard. Verify the data and select Next. 
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Server Activation Number 

Microsoft will provide the License Server ID. 

Add this number to the form in the Licensing Wizard. 



 

ACP ThinManager 3.1 Help Manual Non-ThinManager Components  ••••  519 

 

Wizard Completion 

Once the License Server ID is placed in the appropriate fields on the Licensing Wizard, you will have a choice 
to continue and activate the license packs or to stop with the server activation. 

Microsoft TS CAL License Authorization 
To continue adding license packs, return to the https://activate.microsoft.com web site.  
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Microsoft Terminal Services Licensing Web Site 

Select the Install client license key packs and select Next. 
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Customer Information 

Fill out the form and select Next. 
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TS CAL Information 

Select the Product Type and fill in the fields with the Quantity, Authorization Number, and License Number 
from the Licensing Certificate that was included with the purchase of the licenses. 

Select Next to continue. 
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License Information 

Verify that the information is correct and select Next to continue. 
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License Key Pack ID 

The Microsoft site will provide the License Key Pack ID. This needs to be installed in the Licensing Wizard. 
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License Key Pack ID Fields 

Fill in the fields of the Licensing Wizard with the License Key Pack ID from the Microsoft site and select Next. 

 

Licensing Completion 

The licenses will be added and will be displayed in the Terminal Services Licensing window. 
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Software Installation On Windows 2000/2003 
Microsoft Windows 2000 Server requires that software be added in the “Install Mode” through the Control 
Panel, Add/Remove Programs.  

Select Start > Settings > Control Panel > Add/Remove Programs to launch the Add/Remove Programs 
dialog box. 

Note: Some software, especially downloaded software, doesn’t allow the installer to install it through the 
Add/Remove Programs tools. To manually put the machine into the install mode open a command 
prompt and type: 
change user /install 
This command sets the machine to install mode. When finished, type: 
change user /execute 
This command returns the machine to the normal run mode. 

 

Add/Remove Programs 

Select the CD or Floppy button on the Add/Remove Programs dialog box to open the Installation wizard.  
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Install Program Window 

The wizard will prompt for the installation of the software disk. Select Next to display the Run Installation 
Program dialog box. 

Note: If the new program starts in autorun and proceeds without going through the following procedures, 
either stop the autorun and use the wizard to initiate the installation, or use the change user 
/install command to place the machine in the install mode. Use the change user /execute 
command when finished to return the machine to the Run mode. 
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Run Installation Program 

Enter the command line of the installation program and select Finish, or select the Browse button to select 
the installation file. 

 

Browse File Window 

Selecting the Browse button on the Run Installation dialog box will launch a Browse File window. Highlight 
the installation file and select Open. This will begin the application setup. 
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After Installation Window 

As the installation begins, an After Installation dialog box is displayed. It requests that the Next button be 
selected when the installation is finished. When this button is selected a second confirmation window is 
displayed. 

 

Finish Install Window 

Select the Finish button when the installation is finished. 

Note: If a choice is given to Reboot Now or Reboot Later, choose to reboot later once the entire setup is 
completed and the dialog boxes are cleared. 
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Glossary of Terms 

Access Groups 
Access groups are used to limit access to a terminal or Terminal Server Group unless the user is also a 
member of the access group. 

ACP 
Automation Control Products.   

ACP Enabled Thin Client 
A terminal that uses ACP technology. Also called ThinManager Ready 

ACP Enabled Thin Client Network 
A ThinManager server, a terminal server, and ACP enabled thin clients connected and configured on the 
same network. 

ActiveX 
A Microsoft technology that allows the sharing of data between different applications. 

AppLink 
A function that applies the Initial Program to a Terminal Server Group. 

BIOS 
Basic Input/Output System. A program that the computer uses to control the keyboard, mouse, monitor, serial 
ports, and other devices before the hard drive is accessed . 

CAL 
Client Access License. A Microsoft license that is required to print or access files on a Windows Server. See 
also TS CAL. 

Classic Mode 
The method of configuring Groups and Terminals using property tabs that was introduced in ThinManager 
1.0. See also Wizard Mode. 
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Client 
A machine that requests data, resources, or services from a server. A software program that shares data with 
the server. 

Client/Server 
A relationship between two computers or programs where one, the client, requests data, resources, or 
services from the other, the server. 

COM Port 
A serial communication port on a PC. 

Console 
The administrative session that is run on the server. 

DHCP 
Dynamic Host Configuration Protocol. A protocol for assigning IP addresses and other boot information to 
computers on a network. 

Disk-On-Chip 
Storage device that contains firmware that allows an ACP Enabled thin client to boot locally. This may be a 
disk-on-chip or compact flash, depending on the make and model of the terminal.  

DNS 
Domain Name Service. An Internet service that converts domain names to IP addresses. 

Domain 
A group of computers that are administered as a unit, with common rules, policies, and procedures. 

Domain Name Service 
An Internet service that converts domain names to IP addresses. Often abbreviated to DNS. 

Enforce Primary 
A ThinManager feature that allows terminals that failed over to a backup terminal server to return to their 
primary terminal server once the primary terminal server has returned online. 

Failover 
The ability of a terminal to switch to a backup server when the primary server fails.  

Fat Client 
A computer with a hard drive and operating system that is acting as a client. 

Firmware 
The software that runs the ThinManager Ready thin client.  
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Gateway 
A device that connects two computer networks that use different protocols. 

GUI 
Graphical User Interface. The portion of an operating system or program that provides icons, symbols, or 
pictures for options and choices. 

HMI 
Human-Machine Interface. A software program that allows an operator to control a manufacturing process. 
Also known as MMI, Man-Machine Interface. 

Hot key 
A keyboard combination that triggers a function. 

HSSD 
High speed Serial Driver. A module that works with the ACP Com Redirection program to transfer serial data 
from the ThinManager Ready thin client to the session on the Terminal Server at speeds up to 115 Kbaud. 

ICA 
Independent Computing Architecture. A remote presentation services protocol from Citrix that allows thin 
clients to access the server.  

ICA Connection 
The communication channel between an ICA server and an ICA terminal. 

Initial Program 
A function that loads a specific application instead of the desktop in a terminal server session.  

Instant Failover 
A ThinManager function that allows a ThinManager Ready thin client to start sessions on two terminal 
servers, with only the session of the primary terminal server visible. If the primary terminal server fails, the 
secondary session is immediately displayed.  

IP 
Internet Protocol. A widely used protocol for network communications. 

IP Address 
Four sets of numbers from 0 to 255 that represent an Internet address. 

KeyBlock 
A module that prevents certain keyboard combinations like CTL+ALT+DEL from functioning. 

KVM 
Keyboard/Video/Mouse. A device that allows several PCs to be displayed on a single monitor and controlled 
by a singe keyboard and mouse. 
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Load Balancing 
A dynamic ability to connect a thin client to a group of servers and login to the server with the lightest load.  

Load Sharing 
A static ability to connect a thin client to one of a group of servers in a predetermined fashion to share the 
load among the servers available.  

MAC 
Media Access Control Layer. A protocol that controls access and communication on a network card. 

Module 
Modules are software components that can be added to the firmware to increase the functionality of the 
terminal. Modules include touch screen drivers, sound drivers, and special device drivers. 

MultiCast 
Multicast provides the ability for an unlimited number of terminals to boot simultaneously from the same data 
stream. 

MultiMonitor 
The ability for some ThinManager Ready thin clients to use two or monitors attached to the thin client. 

MultiSession 
A function that allows a terminal to connect to several Terminal Server Groups at one time and to switch 
between sessions. 

MultiSession License 
A license that allows a server to be added to a Terminal Server Group that uses the MultiSession function. 

OEM 
Original Equipment Manufacturer. A company that manufactures computers. 

PLC 
Programmable Logic Controller. A device, often using ladder logic programs, that controls processes and 
devices in an industrial plant.  

POST 
Power On Self Test. A diagnostic test that a computer runs when it is first turned on to make sure that the 
hardware is functioning. 

Primary Up Delay 
An interval of time given to a server to allow it to finish loading before terminals will connect to it. 

Primary Terminal Server 
The first terminal server that a terminal will log into.  
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Published Application 
An application in a server farm that is shared equally among the servers. 

Queuing 
Queuing extends the functionality of Smart Session by preventing terminals from connecting to Terminal 
Servers that have exceeded their Smart Session CPU load limit by letting the terminals connect in an orderly 
fashion. 

RAM 
Random Access Memory. The computer's primary memory space. 

Redundancy 
The use of duplicate equipment so that if one unit fails, another one takes its place. ACP uses Redundancy 
for duplicate ThinManager Servers and uses Failover for duplicate terminal servers. 

RDP 
Remote Desktop Protocol. The client/server communication protocol used between Windows NT/2000/2003 
servers and Windows clients. 

Router 
A device that manages data transmission between two networks. 

SCADA 
Systems Control And Data Acquisition. A software program that gathers and displays data, and allows for 
operator input, for control of a manufacturing process. 

Secondary Server 
Backup terminal servers that a terminal may log into.  

Server 
A computer that holds applications, files, or data for use by other computers.  

Server Farm 
A group of connected servers that share responsibilities and are usually configured to allow processing to 
continue if one or more server crashes. 

Server Ranking 
A number that represents the available resources on a terminal server using SmartSession. Lower numbers 
indicate a lighter load.  

Share Keyboard and Mouse 
A module that allows several thin client to share a keyboard and mouse. 
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SmartSession 
A function that allows a Terminal Server Group to be load balanced so that a ThinManager Ready terminal 
will connect to the terminal server in the terminal server group that has the lightest load. 

SmartSession License 
A license that allows a server to be added to a Terminal Server Group that uses the SmartSession function 
for load balancing. 

Standard Group 
A Terminal Server Group without additional options. The terminal servers are listed in a pre-defined order and 
a terminal connects to the first available terminal server in the order specified by the group. 

Subnet 
A group of TCP/IP addresses that communicate without going through a router and can be reached by 
broadcasts.  

TCP/IP 
Transmission Control Protocol/Internet Protocol. A layered application that allows shared applications and 
data on PCs. 

Terminal 
A client device that relies on a server for operations. ThinManager Ready thin clients are terminals.  

Terminal Server 
A server with a multi-user operating system that processes data for terminals.  

Terminal Server Groups 
A managed collection of terminal servers that a terminal can connect to.  

TermSecure 
A function that allows user profiles to be created and configured with their own Terminal Server Groups and 
Access Groups. When a TermSecure User logs in to a terminal using TermSecure, they will be allowed 
access to their own Terminal Server Groups and any of the terminal sessions that they are a member. 

Thin Client 
A terminal without a hard disk that is used to access a server.  

ThinManager  
A thin client configuration and management software from ACP. 

ThinManager Ready  
An ACP Enabled thin client. 

ThinManager Server 
A computer running both the ThinServer service and the ThinManager interface. 
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Since ThinManager will run on Windows workstations, a ThinManager “Server” can be a workstation. 

ThinServer 
The Windows NT service that is the engine for ThinManager.  

Trialware 
A free demo version of ThinManager that can be downloaded from www.thinmanager.com. It can run for 30 
days without a license. 

TS CAL 
Terminal Server Client Access License. A Microsoft license that is required for each client accessing a 
terminal server. 

USB 
Universal Serial Bus. A data port that allows peripherals to connect to a PC. 

WinTMC 
A terminal server client application that can be installed on a PC. It can be controlled, configured, and 
managed through ThinManager. 

Wizard Mode 
A method of configuring Groups and Terminals using a Wizard that was introduced in ThinManager 2.4. See 
Classic Mode. 
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